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Welcome to
ImagePals GO!

ImagePals GO! is an integrated package
containing file management and
advanced image editing programs that
make your work with images and other
files easier and more productive than ever
before.

There are two main programs: Album, for
cataloging and managing, browsing,
converting and retrieving your files and
Image Editor, for scanning, editing,
enhancing and adding special effects to
your images. An additional utility, Viewer,
allows you to instantly view and edit any
image or graphics file.
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Reading this guide is not the only way you can
learn about ImagePals GO!: the ReadMe file
contains technical information and anything that
came to light after this manual was produced,
(a good idea is to print a hard-copy of this file and
keep it stored with the ImagePals GO! guide), and
the on-line help provides a complete and in-depth
reference which can be easily accessed by pressing
the F1 key or clicking on the help button provided
in certain dialog boxes.

This guide has been divided into two sections,
Album and Image Editor, making it more readable
and relevant to the way you work. The following
previews the contents of each section as well as
the initial introductory chapters:

• Getting started, explains how to install the
ImagePals GO! programs and highlights
necessary system requirements.

• Background information, introduces the
ImagePals GO! programs. This will help you
understand what you can achieve with each
and covers important topics such as using the
on-line Help, object linking and embedding,
and file formats.

1. Album, details all the functions and features
available in both the Album and Viewer
programs of ImagePals GO!

2. Image Editor, details all the functions and
features available in the Image Editor program
of ImagePals GO!

• Glossary

• Index

How to get the most from ImagePals GO!
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· Getting started

This chapter is designed to get you up and
running with ImagePals GO! as quickly as
possible. Here you will find sections on
what you need to get started as well as the
installation procedure.
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Before you begin installing, check that you have
the following:

Your ImagePals GO! package

• License agreement.

• Disk pack, one of the first questions you will
be asked during installation is the serial
number from the disk pack: take a note of the
number or have the disk pack on hand before
you begin installing.

• Registration card, take the time to fill out this
card during installation and become a
registered user.

Your computer

• System, an IBM PC 386/486/586, PS/2, or
compatible computer.

• Operating software, Microsoft Windows
(version 3.1 or higher).

• Memory, 4MB or more of system memory
(RAM).

• Disk drives, a 3½"disk drive and a hard drive
(with approximately 5MB of free space).

• Display, any Windows-compatible display
adapter, including VGA, Super VGA, XGA,
8514/A, and 15-, 16-, or 24-bit.

• Pointing device, any mouse, trackball or
pointing device supported by Windows.

• Input device (optional), any desktop or hand-
held scanner, video board or frame grabber
with compatible drivers including TWAIN-
compliant devices.

• Printer (optional), any black & white or color
printer, imagesetter or film recorder
supported by Windows.

What you need
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The ImagePals GO! installation program runs from
within Windows and is fully self-explanatory. You
must use this program to install ImagePals GO! as
the program files require decompression during
installation.

To install ImagePals GO!:

1. Turn on your computer and run Microsoft
Windows.

2. Read the license agreement and, if you agree
to abide by it, open the disk pack.

3. Remove the ImagePals GO! program disks and
make a backup copy of each. Use the backup
copies to complete the installation.

4. Insert the first program disk into drive A (or
drive B).

5. Open Program Manager (or File Manager) and
choose the Run command in the File menu.
The Run dialog box appears.

6. In the Command Line entry box, type
a:\install (or b:\install) and press enter. The
installation program begins.

7. Follow the installation program instructions.
While the program is installing files, the
installation window displays information
about ImagePals GO! and the progress of the
installation.

Note: To move between entry boxes in the
installation program, use your mouse or press TAB
(not ENTER).

Installation
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8. When the installation program is finished with
disk 1, you will be asked for disk 2. Remove
disk 1, insert disk 2 and click OK. Repeat this
step for each disk requested.

9. When the installation is complete you are
asked if you would like to read the ReadMe
file. This file contains important information
that is not included in the printed
documentation.

10. Remove all the disks and keep them in a safe
place. ImagePals GO! is now installed and
ready for use. The ImagePals GO! icons will
appear in a program group in Windows
Program Manager. (Exactly where depends on
the choices you made during installation.)

Running ImagePals GO!

To run either of the ImagePals GO! programs,
simply double-click on the appropriate icon in the
Windows Program Manager. If you followed the
suggestions made by the installation program, the
program icons appear in the Ulead ImagePals 2.0
GO! program group.

The ImagePals GO! program group
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· Background
information

Before you start work with ImagePals GO!,
it is important that you understand some
of the concepts and features of each of the
ImagePals GO! programs. This chapter
explains these and also discusses
important topics such as calibrating your
display, using the on-line help, object
linking and embedding (OLE) and file
formats.
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ImagePals GO! is a Lite version of the widely
successful image editing and file management
program, ImagePals 2.0. While performing just as
well as ImagePals 2.0, ImagePals GO! does have
certain restrictions, these are:

• reduced support for certain image and
graphics file formats,

• a limitation of only 2 albums in the Album
workspace, or on the shelf, at any one time,

• a maximum of 100 thumbnails in each album.
(You can, however, have an unlimited number
of albums.)

Note: For a complete description of ImagePals 2.0,
choose the About Ulead Products command in the
Help menu.

Apart from these, each of the ImagePals GO!
programs share the following features:

• support for Black & White, Grayscale, Indexed
16- and 256-Color, and RGB True Color image
data types.

• compatibility with the following image and
graphics file formats: BMP, CGM, EPS, GIF,
JPG, PCD, PCX, TGA, TIF, and WMF.

• conversion between file formats.

• support for JPEG, LZW and RLE compression
schemes.

• ability to view images at different
magnifications.

• monitor gamma calibration.

• printing to output devices supported by
Windows, including PCL and PostScript
printers, film-recorders, and high-resolution
imagesetters.

• batch manager to apply commands to
multiple files.

• commands to undo and redo operations.

• enhanced “drag-and-drop” facilities.

• multiple preferences to customize display and
feature options.

• expanded on-line help that is always available
via a help button or the F1 hot key.

ImagePals GO! – an overview
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The traditional way of managing files has been to
use the “file tree” approach, such as that adopted
by DOS and Windows. This method displays the
files on your system as a tree consisting of a root
directory with subdirectory “branches”. Album
does not change this structure, it only represents
the information in a different way – through the
use of albums and thumbnails.

Albums just like the real thing, are used to store
photographs (thumbnails) of your files. Just as you
can have albums of photographs for particular
events, you can have albums of files for particular
purposes, e.g. an album of video files, or one that
holds your latest multimedia presentation.

Thumbnails are visual representations of the
contents of a file. Therefore you “see” what a file
is, rather than having to rely on an 8 character
filename. This way, it is much easier to identify
your files and to group like files together.
Thumbnails also allow you to append additional
information, such as subjects and descriptions,
that traditional filenames could never do.

An example of thumbnails in an album

Album
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To utilize Album to its fullest, it should be the first
program you open after running Windows. You
can access, as well as maintain, all your files and
programs from within Album and there should be
no need to return to Windows Program Manager.
Some of the features of Album are:

• ability to visually catalog all your image,
graphic, animation, audio, video and
application-linked files.

• automatic and manual file collection.

• choice of thumbnail size, data type, and
compression.

• commands to move, copy, rename, delete,
and change DOS attributes of any file, and to
convert the data types and file formats of
image and graphics files.

• automatic file and album integrity checks.

• facilities to easily assign and maintain
thumbnail descriptions, subjects and
keywords. (You can even export and import
catalog information as text files for spell-
checking and quick input)

• marking of individual thumbnails to aid
interactive browsing.

• search ribbon for one-step search operations.

• display of multiple files for preview or
comparison.

• slide show for images, graphics, animation,
and video files – including soundtrack
controls.

• drag-and-drop of thumbnails between albums
as well as to and from programs, (including
Windows File Manager).

• enhanced OLE support with special features to
speed up placing, previewing and printing of
images in client programs.

• toolbox, with program grouping, provides
direct and convenient access to your most
commonly used programs.

• shelf for storing albums.

• direct import of images from TWAIN-
compatible devices.
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Viewer

Viewer is a utility that provides a quick and easy
way to open and display image and graphics files –
regardless of their associated programs. This is
particularly useful when you want to compare
images, view an image at its actual size or check
the contents of an image or graphics file. Once
displayed in a Viewer window, you can perform
basic editing operations or transfer the file to an
editing program of your choice.

Image Editor

Image Editor, as the name suggests, is all about
editing your image files and comes equipped with
a comprehensive range of image processing
commands and tools which can be used to create,
compose, change, and improve any type of image
from black-and-white to full-color. Add to this
extensive special effects, such as warping and
variable distortions, and you have a package that
satisfies the most demanding of imaging users.
Some of the features of Image Editor include:

• unique object pool for the storage and
management of images and masks.

• global viewer to help you find the right view of
an image quickly.

• selection tools and commands to select single
or multiple parts of an image, expand
selection areas, select the border of an area
and control the merging of selection areas.
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• painting and retouching of images with a wide
range of tools.

• an anti-aliasing option for smoother text.

• clone tool for cloning parts of an image within
or between images.

• controls to adjust gamma, hue, saturation,
brightness, contrast, and mapping curves – all
of which help to enhance a whole image or
any selected part of an image.

• transformations such as distort and slant as
well as over twenty special effects including
warping, puzzle, watercolor, and fisheye; all
with the ability to preview effects before
application.

• friendly, automatic and manual stitching of
images.

• enhanced support for OLE.

• image input from Photo CD, scanners, frame-
grabbers, or other input devices which have a
compatible driver.

• input and output device calibration with post-
processing commands and pre-print mapping
options (and new halftoning control for
printing).
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The on-line help provides a useful and informative
alternative to learning about ImagePals GO!, and
should be used in conjunction with this guide. In
the help, you will find concise and definitive
explanations about various menu commands,
operations and procedures.

Help can be accessed in 3 ways: from the Help
menu, by clicking on the Help button in certain
dialog boxes, or by pressing the F1 hot key. How
you access help depends on what you are doing at
the time and what information you wish to view.
The following describes each of these access
methods:

Help menu provides commands that open help at
either a specific topic or at the contents page of
help. Use the Help menu when you want to
browse through help or wish to go to a specific
topic. There are also commands that display
information about ImagePals GO! as well as other
products in the Ulead range.

Dialog boxes may contain a Help button that,
when selected, opens help at the page describing
the dialog box you are in. This is particularly
helpful when you want to clarify or understand
certain commands and options available in a
dialog box.

F1 hot key is perhaps the most convenient way to
access help, as it is easy to remember (just press
the F1 key) and opens help at the topic describing
the command or feature your mouse is currently
resting on.

Using the on-line help
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To display images and graphics consistently, it is
important that you optimize your monitor by
calibrating your display. Every time you change
your monitor, display adapter or the environment
in which you work, you should recalibrate. You
can conveniently calibrate your display from
either Album, Image Editor, or Viewer.

To calibrate your display:

1. Choose “Display” from the Preferences
submenu in Album’s Album menu or in the
other programs’ File menu. The Display dialog
box opens.

2. Make sure the Monitor Gamma option is
unchecked. If it is checked, click on it to
uncheck it.

3. Click OK. The dialog box closes.

4. Display the IPGAMMA.TIF file. In Image Editor
or Viewer, open it using the Open command
from the File menu. Using Album, insert it into
an album and double-click on its thumbnail to
display it, (in Viewer).

Note: The IPGAMMA.TIF file should be in the same
directory as your ImagePals GO! programs.

The IPGAMMA.TIF file

Calibrating your display
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5. Examine the IPGAMMA.TIF image and
identify the gray square that most closely
matches the midtone gray of the vertical
background strips. Make a note of the number
of this square.
If, for example, the square at the bottom of the
middle row most closely matches the gray
strip, take a note of the number 1.7.

Note: This number can be any value from 0.01 to 7.99.
If none of the squares exactly match, you should
estimate the best match. In general, your value should
fall within the range 0.8 – 2.4. If none of the squares
match, then you may need to manually adjust the
brightness and contrast controls on your monitor
first.

6. Open the Display dialog box again.
(A complete procedure is given in step 1.)

7. Click on the Monitor Gamma option to check
it and enter the number recorded in step 5
into the Monitor Gamma entry box.

8. Click OK. The dialog box closes. Now, when
you view the IPGAMMA.TIF file, the gray
square numbered 1.0 should most closely
match the gray strip.

One of the advances to Windows over the years
has been the introduction of object linking and
embedding, (OLE). OLE is a method of
maintaining and transporting files between
programs. The file is called an object while the
programs are referred to as the server and client.
The server is the program that created or can edit
the object; the client is the program into whose
document the object is placed. Album (in
conjunction with Viewer) and Image Editor can
act as server programs, while your word
processing, DTP and presentation packages (e.g.
Microsoft Write, Word for Windows, Aldus
PageMaker 5, Quark Xpress and PowerPoint) can
act as clients.

Object Linking &
Embedding (OLE)
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Once placed into a client program, the object
“remembers” the server program it came from. To
edit the object, you simply have to double-click on
it in the client program’s document: the server
program opens, displaying the object. This link to
the original file and its server program is the
advantage OLE has over copying and pasting.

So, what about linking and embedding? Well, in
taking the object from the server to the client you
can choose if just a representative version of the
object is taken, linked – or if the object itself (and a
representative version of it) are taken, embedded.
The remainder of this section explains more about
linking, embedding and the options Album and
Image Editor provide as server programs.

Linking

Linking an object stores a representation of an
object and a link, to both the original file on disk
and the server program, in the client program’s
document. This means that you must retain the
original file on disk, and in the same location, to
retain the ability to edit it. The major advantages
of linking are:

• it does not increase the size of the client
document too much (especially if you use
Album’s low resolution place-holder option).

• you can place an object, such as a logo, into
many different documents and by editing the
original file update all of them in one action.
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The disadvantages are:

• if you are not just using Album to manage your
files (you may also be using DOS and Windows
File Manager) it is very easy to move, delete or
change a linked file unknowingly.

• the document is not readily portable – to move
the document and maintain a link, you need
to move the files with the document and
retain the same directory structure or relink
them after moving.

To link an object

Linking objects always starts from the server, as
follows:

1. From Album: locate the album containing the
thumbnail of the file you want and select it.

From Image Editor: open the image file you
want (if you wish to paste only part of the
image, select that part).

Note: Before you proceed, ensure that the correct
options are chosen in the OLE & Clipboard
preferences dialog box. For Image Editor, select
Include OLE-Related Formats or, in Album, select OLE
Linking Format.

2. Choose “Copy” (Image Editor) or “Copy: File”
(Album) from the Edit menu to copy the
selected file to the clipboard.

3. Open or switch to the client program
containing the document into which you want
to place the object.
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4. Choose the client program’s Paste Special
command. The Paste Special dialog box
appears.

Note: Some client programs have a Paste Link
command, you can use this as a more direct
alternative to the Paste Special command.

5. Select “Picture” or “Device Independent
Bitmap” in the Data Type list box (choice
depends on whether the source is Album or
Image Editor). The Paste Link button becomes
enabled.

6. Click on Paste Link. The dialog box closes and
a representation of the object appears in the
client program’s active document.

Note: You can also place linked objects into client
programs by dragging and dropping them from
Album. Album also provides an option to choose the
representation format to help you make the process
as efficient as possible. These options are described
fully in the Album section and on-line help.

Embedding

Embedding an object into a client program’s
document places a copy of the original file along
with a representative version of it and a reference
to its server program. This means that if you delete
the original file from disk, no harm comes to the
embedded file. The major advantages of this are:

• it makes the document containing the object
portable and independent: as long as the
server program is available, you can edit the
object regardless of whether you have deleted
the original file from disk.

• there is little danger of you deleting or making
changes to the object accidentally. You can
also place the same piece of information into
many different documents and edit them all
individually without affecting any of the
others.

The major disadvantage is:

• the size of your document in the client
program increases significantly. If you do not
wish to retain editorial control over a placed
object, it is better to paste a single copy of the
object into the document, i.e. don’t link or
embed it at all.
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• when updating a shared object, you have to
relink each one individually.

Note: When embedding objects from Album, it is
advisable to keep the original file and the album that
contains its thumbnail. If you delete the file or the
album, you will still be able to access album from the
embedded object and replace the embedded object,
but you will not be able to edit it.

To embed an object

You can start from the client program or the server
program to embed an object. Starting from the
server program, follow the procedure for linking
outlined in the previous section, but, in step 6,
press the Paste button instead of the Paste Link
button. To start from the client program, use the
following procedure:

To embed an object from the client program:

1. Open or create a document in the client
program and select the client’s Insert Object
command (or similar). The Insert Object
dialog box appears.

2. In the Object Type list box, select Ulead Album
Clip or Ulead Image Editor Image.

3. Click OK. The dialog box closes and the
selected server program (Album or Image
Editor) appears.

4. In Album: locate the album containing the
thumbnail of the file you want to embed and
select it.
In Image Editor: open the image you want to
embed.

5. From Album’s Album menu or Image Editor’s
File menu, choose “Update client” (client is
the name of the client program you began this
procedure in).

6. Switch back to the client program. The object
you selected appears in the document in the
client program.

Note: The options in the OLE & Clipboard preferences
dialog box do not affect this method of embedding.
However, if you use the client program’s Paste or
Paste Special commands be sure you have selected the
options appropriate to embedding.
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What happens when you double-click
on, or want to edit an object?

When you go to edit an object from Image Editor,
the behavior is the same as that for other normal
server programs; Image Editor opens displaying
the object. Album, however, is a little different as
Album supports more than just image files and
provides no editing functions. You can relink as
follows:

For image and graphics files

• to relink or update an embedded file: Select
the Edit: Ulead Album Clip command, Album
opens displaying the album the original object
came from. You can then update from the
original, or select an alternative thumbnail
and update.

• to view a file in Viewer: Double-click on the
object and the file is displayed in Viewer. This
is most useful for viewing the original file of a
low-resolution place holder.

• to replace an embedded low resolution place
holder with the original file: Select the Edit:
Ulead Album Clip command, Album opens
displaying the album the original object came
from. Open the OLE & Clipboard dialog box,
accessed by choosing the OLE & Clipboard
command in the Album: Preferences
submenu, and select the Source Object
Representation Format. Choosing the Update
command in the Album menu then replaces
the low-resolution place holder with the
original image.

• to relink a low resolution place holder, which
has been linked, to its original image or
graphics file: Open Album and, in the OLE &
Clipboard dialog box, select the Source Object
Representation Format. Close Album and go
back to the client. In the client, select the
object and update it (most clients provide
update links, update fields or similar
command for this purpose).
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For other types of files

Album can embed and link all types of images,
graphics, animation, sound, and video files. After
embedding or linking you can use the link
provided by Album as follows:

• to relink or update an embedded file: Select
the Edit: Ulead Album Clip command, Album
opens displaying the album the original object
came from. You can then update from the
original, or select an alternative thumbnail
and update.

• to preview a sound, animation, or video file:
Double-click on the object and the file is
displayed in Windows Media Player.

ImagePals GO! provides extensive tools for
managing and manipulating images, therefore, it
is important that you fully understand what is an
image. Armed with this knowledge, you can use
ImagePals GO! more efficiently and achieve the
best possible results with a minimum of effort.

To many people, an image is a picture, a painting,
or even an idea; but in the world of computers, it
is a collection of dots called pixels. These pixels are
arranged in rows to form the image.

Each pixel is white or colored. Exactly which color
depends upon the data type of the image. For the
simplest data type, the pixels can be either black
or white. For the most powerful data type, each
pixel can be any one of 16.7 million colors.

Images
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As long as the pixels are small enough, you do not
see them as individual dots: you see groups of
pixels, which together form areas of color or gray.
For images placed in a word processor, DTP
program or output to a printer, the size of the
image is determined by its resolution. If an image
has a resolution of 100 ppi (pixels per inch) and it
is 100 pixels in width by 200 pixels in height, it will
be one inch wide by two inches high.

Notes:

• An image’s pixels, resolution and data type all play
a part in determining how the image will look when
displayed or printed.

• When working with images in Image Editor or
transferring images into a video, the resolution
information is irrelevant: the size of the image is
determined by its dimensions in pixels and the
resolution of your graphics mode and monitor size.

Image data types

The data type of an image determines the colors
the image may contain, and may also determine
how it can be manipulated. In ImagePals GO!, an
image of any data type can be displayed on any
type of computer display, but it does not appear
the same on all displays. For example, if you
display a color image on a monochrome monitor
you will not see colors.

In many descriptions of image data types, you will
see mention of bits. The number of bits controls
the number of colors available. You can work out
the number of colors available by raising two to
the power of the number of bits. For example, an
8-bit image data type gives you 256 different colors
(2 to the power of 8 is 256). This section explains
the data types supported by ImagePals GO! and
the table over shows file formats available with the
various data types.
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Data type File formats supported by ImagePals GO!

Black & White BMP, EPS, GIF, PCX, TIF, WMF

Grayscale EPS, JPG, PCX, TGA, TIF

Indexed 16-Color BMP, GIF, PCX, TIF, WMF

Indexed 256-Color BMP, GIF, PCX, TGA, TIF, WMF

RGB HiColor* BMP, TGA

RGB True Color BMP, EPS, JPG, PCX, TGA, TIF, WMF

* Not supported by Image Editor

Black & White

Black & White is a one-bit data type. In a Black &
White image, each pixel can only be one of two
colors: white or black. You get gray shades by
arranging black and white pixels in such a way that
they appear to be gray. For example, in a square of
four pixels by four pixels (sixteen in all), if there
are eight black and eight white pixels arranged
properly, the square will look gray
(a 50% tint of black).

Grayscale

Each pixel in an 8-bit Grayscale image can be
black, white, or any one of 254 different shades of
gray. Grayscale is a 256-color (8-bit) data type.

All the Image Editor tools and commands can be
applied to Grayscale images except those which
are color specific. Choose this data type when you
want to prepare images for publications being
printed in a single color. If you want to introduce
color into a Grayscale image, convert it to RGB
True Color or Indexed 256-Color first.
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Indexed 16- and 256-Color

Indexed-Color images are images that have a color
table incorporated into their description. This
color table contains all the colors that can appear
in the image. For Indexed 16-Color images, the
table has 16 colors (4-bit); for Indexed 256-Color
images the table contains 256 colors (8-bit).

You can simulate additional colors by using
different colored pixels arranged closely together
(dithering). Using this technique, the eye is tricked
into seeing more colors than are actually found in
the color table.

Most ImagePals GO! functions work on indexed-
color images, but to get full benefit from the more
advanced editing features you need to convert
Indexed-Color images to RGB True Color. You may
wish to convert images to indexed-color for use in
certain programs (such as multimedia
presentations) and for display on 256-color and
16-color monitors.

RGB HiColor

This data type was introduced in conjunction with
15- and 16-bit display cards (capable of displaying
32,768 or 65,536 colors). For displays, these cards
provide a lower-cost alternative to True Color
cards for high quality color representation.

You may want to use this data type if you are
capturing from a HiColor display or, if thousands
of colors satisfy your needs, save images in this
data type to save space on your hard drive. (An
RGB HiColor image occupies 33% less memory
space than an equivalent RGB True Color image.)
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RGB True Color

The initials RGB stand for Red, Green, and Blue.
The data type bears this name because all colors
are created with different amounts of red, green,
and blue. In fact there are 256 shades of each
available color. When you mix all of these together
you will find there are 16.7 million possible colors
(3 × 8-bit = 24-bit), hence the term True Color. You
can apply all the Image Editor tools and
commands to RGB True Color images.

RGB 8-Color

The RGB 8-Color data type is a three-bit data type
where each pixel can be one of eight colors.
ImagePals GO! supports scanners that scan RGB 8-
Color images and will open RGB 8-Color images.
RGB 8-Color images are automatically converted
to Indexed 16-Color with the same colors retained
(plus space for eight more). You cannot, however,
convert to, or create new RGB 8-Color images.

As mentioned previously, how color is represented
in an image depends on its data type. Some data
types are easier to visualize than others, e.g.
Grayscale data types consist of only two main
colors, black and white, and a further 254 shades
of gray in between, (256 “colors” altogether).

For color images the situation is very different.
Our eyes can distinguish many thousands more
colors than we can accurately describe. Color
models help us imagine and describe colors for
different situations. The ImagePals GO! programs
make use of the red, green, blue (RGB) model and
the hue, saturation and brightness (HSB) model.

Understanding color
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RGB color model

This model does not make it easy to imagine lots
of colors, but is used by many computer monitors
and image data types to specify color. From the
whole spectrum of color there are three primary
colors, red, green, and blue, from which all other
colors can be created.

In the RGB model the primary colors are plotted in
a three-dimensional chart that resembles a cube.
Red, green and blue are found on the x, y and z
axes of the chart. The colors increase from nothing
(black) at the origin to pure color. The line from
the origin to the diagonally opposite corner of the
square changes from black through varying shades
of gray to white and represents equal amounts of
red, green and blue.

HSB color model

We can visualize the colors available on each face
of the RGB cube, but it is hard to imagine all the
color combinations available inside. It is easier to
imagine ranges of color (hue), such as reds,
yellows, blues, violets; varying from a dull gray
shade to a bright pure color (saturation); and
whose brightness can vary from very light (white)
to very dark (black). This is how color is presented
in the HSB color model.

The HSB color model takes the form of an upside-
down cone. Looking at the top of the cone you can
see the colors arranged in a circle. The position of
each color is defined relative to red. Green is at
120°, and Blue is at 240°. Opposite each primary
color is the color’s complementary color: opposite
red is cyan (180°), opposite green is magenta
(300°), and opposite blue is yellow (60°). If you
follow a color band from the center out, you will
see the color goes from white to an intense color,
this is the saturation of a color. Brightness is
represented from the tip of the cone, to the
bottom, darkness.
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Since the Album program of ImagePals GO! can
manage files of any type, you will almost certainly
find yourself seeing file extensions and formats
you’re not familiar with. To help you navigate
through this, Album categorizes files into eight
media types: Image, Graphics, Waveform, MIDI,
Video, Animation, Application-Linked, and
Others. From these types, Album can only directly
edit, read and write files falling into the Image

and Graphics groups. For files from the other
groups, Album can directly catalog and manage
them and, when you wish to edit them, transfer
them to compatible programs for you.

The table below shows the extensions of files that
you will normally find in each group. This chapter
describes these files in the order they are
presented in the table.

File type File formats available (extensions)

Application-linked Any file registered in registration database, e.g. WRI, TXT,...

Others DBF, DOC, PPT, RTF, CDR

Waveform VOC, WAV

MIDI MID, RMI

Video AVI

Animation FLC, FLI, FLX

Graphics CGM, WMF

Images BMP, EPS, GIF, JPG, PCD, PCT, PCX, TGA, TIF

File formats
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Application-linked files

Application-linked files are files that ImagePals
GO! does not directly support. This includes any
files whose extension is linked to a Windows
program in the Windows registration database.
(This database is maintained by Windows and
records the link between files and their programs.)
Application-linked files can be opened in their
linked program directly from Album or Windows
File Manager by double-clicking on the file’s
thumbnail or filename.

Links into the registration database come from
four places:

• the programs themselves. When installed,
programs record their proprietary formats and
any formats they “expect” to open. Windows
Write, for example, records Write (.WRI) files
as one type of file that will open in it.

• the Associate command in the File menu of
Album or Windows File Manager. This
command opens a dialog box in which you can
see the program a format is linked to by typing
the extension in the Files with Extension entry
box. You can also change the association of
files (see your File Manager’s Help topic:
Associate Files with Applications). This
command is the method Microsoft
recommends for editing the database.

• the [Extensions] section in your WIN.INI file.
You can manually edit this section and add
new entries. The Associate command is a
more interactive method of editing this data.

• the registration database (the REG.DAT file in
your Windows directory). Microsoft provides
the utility, REGEDIT.EXE, which allows you to
view and edit the database.
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Other files

This is a special category for files that ImagePals
GO! can recognize and extract some information
from but cannot read completely. The DOC files
from Microsoft Word for Windows are a good
example of this: ImagePals GO! can read some of
the header information, like the author’s name,
and enter this into the thumbnail information
fields. For CDR files from CorelDRAW. 3.0/4.0 and
PPT files from PowerPoint 3.0, you can get the
header information from the preview information
found within these programs.

Waveform files

ImagePals GO! supports two types of Waveform
files: VOC and WAV. WAV is by far the most
common and can be played by Windows Media
Player directly from Album. Waveform files can
record sounds very accurately (much like images
can record photographs) but the amount of space
they occupy can be very large.

Note: VOC files cannot be played by Media Player
without special updating from hardware sound card
vendors.

MIDI files

MIDI stands for Musical Instrument Digital
Interface and is a standard for communication
between musical synthesizers and computers.
Album can play MIDI files through Windows
Media Player. (ImagePals GO! also supports the
RMI file format, developed by Microsoft.)
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Video files

Currently there is one video file format in
Windows that is unrivaled for popularity: AVI. This
format was developed by Microsoft for use in its
Video for Windows software and can record both
Audio and Video data in an interleaved format.
ImagePals GO! allows you to play AVI videos using
Windows Media Player.

Animation files

ImagePals GO! supports Autodesk Animator FLIC
files and uses Media Player to display the files.

Graphics files

Computer Graphics Metafile (CGM)

CGM is an official standard for graphics
interchange developed by the American National
Standards Institute. It uses three different
standard encodings that include character, binary
word and readable text. CGM is device
independent and is ideal for 2-D CAD and drawing
programs such as CorelDraw. ImagePals GO! can
read CGM files.

Windows Metafile (WMF)

WMF is a device independent format for the
exchange of raster and vector graphics data. WMF
supports Black & White, Indexed 16-Color, 256-
Color and RGB True Color images.

In ImagePals GO!, saving files in WMF format
saves data according to your display mode, e.g. if
you save a True Color image as WMF on an
Indexed 256-Color display, when you open the file,
you will see it as Indexed 256-Color. ImagePals
GO! can read both vector and raster formats and
write to this format (raster only.)
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Image files

Windows Bitmap (BMP)

This is a file format that allows Windows to display
an image consistently on different devices (with
similar capabilities). It supports Black & White,
Indexed 16- and 256-Color, HiColor (565 and 555)
and True Color images. You may want to use this
format to save indexed-color images for later use
in programs like Windows Paintbrush or in
Windows itself (as, for example, your
“Wallpaper”). ImagePals GO! can both read and
write to this format.

Note: ImagePals GO! will convert 32-bit True-Color
images to 24-bit True Color when reading.

Encapsulated PostScript (EPS)

EPS is a device-independent file format used in
Adobe PostScript language that retains
information that can be outputted directly to a
printer, or imported into another program. A low
resolution TIFF preview enables you to view the
image when imported into other programs.
ImagePals GO! allows you to read and write to this
format (in raster form).

Note: ImagePals GO! cannot recognize EPS files that
contain information other than in an image format.
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Graphics Interchange Format (GIF)

Developed by CompuServe to allow device-
independent transfer of images, GIF supports
images up to 64 MB in size with up to 256 colors
(8-bit), Black & White, Indexed 16- and 256-Colors.

GIF formats support LZW compression and is ideal
for converting to and from this platform.
ImagePals GO! supports its 89A standard and can
read and write to GIF format.

Note: GIF files do not record image resolution.

JPEG file interchange format (JPG)

Developed by the Joint Photographic Experts
Group, JPG is a new industry standard compressed
file format that offers compression ratios up to
100:1 (original file: compressed file). As a standard
it offers device-independence, i.e. you should be
able to open any JPG file in all programs that
support this format. JPG supports Grayscale, True
Color and CMYK (4-2-4) True Color images.
ImagePals GO! can read and write to this format.

JPEG differs from LZW compression in that it is a
“lossey” compression scheme: it discards data
during compression. To minimize the visual effect
of this loss, JPEG identifies and discards the
information that is least important to the human
eye. Use this format when disk space is at a
premium, or you have very large images.

Kodak Photo CD (PCD)

Eastman Kodak created PCD for its Photo CD
products which allows you to view photos from
Photo CDs. To enable you to view these photos in
different display modes, PCD files contain 5
resolutions and allow you to choose from 3
different data types; Grayscale, Indexed 256-Color
and True Color photos. ImagePals GO! can read
files in the PCD format but cannot save.



BACKGROUND INFORMATION 39

06/13/95 TaurusCONFIDENTIAL

PC Paintbrush (PCX)

Developed by ZSoft Corporation for PC
Paintbrush, this is the default format used by some
scanning packages and paint programs (including
PC Paintbrush). PCX supports Black & White,
Indexed 256-Color, Grayscale, HiColor, True color
and CMYK True Color images. ImagePals GO! has
the ability to read and write to this format.

Note: Some versions of the PCX format do not record
the resolution of an image. The version used by
ImagePals GO! does. If you import an image with no
resolution defined, it will set it at your current display
resolution. You can redefine the resolution with the
Resolution command in the Edit menu.

TARGA (TGA)

Developed by TrueVision for its full-color video
boards (in particular the TARGA board), this is the
format used by many specialist systems.
ImagePals GO! supports Grayscale, Indexed 256-
Color, HiColor and True Color (Alpha Channel)
TGA images, and can read and write to this
format.

Note: Some TGA files do not record the resolution of
images.
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Tagged Image file format (TIF)

Developed by Aldus and Microsoft to promote the
use of desktop scanners and DTP (desktop
publishing), non-compressed TIF is hardware and
software independent, but there are many types of
compression available that are not.

ImagePals GO! can both read and write files in the
TIF format. In addition to Black & White and
Grayscale images, ImagePals GO! also supports
Indexed 16- and 256-Color, True Color and CMYK
True Color (4-2-4) TIF images with LZW, PackBits
and CCITT G3 1-D compression options..

Choose this format for exchange image data
between graphic media. Programs that support
TIF images include: ColorStudio, CorelDRAW,
PageMaker, PC Paintbrush IV Plus, PhotoShop,
PhotoStyler, Picture Publisher Plus, PowerPoint,
PrePrint and Ventura Publisher, to name just a
few.

Windows Metafile (WMF)

See description for Windows metafile in the
previous graphics section, (p.36).

Working with FIO modules

All the ImagePals GO! programs can read and
write FIO (File Input Output) modules. For
ImagePals GO!, FIO formats include those from
the Images grouping. Depending on your working
needs, you may use particular FIO formats more
often than others. ImagePals GO! provides a fast
and easy way to select these FIO options. Add or
remove certain FIO formats by using the File
Formats command in the File: Preferences
submenu.

Cataloging MIO (Media Input Output) modules is
simple in ImagePals GO! Album. You must
manually copy, add or delete them from the
directory by using File Manager.
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S E C T I O N  1

Album
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1.1 Album basics, describes basic Album
functions such as applying commands, drag-
and-drop operations and customizing Album.

1.2 Managing albums, explains how to create
albums and perform standard album file
maintenance such as copying, moving,
archiving and restoring album files.

1.3 Managing thumbnails, shows you how to
insert thumbnails of files into albums as well
as manage the files on your system.

1.4 Labeling thumbnails, explains how to assign
keywords, marks, subjects and descriptions
to thumbnails.

1.5 Locating thumbnails, takes a look at
performing a variety of search operations to
locate thumbnails and the files of thumbnails.

1.6 Viewer, introduces the Viewer program of
ImagePals GO!.

Section preview
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1·1 Album basics

This chapter introduces you to the Album
window and explains some of the basics
behind how Album manages the files on
your system. These basics include applying
commands, using the “repeat” key,
recovering from any mistakes made,
accessing programs from the toolbox,
performing drag-and-drop operations,
and using the Preferences commands to
customize the way Album works with you
and your Windows environment.
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Album can be invoked in a number of ways:

• double-clicking on the Album icon in the
ImagePals GO! program group.

• choosing the Album command from the Pals
menu in any ImagePals GO! program.

• double-clicking on an album file in Windows
File Manager.

The Album window

When you invoke Album you may see:

• Albums within the workspace (the central
portion) of the Album window.

• A ribbon, below the menu bar, providing quick
access to search functions. (Double-clicking
on an empty portion of the ribbon opens the
Search dialog box.)

• The mark palette, on the left, used to identify
and label thumbnails and a toolbox, on the
right, providing direct access to your programs
as well as a “shelf” to store albums.

• The status bar, at the bottom, displaying
information about the active album. (Double-
clicking on the status bar opens the Album
preferences dialog box, see p.54)

Running Album
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To perform an operation, you first need to select
the thumbnail or album you want the operation to
be performed on, and then choose the appropriate
command from a menu. This is fine when you
only want to apply the command to a few
thumbnails within a single album, but proves
inefficient when you want to perform the same
command to thumbnails in different albums. To
overcome this limitation, Album provides an extra
feature, the batch manager.

Using the batch manager

The batch manager can be accessed in two ways:
double-clicking on an empty part of the
workspace or choosing the Batch Manager
command in the Album menu. Once invoked, the
batch manager opens and displays the titles of all
the albums present in the workspace. The
commands that can be applied in the batch
manager are: Check, Minimize, Print Thumbnails,
Put on Shelf, Remove, Restore Window, Save
Sequence, Search, Sort by, View All, View
Thumbnails and View Filenames.

To perform a batch command, choose the
command you want to perform and select the
albums you want the command to be performed
on. Once decided, click OK – batch manager does
the rest for you.

Note: The batch manager can only apply commands
to albums open in the workspace. If there are no
open albums it is unavailable.

Applying commands
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Repeating commands in Album

Complementing the batch manager is the Repeat
command in the Edit menu. This allows you to
perform the last applied command again by
pressing the “F4” key. Simply apply a command to
a thumbnail or album, select another thumbnail
or album and press “F4”. The action is repeated.
Most of Album’s commands can be repeated in
this way, for example:

• select a thumbnail and choose “Properties”
from the Thumbnail menu. In the dialog box
that appears, enter a description in the
Description entry box and click OK. Select
another thumbnail and press “F4”. The
Properties dialog box reopens, enabling you to
quickly add new information to the
thumbnail.

• select an open album and choose “Size” from
the Thumbnail: Sort by submenu. The
thumbnails in the album are sorted by their
file size. Select another open album and press
“F4”. The images in the second album are
sorted in the same manner.

Recovering from mistakes

If you make a mistake while working in Album,
you can normally correct it by using the Undo
command in the Edit menu. This reverses the last
applied command and returns the album and its
thumbnails to their state prior to the application
of the command. At times you may see Can’t Undo
in the Edit menu. This is when you cannot undo
the last action, e.g. immediately after deleting the
file of a thumbnail.
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Central to Album’s ability to manage files, is its
ability to act as a program manager through the
toolbox. By adding frequently used programs into
the toolbox you can transfer control and, in many
cases, files between Album and those programs.
You can also place similar programs into program
groups, allowing you to instantly change the
toolbox configuration depending on the task at
hand, e.g. one group can consist of your
multimedia programs, another, your word
processing programs and so on. Once an icon is
added to the toolbox, simply click on it to open the
corresponding program. (You can also open
programs from the Run dialog box, accessed by
choosing the Run command in the toolbox menu.)

Adding programs to the toolbox

When you invoke Album for the first time, the
toolbox appears with a number of “empty” icons.
When you add a program, each of these icons are
replaced with that of the appropriate program
icon. Once placed into the toolbox, you can then
manage your programs, and determine which
programs are accessible, and at what times.

 To add a program icon:

1. Click on the tools button in the toolbox and
choose “New” from the menu. The New
Program dialog box opens.

2. Click on the Program Group option and in the
Group Name entry box enter the name of a
group you want the program to be associated
with, e.g. Multimedia.

Using the toolbox
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3. Click on the Program Icon option and enter
the Description, Command Line and Working
Directory of the program concerned. To load
the ImagePals GO! Image Editor program, type
in Image Editor for the Description, the full
pathname where your ImagePals GO! files are
located for the Command Line and the full
pathname of your temp directory for the
Working Directory.

4. Click on the New button. The program icon
appears in the toolbox. If you want to add
more programs to the toolbox, repeat steps
2 to 4.

5. Click on the Close button to close the dialog
box.

Notes:

• You can also add programs to the toolbox by
dragging execution files (EXE) from Windows File
Manager and dropping them onto an empty icon in
the toolbox.

• To change program groups, choose the appropriate
group name from the list of group commands in the
toolbox menu.

• If you wish to change any of the parameters
specified in the New Program dialog box, choose
the Properties command in the toolbox menu.

Removing a program

At times you may want to remove a program icon,
this can be because you no longer need it, have
deleted the program from your hard disk, or feel
that there are too many icons in the program
group. When you remove icons, you can choose to
remove individual ones, or all those associated to
a program group.

To remove a program icon or a program group:

1. Click on the tools button in the toolbox and
choose “Delete”. The Delete dialog box opens.

2. To delete the current program group, select
the Delete Current Program Group option.
(This deletes all program icons associated with
that group.) To delete an individual program
icon, select the Delete Program Icon From
Current Group option and highlight the icon
to be deleted from the Icon combo box.

3. Click OK. The selected program icon or group
disappears from the toolbox and the dialog
box closes.
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Scrolling the program icons

The arrangement of the programs in the toolbox
depends upon the order in which you add them.
When a program is added, it automatically goes to
the end of the list. Too many however, and you
may not be able to see them displayed within the
program window. To scroll through the icons,
click on the direction arrows. Clicking on the left
arrow scrolls up, clicking on the right arrow scrolls
down. (If all the program icons can be displayed
within the workspace, the direction buttons are
disabled.)

Customizing the toolbox

When you work in Album, you may prefer the
toolbox in another position, or feel that there are
not enough program icons available. To better
customize the toolbox, use the Configure
command (accessed by clicking on the tools
button) to open the Configure dialog box. To
increase the number of program icons, enter a
value (between 1 and 24) in the Icons to Show
entry box. Checking the Show Names option
displays the names of each program under their
respective icon in the toolbox. (You may find that
when selecting this option the toolbox expands in
size to accommodate the added text.) In the
Configure dialog box you can also choose to make
the toolbox floating or fix it to the left or the right
of the Album window. When floating, move the
toolbox by dragging on the title bar.
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Drag-and-drop is a simple, yet powerful technique
for transferring information within and between
programs, and shifting the focus of your work
during a Windows session. Album provides
extensive support for drag-and-drop that
enhances Album’s ability to provide complete file
and program management. The following section
describes the drag-and-drop operations you can
perform with Album:

Drag-and-drop to the toolbox

One of the more common drag-and-drop
operations is to drag a thumbnail from an album
and drop it onto a program icon in the toolbox.
Given that the file is compatible and the program
accepts command line opening of files, the file
associated with the thumbnail is opened in the
destination program. Dragging and dropping to
one of the ImagePals GO! program icons is even
more powerful, as you can drag-and-drop
multiple thumbnails in one go.

Note: Double-clicking on a thumbnail, pressing the
Enter key, or choosing the Run command in the Edit
menu also opens the file of a thumbnail, as long as it
has the correct program association, (see p.87).

Performing drag-and-drop
operations
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Drag-and-drop to the program
workspace

If you have other programs running at the same
time, you can drag-and-drop thumbnails directly
into the program’s workspace rather than its
program icon in the toolbox. (Depending on the
settings in the OLE & Clipboard dialog box, see
p.56, this either embeds, links or opens the file,
where compatible.)

If you are working from Windows File Manager,
you can:

• drag-and-drop program files (EXE) to an
empty icon in the toolbox of Album to create
program icons.

• drag-and-drop album files (ABM) into the
Album workspace to open them.

• drag-and-drop files into albums to creates
thumbnails of the files.

Notes:

• It is important that files are dragged to the right
place, e.g. albums must be dropped in an empty
part of the workspace, images must be dropped
into an album, and programs must be dropped onto
the toolbox.

• When dragging thumbnails to other programs, the
result is determined by the particular program. In
general, if you drop a thumbnail onto a minimized
program icon, or onto the program window’s title
bar, the program will attempt to open it. If you
drop the thumbnail into the program’s workspace,
it may be placed into the active document as an
object, or it may be opened; exactly which depends
on the settings defined in the OLE & Clipboard
preferences dialog box, (see p.56).
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Drag-and-drop thumbnails to albums

With drag-and-drop you can easily move
thumbnails within or between albums by simply
selecting the thumbnails and dragging them to
their new destination. (This can be to an open
album or its minimized icon.) Thumbnails moved
from one album to another are removed from the
first and introduced at the end of the second (or in
the position determined by the album’s current
sort mode). If you hold the Ctrl key down while
dragging, the thumbnails are copied. (The original
files associated to the thumbnails are not
duplicated.)

Note: Thumbnails, when dropped into an album,
change to suit the current size of the thumbnails in
the target album.

An essential part of Album’s management is that it
allows you to control both the program and how
the program interacts with Windows. This is done
through the preferences commands in the Album:
Preferences submenu. The following section
describes each of these commands and details
how you can use them to improve the way Album
works for you:

Customizing the way you
work
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Album

Choosing this command opens the Album dialog
box. (Double-clicking on the status bar also
performs the same function.) In this dialog box
you can set various features related to working
with files and thumbnails.

Using the Display Information group box you can
change what information is displayed with each
thumbnail or filename. In thumbnail mode you
can choose to display the filename, subject (if the
thumbnail contains a subject), or neither.
Checking the Don’t Show Thumbnail Slide option
removes the slide around a thumbnail and only
displays the thumbnail image. This is helpful when
viewing a large number of thumbnails and you
want to have as many as possible displayed in the
current view. In filename mode you can choose to
display either file attributes, keywords, subjects,
descriptions or directories of files.

If you find your albums are using too much disk
space, check the Reduce True Color to 256 Color
option. The next time you insert thumbnails, any
True Color thumbnails are automatically
converted to Indexed 256-Color. (This can help
reduce thumbnail size by two-thirds.) This does,
however, increase thumbnail insertion time and
results in poorer quality thumbnails.

Note: Indexed 256-Color thumbnails can only be
compressed using LZW compression (irrespective of
the compression option selected in the Album
Properties dialog box, see p.64).
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To ensure that thumbnails accurately show the
current status of their associated files, leave the
Enable Automatic Checking of Source Files option
checked. Any changes made to a file are
immediately updated in the thumbnail whenever
the thumbnail is selected or the view in the album
changes, such as from scrolling or performing a
sort operations. Although this option doesn’t
require any extra memory, it may slow down
processing time. Leave this option unchecked
when you are certain files have not been modified,
or it is not necessary to update existing
thumbnails, or you wish to scroll quickly through
an album without having thumbnails repaint.

Note: If, during a check, Album comes across any
missing files, a cross appears over the index number
of the appropriate thumbnail. You can then choose to
reinsert, relink or delete the thumbnail.

Checking the Minimize on Use option minimizes
Album as soon as you switch to or invoke another
program from the toolbox. The Sort Thumbnails
in Ascending Order option rearranges thumbnails
into ascending order whenever a sort command is
applied. Leaving this option unchecked sorts the
thumbnails in descending order.

To free up as much system memory as possible,
check the Swap Out to Disk When Minimized
option. The next time you minimize an album, the
system memory used for that album is released.
(This method can help free up to 100 KB for an
album containing 1000 thumbnails.)

Note: When you swap out to disk, the memory
contents of the album are saved to a file in your TEMP
directory (*.$$$). Restoring the album reads that file
back into memory. This may slow processing time
depending on the size of this file and the current
state of your system’s resources.

Displaying thumbnails in an album with no slide,
filename, and subject information
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OLE & Clipboard

Choosing this command opens the OLE &
Clipboard dialog box providing options to control
the clipboard and how Album behaves when
performing OLE operations.

Note: The default settings you see here are designed
to allow Album to function at an optimum when
performing OLE operations or when working with
image and graphics data. In most cases there will be
no need to change these settings. Do so, only when
you require greater control over OLE and clipboard
processes.

In the Formats to Copy to Clipboard group box,
you can specify if you want Album to act as a
server program when performing OLE operations,
as well as defining how image and graphics data is
represented on the clipboard. If you want to
perform an embedding or linking operation, then
you must check the appropriate OLE options, OLE
Embedding Format or OLE Linking Format. If
neither is checked, the Paste Special command in

the client program will be disabled. (If both are
checked, you can decide on which option to use
when in the client program.)

The two options, Device Independent Bitmap
(DIB) and Device Dependent Bitmap (DDB) allow
you to determine how image information is
recorded when you place image and graphics files
onto the clipboard. If you are on a network and
share data, or want an image to appear at the
same size in different resolutions, or want to
maintain the color and resolution between
programs, select the Device Independent Bitmap
option. Checking this option also enables the
Convert as Display Mode option. This converts the
data type of an image (when placed onto the
clipboard) to that of your current display mode,
and is particularly useful if you are using a low
resolution display and wish to save on system
resources.
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If you work on a stand alone machine, do not
share data with other machines or programs, and
work in the same screen resolution, then check
the Device Dependent Bitmap option. This only
records the minimum amount of display
information necessary when using the clipboard.
(You may find this option produces different
results for different programs depending on how
the program handles particular data structures.)

Note: After placing images onto the clipboard, do not
change these options before pasting. Doing so may
produce unexpected results.

When performing OLE operations, you can
determine how the object is represented in the
client document by selecting an option in the OLE
Representation Format group box. Checking the
Source Object option displays the entire file in the
client document. This allows you to clearly see the
contents and dimensions of the object file, but
does increase the client’s file size and slow down
its operation.

To display image or graphics objects without
greatly affecting the client’s file size or operation,
check the Low Resolution Place Holder option.
This places a low resolution version of the object
file into the client document and is particularly
helpful when preparing images for publication,
and it is not necessary to have a good quality
image displayed on screen.

If it is not necessary to display the object, or its
dimensions, check the Thumbnail Only option or
Album’ Program Icon option, this adds the least to
the client’s file size and uses the appropriate icon
to represent the object file.

As mentioned previously, one of Album’s more
powerful features is the way it uses drag-and-drop
between Album and other programs. Controlling
how Album behaves when you perform a drag-
and-drop operation is determined by the options
selected in the Drag-and-Drop Operation group
box.
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Selecting the Simulate Clipboard Copy/Paste
Behavior option makes Album perform drag-and-
drop operations as if you are using the Copy and
Paste commands in the Edit menu manually. Use
this option when you only wish to copy files, not
embed or link them, or if the destination program
cannot act as a client. If you want to embed or link
files, select the Paste Embedded Object Into Client
or Paste Linked Object Into Client options
respectively. For general purposes, select the
Simulate File Manager’s Behavior option. This
makes Album behave in the same manner as
Windows File Manager when performing drag-
and-drop operations.

Note: If you want to embed or link an object, and are
not sure which option is selected, hold down the Shift
key as you drop the object into the destination
program. This embeds the object, irrespective of the
selection made in the OLE & Clipboard dialog box.
Holding down the Ctrl key links the object.

Photo CD

The Photo CD dialog box gives you the option of
determining the resolution and data type of any
photos imported from a Kodak Photo CD.

Display

The Display dialog box allows you to adjust how
Album displays images. If you are working in 256-
color display mode, you can select the View
Images With a Common Palette option to display
all images using the system palette – this provides
reasonable representation of all images and makes
your work quicker because the palette is shared by
each image, and therefore does not repaint when
you switch between images.
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A 256-color display mode also enables the Don’t
Care About Background Quality option. If you
have selected the common palette option, this
makes no difference, otherwise select this option
to prevent repainting of background images –
giving you the best representation of the active
image in the fastest working environment. (You
cannot, however, compare images with this option
selected.)

The final option present in the Display dialog box
is the Monitor Gamma option which tunes your
monitor to the current display. It is very important
that you calibrate your display before you start
working with images for the first time. To learn
more about how to calibrate your display, see p.20.

Memory

The Memory command gives you the opportunity
to specify directories which can provide additional
working space when working with images. The
first directory shown is the TEMP directory
defined by the SET TEMP statement in your
AUTOEXEC.BAT file. Album provides a further
three choices that would normally be different
drives. If you are working on a network, you may
have different space allocations on the same drive;
enabling you to specify more than one temporary
directory from the same drive.
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File Formats

The File Formats command allows you to specify
which image and graphics file formats you want
Album to support. When you use Album for the
first time all available file formats are placed on
the active list, this does, however, occupy system
resources. If you only work with a limited number
of file formats, then use this command to remove

unnecessary formats from the active list – in turn
helping free up system resources.

Notes:

• If you have a thumbnail selected, the file format of
the thumbnail’s file appears with an asterisk;
indicating that the format is in use. If you want to
remove the format from the active list first deselect
the thumbnail.

• The selections you make here are reflected in all the
ImagePals GO! programs.
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1·2 Managing albums

In this chapter you will learn how to work
with albums and perform standard
operations such as creating, opening and
printing album files. You will also find
sections on using the album shelf and
various maintenance commands that
allow you to copy, delete, rename, move
and backup album files.
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Albums on a network

Album allows you to access album files on a
network. For most albums, this works on a first-
come first-served basis as albums (in general) can
only be present in one album workspace at a time
– they cannot be shared.

If you try to open an album that is already open in
another user’s workspace, you will be told that the
album is being used by another program or user.
You can only open the album if it has been
removed from the other user’s workspace or that
user exits Album. When it is available, you can
open it from the shelf.

Album allows you to view albums that are in read
only directories or ones that have been made read
only with the DOS “ATTRIB” command or by the
Read Only option in the Album Properties dialog
box, (see p.64). In fact, unlike other albums, read
only albums on a network can be viewed
simultaneously by multiple users. In a read only
album, you cannot add or delete images, change
the properties of thumbnails, or save a new user
defined order.

Your first step on the way to managing the files on
your system is arranging them into albums. At this
point, it is important to remember that ImagePals
GO! is a reduced version of ImagePals 2.0. As such,
you can only have two albums open, either in the
workspace or on the Album shelf. Also, you are
limited to a maximum number of 100 files for each
album. You can, however, have any number of
album files.

Creating a new album

You can create an album by:

• choosing the New command in the Album
menu (see procedure on the following page).

• clicking on the Album button in any of the
other ImagePals GO! program’s Save As dialog
boxes and choose “New”.

• electing thumbnails in an existing album and
then choosing the Make Album command in
the Edit menu.

Working with albums
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To create a new album:

1. choose “New” from the Album menu. The
New Album dialog box opens.

2. decide on an album title and enter it in the
Title entry box. The title you enter appears in
the new album’s title bar. (The first 8
characters of the title are used to make up the
album’s filename. Album files are indicated
with an *.ABM file extension.)

3. select a thumbnail size and compression
scheme to display files in the album. The
larger the thumbnail size the more memory
required. For most cases select the default 80 ×
80 option.

Notes:

• JPEG compression only compresses True Color and
Grayscale thumbnails, all other types are
compressed using the lossless LZW compression
scheme.

• Your compression options only affect the
thumbnails and do not change the original files.

• The Display Thumbnails in Grayscale option is
enabled if you are using a 16-color display and have
selected Bypass VGA Palette to Enable use of 16
Grays in the VGA Palette dialog box.

4. In the Create Album File in Directory entry
box, type in the directory you want the album
file to be saved in. Leave this if you wish to
accept the default directory shown.

5. In the Description entry box type in a short
description for the new album (maximum 511
characters). (Optional.)

6. Deselect the Continue to Insert Files option if
you don’t want to start inserting images
immediately after creating the album.

7. Click on the Keyword button if you wish to
assign keywords to the album, (see p.90).

8. Click OK. The new album appears in the
Album workspace. (If you have selected to
insert thumbnails, the Insert dialog box
appears, see p.72.)
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Opening album files

When you create an album, it immediately
appears in the Album workspace. It stays there
until you move it onto the shelf or remove it. To
open albums you have removed, use the Open
command in the Album menu; this returns the
album to the workspace.
If you wish to open multiple album files, hold
down the Ctrl key and click on the files you want
to open. To open a range of files click on the first
file in the range and hold down the Shift key when
you click on the last file. Any intervening files will
be highlighted as part of the selection. Dragging
your mouse over the files achieves the same result.

Note: You can also open albums by dragging them
from Windows File Manager and dropping them into
an empty part of the Album workspace or onto its
minimized icon (you cannot drop them on top of a
status line, toolbox, or any other open windows or
icons).

Changing an album’s properties

When you create an album, you have the
opportunity to define certain properties of the
album such as the title and description. To modify
these properties choose the Properties command
in the Album menu. This opens the Album
Properties dialog box which allows you to:

• change an album’s title and description.

• change the thumbnail size and compression
setting.

• show thumbnails in Grayscale, (for 16-color
displays only).

• mark the album as read only.
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Arranging albums in the workspace

During your work in Album, you may want to
compare the thumbnails between albums or to
better arrange your albums in the workspace. This
can be done by choosing the arranging commands
in the Windows menu: Cascade, Tile and Arrange
Icons. Cascade “stacks” open albums beneath and
to the right of each other whereas Tile resizes open
albums to fill the workspace. If you have a large
number of minimized album icons, the Arrange
Icons command arranges these icons along the
bottom of the workspace.

Closing albums

Closing an album file is slightly different than
closing other files such as images and text
documents. If you wish to close an album, but
intend on using it later, you should place the
album onto the album shelf. If you don’t want to
use the album in the near future, choose the
Remove command in the Album menu. This
removes the album from the workspace, but does
not delete the album file. To bring the album back
into the workspace, you have to open it again.

When working with albums, it is easy to forget that
they are in fact files, and, as files, can be managed
and maintained. At this point, it is important to
remember that when performing operations on
album files, you are not affecting the files
associated to thumbnails.

All the necessary commands to maintain album
files can be found in the Album: Maintenance
submenu. Many of these commands will be
familiar and behave in the same manner as if
using Windows File Manager. The following
section describes each of these commands in
greater detail.

Maintaining albums
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Checking a thumbnail against its
associated file

If you have been using the Windows File Manager
or even DOS to manage your files, you may
inadvertently “break” the link between some files
and their thumbnails. This can be because the
original files have moved, been renamed or even
deleted.

To determine if this link has been broken, use the
Check command. Album then performs a cross
reference between the thumbnails in the active
album and their associated files. Any thumbnails
whose files are found missing appear with a cross
mark over their index number. These thumbnails
can then be deleted if you no longer need them, or
relinked back to their respective files, (see p.88).

Notes:

• Check cannot be performed on read only albums. To
take the read only attribute off an album, deselect
the Read Only option in the Album Properties
dialog box, (see p.54).

• Checking the Enable Automatic Checking of Source
Files option in the Album dialog box automatically
checks thumbnails whenever you select them,
perform a sorting operation or scroll.

After checking the thumbnails in this album, thumbnails
1 and 2 still maintain a link to their associated files,
thumbnails 3 and 4 have lost their links

Moving an album file

Choosing the Move command opens the Move
Album dialog box. In this dialog box you can
specify a new path and directory to place the
active album file. This moves the album file, not
the files associated to the thumbnails in the
album. To move associated files use the Move
command in the File menu.
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Copying an album file

Choosing the Copy command opens the Copy
Album dialog box. In this dialog box you can copy
the active album file to a new path and directory.
This copies the album file, not the files associated
to the thumbnails in the album. To copy
associated files use the Copy command in the File
menu.

Deleting an album file

If you want to delete an album file choose this
command. This does not delete the files
associated to any thumbnails. Once you have
deleted a file, the operation cannot be undone, as
a precaution, you may want to keep a copy of
important albums stored in your TEMP directory.

Renaming an album file

Choosing the Rename command allows you to
rename the active album file. When you rename
the file, the title of the album remains unchanged.
To change the title of the album use the Properties
command in the Album menu, (see p.64).

Backing up an album file

When you back up an album, you not only back up
the album file but all those files associated with
the thumbnails. This serves two useful purposes;
one, it creates a copy of the important files you
want to keep a record of, and two, allows you to
delete the backed up files to create more storage
space.
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If you choose to delete the original files after a
backup, you can still keep a record of them by not
deleting the album file. This allows you to view the
thumbnails of the files in the album.
(To access the files you need to restore the original
album.)

To backup an album:

1. Select the album you want to backup.

2. Choose “Backup” from the Album:
Maintenance submenu. The Backup dialog
box opens.

3. Use the Directories list box to select the drive
and directory to where you want to save the
album.

Important: ALL files in the target directory are
deleted before backing up begins.

4. If you have selected specific thumbnails to
back up, check the Backup Selected Files Only
option. Unchecked and all files are backed-up.

5. Check the Compress Files option to compress
the files as they are backed up. (Optional.)

6. Click OK. The dialog box closes and the
backup begins. (The progress of the backup is
displayed in the album’s status bar.)

Notes:

• Using LZW compression, the backed up files should
occupy 15%–40% less space than the uncompressed
originals. Files which have already been compressed
with an LZW compression schemes will not be
compressed again and files compressed with other
compression schemes may not be compressed very
much (if at all).

• If it is important to achieve maximum compression,
try converting all image files in the album to the
JPEG format. JPEG, however, is a lossey compression
scheme, as such the quality of some compressed
files may not be as good as the original.
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Backing up to floppy disks

If you are backing up to a floppy disk, you will be
asked to insert additional disks as they are filled
up. During the backup operation, Album splits
files so that disks are filled as efficiently as
possible. For a rough indication of the total
number of disks required to back up an album,
refer to the Total Size to Backup indicator in the
Backup dialog box and divide this by the capacity
of your disks.

Note: It is important that you sequentially number
and label each disk used during the backup. When
you come to restore the album, you will know which
disks to insert and in which order.

Restoring an album file

After backing up an album, you must restore the
album to be able to use any of the files contained
in it.

To restore an album:

1. Choose “Restore” from the Album:
Maintenance submenu. The Restore dialog
box opens.

2. Using the Directories list box, locate the drive
and directory containing the album you wish
to restore.

3. In the Restore To group box, select the original
subdirectory or another one to restore the
backed up files to.

4. Click OK. The dialog box closes, your album
and associated files are restored to their
specified subdirectories and the album
appears in the Album workspace.

When you restore an album, any existing files with
the same filename as the files to be restored are
replaced. These files may be the files you originally
backed-up and did not delete, or files you have
since created. To avoid replacing these files you
can:

• restore the album and its files to another
subdirectory.

• rename or move the existing files before you
perform the restore operation, (see p.85).

Note: You can restore an album that has the same
title as an existing one, as long as the filename is
different or you restore it to a different directory.
However, once restored, you cannot open it in Album
until you have renamed, removed or deleted the
other.
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Whenever you create an album, it appears in the
Album workspace. You can only have to 2 albums
open in the workspace at one time. If you wish,
these can remain in the workspace or you can
place them onto the shelf in the toolbox.

The shelf is a storage area that allows you to place
albums you are not currently working on or wish
to remove from the workspace. We recommend
that you place excess albums onto the shelf, as this
not only makes it easier to work with those albums
you often use but also frees up system resources.

Note: To access files referenced in an album on the
shelf, you must return the album back to the
workspace.

You can place albums onto the shelf in the
following ways:

• drag an album icon onto the shelf button.

• open the Shelf dialog box by clicking on the
Shelf icon in the toolbox or choose the Shelf
command in the View: Options submenu, or
from the menu button on the status bar. Select
the album you want to place onto the shelf
from the Albums in Workspace list box. Click

“=>”, the selected album is automatically
removed from the workspace and appears in
the Albums on Shelf list box.

• click on an album’s control menu box (or click
once on a minimized album icon) and, from
the control menu, choose the Put on Shelf
command.

• use the batch manager’s Put on Shelf
operation.

To retrieve albums from the shelf:

• open the Shelf dialog box by clicking on the
Shelf icon in the toolbox or choose the Shelf
command in the View: Options submenu or
from the menu button on the status bar. Select
the album you want to retrieve from the
Albums on Shelf list box. Click “<=”, the
selected album is automatically moved into
the workspace and appears on the Albums in
Workspace list box. Clicking Close removes the
Shelf dialog box and returns you to the
workspace.

Using the album shelf
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1·3 Managing
thumbnails

In the previous chapter you would have
learned about albums, and how albums
help keep order of the files in your system.
This chapter takes you one step further,
explaining how to insert thumbnails of
your files into albums. Once inserted you
can manipulate the thumbnails and
perform various file management tasks
such as copying, moving, renaming and
deleting.
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Once you have created an album, you can proceed
to insert thumbnails of your files. It is important to
remember that the original file never moves, it
remains where it is on your disk. How the
thumbnail is represented depends on the type of
file it is linked, (associated) to. If its associated file
is an image or graphics file, the thumbnail displays
the contents of that file. For video and animation
files, the first frame of the sequence is displayed. If
the file’s contents cannot be shown, as in text or
sound files, the thumbnail is represented by the
file’s program icon or a default icon.

Inserting thumbnails of files into an
album

Whether you want to insert thumbnails into an
empty album or one that already contains other
thumbnails, you can:
• use the Insert command from the Thumbnail

menu, (see procedure on the following page).

• drag-and-drop existing thumbnails from one
album to another.

• use the Acquire command in the Album menu
(only available if you have an installed TWAIN
device).

• click on the Album button in any of the
ImagePals GO! programs Save As dialog boxes.

• drag-and-drop files directly from Windows
File Manager into an album.

Note: The thumbnail of a given file can only be
inserted into the same album once. If you insert a
thumbnail from the same file more than once, the
original thumbnail and information are updated each
time.

Working with thumbnails
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To insert thumbnails of files:

1. Choose “Insert” from the Thumbnail menu.
The Insert dialog box opens.

2. Using the Directories list box, locate the drive
and directory containing the file or files you
want to insert

3. Select the media type you want to choose from
the List Media Types combo box. (Choosing a
type here determines which file extensions are
available in the List File Types of Media Type
combo box below.)

4. Select the file extensions of the files you wish
to insert from the List File Types of Media Type
combo box.

5. Select the album you want to insert to from
the Insert Files to Album combo box. (Optional
if inserting thumbnails when creating a new
album.)

6. Select the files you want to insert from the File
Name list box.

Note: You can perform a quick insert of single files by
double-clicking on their filenames.

7. Check the Include all Subdirectories option if
you wish to include matching files from any
subdirectories.

8. Check the Write Errors and Journals to File
option if you wish to see a report created
about any problems occurred when inserting
the selected files. Use this if inserting a large
number of thumbnails and you don’t want the
insertion process to be halted if any errors
occur. (This is particularly useful if inserting
files overnight.) If this is left unchecked, any
problems that occur prompt a message box
and halt the insertion process.

9. Click Insert. The selected files are inserted into
the specified album. The dialog box remains
open to allow you to insert more files into
albums. To close the dialog box click on the
Close button.
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Inserting files from a TWAIN device

If you have an installed TWAIN device, such as a
frame grabber or scanner, you can input images
directly to an album using the Acquire command
in the Album menu. Choosing this command
opens the Acquire dialog box. In this dialog box
you can specify the filename, drive and directory
of the file to be created. Once created, a thumbnail
of the file is automatically placed in the active
album. (If acquiring multiple images, ensure that
the last character in the filename is a number.
Album will automatically add one to this with each
successive input.)
When using an auto feed scanner and scanning
large numbers of pages with information on both
sides, check the Increase File Number by Two
option at the bottom of the dialog box. In the first
scan, all files are saved in consecutive odd
numbers, e.g IMG0001.BMP, IMG0003.BMP...

When you scan in the reverse sides of the pages,
the files are saved as even numbers, e.g.
IMG0002.BMP, IMG0004.BMP... This way you can
be sure that the file order is identical to your page
order.

Note: Before you use the Acquire command, you have
to select the TWAIN device to input from in the Select
Source dialog box, opened by choosing the Select
Source command in the Album menu.

Updating a thumbnail

If the file of a thumbnail was created in one of the
ImagePals GO! programs, the thumbnail is
immediately updated each time there is a change
to the file. To update thumbnails of files generated
by other programs, choose the From File
command in the Thumbnail: Update submenu.
This performs a check between each
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thumbnail and its associated file. If, during an
update, Album comes across any missing files or
broken links, a cross appears over the index
number of the appropriate thumbnail. You can
then choose to reinsert, relink, (see p.88) or delete
the thumbnail.

Note: If you have the Enable Automatic Checking of
Source Files option checked in the Album dialog box,
(see p.54), thumbnails are updated whenever selected
or the view in the album change. To update a large
number of thumbnails, first check this option and
then scroll through the album. Each thumbnail is
automatically updated as you scroll.

Changing a thumbnail

When you first insert the thumbnail of a file it
displays the contents of that file, where possible.
At times you may want to change these contents,
especially for those thumbnails whose contents
cannot be displayed, e.g. sound and text files.

When you change a thumbnail, you replace it with
image or graphics data from the clipboard using
the From Clipboard command in the Thumbnail:
Update submenu. With this method you can use
your favorite images to represent thumbnails or
customize particular thumbnails to represent
particular files.

The first two thumbnails have been changed with an
existing image file
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Selecting thumbnails

When you perform an operation, it is applied to all
the thumbnails in an album, or to selected
thumbnails only. You can select or deselect
thumbnails in the following ways:

to select one, click on it.

• to select a range, click on the first thumbnail
in the range and then, with the Shift key held
down, click on the last.

• to select or deselect individual thumbnails,
hold the Ctrl key down and click on the ones
you want to add to, or delete from the current
selection.

• in the Search dialog box, choose the Select
option in the Action to Take combo box. Any
thumbnails matching the search criteria are
selected.

Using the Edit: Select submenu, you can select or
deselect thumbnails with the following
commands:

• All selects all the thumbnails in the current
view.

• None deselects all selected thumbnails.
(Clicking on an album’s status bar has the
same affect.)

• Invert selects the thumbnails which are not
currently selected and deselects the ones
selected in the current view. This is useful if
you want to select a large number of
thumbnails while wanting to exclude one or
two. In such cases select the ones you do not
want and then invert the selection.

Note: If you only want to view selected thumbnails,
choose the Selected command in the View menu. To
display all the thumbnails again, choose the All
command from the same menu or click on the view all
button in the search ribbon.

Thumbnails, 1, 3 and 4 are selected and appear with a
highlighted filename
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Using the clipboard

One of the easiest ways to move thumbnails is by
dragging them and dropping them into other
albums. Other means involve using the clipboard
and the Cut, Copy, and Paste commands in the
Edit menu.
Cutting a thumbnail removes it from the album
and places it onto the clipboard (only the
thumbnail is cut; the thumbnail’s file is not
affected and remains where it is). If you choose to
use the Copy command, you have the option of
copying the thumbnail, its associated file or
filename. Copying a filename is useful, particularly
if it has a long pathname and you wish to use it in
any of the file access dialog boxes, such as the
Open dialog box, or when referencing it in a text
document.

Note: If you want a program to automatically open
the same file each time you access it, paste the file’s
filename into the command line of the Program
Properties dialog box, accessed by choosing the
Properties command in the tool button menu. If the
program supports the opening of files with a
command line, the file will automatically open each
time you invoke the program via the toolbox.

Pasting thumbnails into an album

The Paste command is available when the
clipboard contains thumbnails that have been cut
or copied from an album. In user-defined sort
mode, (see p.108), pasted thumbnails are placed at
the end of an album. In other sort modes they are
placed according to the sort order.

Note: If you paste thumbnails into an album that
already contains the same thumbnail, the existing
copy is replaced.

Printing

Album allows you to print an album, thumbnail,
associated file and keywords to any Windows
compatible output device. Before you print,
however, make sure that your output device is
turned on, connected, and selected in the Printer
Setup dialog box. You can access this dialog box
through the Printer Setup command in the Album
menu.

When ready to print, choose the Print command
in the Album menu, a submenu appears with the
following commands:
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Album

When you want to print out information on all the
thumbnails contained within an album, choose
the Album command. This opens the Print Album
dialog box where you can define what information
to print, such as the thumbnail, file attributes,
keywords, subjects and descriptions. You can print
individual options or all at the same time.

When printing out thumbnails, you can determine
their size in the Thumbnail Size spin box, from 1/2
an inch square to 3 inches square. To only print
the currently selected thumbnails, check the Print
Selected Items Only option. For the best possible
representation of thumbnails, check the Create
Thumbnails From Original File option. This
produces a clearer thumbnail, but does slow down
processing time.

Other options are also included in the Page Setup
dialog box, accessed by clicking on the Page
button. Here you can change the page layout,
create a header and/or footer as well as choose to
append any relevant file information.

Thumbnails

To print information regarding individual
thumbnails choose the Thumbnails command.
This opens the Print Thumbnails dialog box. When
you print a thumbnail, you can include its
filename, index number and thumbnail slide. You
can also control how many thumbnails appear on
each page as well as the size of each thumbnail.

Checking the Create Thumbnails From Original
File option produces a clearer thumbnail, but does
slow down processing time. To print only selected
thumbnails check the Print Selected Items Only
option. (This is disabled if no thumbnails are
selected.) If you have not selected any thumbnails,
all thumbnails in the album are printed.
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Keywords

If any of your thumbnails have keywords assigned
to them, you can print out those keywords by
choosing the Keywords command. The Print
Keyword dialog box opens. This is a useful
command to use when you want to print a list to
cross reference your keywords to filenames. Select
the keywords to print by highlighting them in the
Keywords to Print list box .

Other options are also included in the Page Setup
dialog box, accessed by clicking on the Page
button. Here you can change the page layout,
create a header and/or footer as well as choose to
append any relevant file information.

File

If you want to print out the file of a thumbnail,
choose the File command. The Print File dialog
box opens. This dialog box contains the following
options:

In the Title entry box you can enter a title for the
images to be printed. (The default, “&f”, prints the
file’s filename.) Checking the Scale to Fit the Page
option scales the file to be as large as possible on
the page while maintaining its aspect ratio. With
this option unselected, the file prints at the size
determined by its resolution.

The Center Image Horizontally, Center Image
Vertically and Start From Top Left Corner options
allow you to choose where images print on the
page. If both the center options are selected,
images print centered on the page. (Choosing
these options disables the corresponding From
Top or From Left option.)

Note: For some application-linked files, their
associated program will be called up to the print the
file. Once printed the program will then close. For
example, to print a Write document, Write is opened
with the selected document in the workspace; the
Print dialog box also appears. Enter your print
settings and click OK. The file is printed and Write
closes, returning you to Album.
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Thumbnails are a way of viewing the contents of
files. You are not however restricted to viewing
them in this mode only. You can view them as
filenames – just like the File Manger of Windows.
(You can view different albums in different
modes.)

To change the viewing mode of an album, select
the album in the workspace (by clicking on its title
bar or icon) and then choose the Thumbnails or
Filenames command from the View menu. The
following provides a brief explanation of what
information is displayed when you choose either
of the viewing modes:

• Thumbnails displays the thumbnails of files
from left to right and top to bottom in an
album. You can also choose whether or not to
display the filenames, subjects or slides of
thumbnails using the Album preferences
dialog box, (see p.54).

• Filenames displays filenames from top to
bottom in the album. Depending on selections
made in the Album dialog box, (see p.54),
various information is displayed about each
file, such as: file attributes, subject,
description and pathname. (Viewing in
filename mode is quicker than thumbnail
mode, and requires less memory.)

Scrolling an album

Album provides several methods for locating
thumbnails in an album. The most obvious is the
scroll bar, which appears on the right side of the
album when it is not possible to display all the
thumbnails in the current view. Clicking on the
scroll bar direction buttons moves the view by a
single line. Clicking in the scroll bar moves the
view by a page, and dragging the slider allows you
to move quickly to a new location.

Viewing
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If you have a large number of thumbnails in an
album you can automatically scroll them by
choosing the Auto Scroll command in the View
menu. The Auto Scroll dialog box opens. In the
Delay Time entry box, type in a the time (in
seconds) you want Album to wait before each
scroll. When ready, click on the OK button. The
dialog box closes and automatic scrolling begins.
(To pause/continue scrolling, press the Space bar,
to stop scrolling press the Esc key.)

If you want to go to a specific thumbnail, choose
the Scroll To command in the View menu. This
opens the Scroll To dialog box which lists the
filenames and index numbers of all the
thumbnails in the album. Selecting a filename and
clicking OK automatically scrolls the thumbnails
to the location of the selected filename. (Double-
clicking on a filename performs the same effect.)

Performing a slide show presentation

Album provides a slide show feature which allows
you to showcase your image, graphics and sound
files. This includes using impressive transition
effects and providing manual or automatic
playing. Apart from its obvious value as a
presentation tool, slide show can also serve as a
personalized screen saver.

To create a slide show:

1. Choose “Slide Show” from the Thumbnail
menu. The Slide Show dialog box opens.

2. In the Transition group box decide on a
transition effect. To control the speed between
each slide, use the Speed slider. To determine
how the slide show plays the presentation,
select either the Delay (in seconds),
Synchronize With Audio Files (displays a new
slide once an audio file has finished playing),
or Manually With Keyboard or Mouse options,
(use this option if you want to control the
transition yourself).



82 IMAGEPALS GO!

06/13/95 TaurusCONFIDENTIAL

3. Select other options such as: Continuous
Repeat, Resize Large Images to Fit Screen, Use
a Common Palette to Show Pictures (16-Color
display mode only) and Hide Pointer During
Slide Show. (Optional.)

4. In the Attributes group box click on the Text,
Bkgd Color and/or Bkgd Music buttons to
define their respective attributes.

Notes:

• You can only play MIDI files as background music.

• If you have the Synchronize With Audio Files option
checked, the time specified in the Delay option is
used as a pause between each audio file.

5. Once you are satisfied with the settings, click
OK. The files are loaded to memory and the
slide show begins. (If you selected the
Manually With Keyboard or Mouse option, the
Slide Show Controls dialog box opens detailing
the respective keyboard or mouse operations
used to control the playing of the slide show.)

Once you have played a slide show, you may want
to retain the same slide show settings for future
use. To do this, click on the Save button to save
your settings to file. Click on the Load button to
bring your settings back into the slide show .

When you load a settings file, all the settings
currently chosen in the Slide Show dialog box
change to the new configuration. Once loaded,
you can still change the settings to suit the
particular type of slide show you are preparing,
but the original file remains unchanged unless you
resave it.

Viewing image and graphics files

If a thumbnail’s file is an image or graphic file, you
can view it using the Viewer program of ImagePals
GO!, (see p.112). This is particularly useful if you
want to compare multiple files at their original
size, or just to see a file in greater detail. To open a
file in the Viewer program, double-click on its
thumbnail or select the thumbnail and choose the
File command in the View menu.

Once a file is displayed in a Viewer window, you
can perform basic editing functions such as
copying the file, or portions of the file to the
clipboard. You can then paste the data into
another compatible file or use it to change a
thumbnail’s representation, (see p.75).
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Displaying information

You can display information about the file of a
thumbnail in two ways: choosing the File
Information command in the View menu, or by
clicking on a thumbnail with the right mouse
button. Choosing the File Information command
opens the File Information dialog box. Here you
can find information about the attributes of the
file as well as details including the filename, file
format and space occupied on disk, and whether
the file is read only. Clicking on the More button
displays additional information about any masks,
keywords, subjects or descriptions associated with
the file. (Clicking the right mouse button on a
thumbnail displays similar information in a pop-
up dialog box.)

Note: For different files and formats the information
provided may vary.

To display information about an album, choose
the Album Information command. This opens the
System Information dialog box. Here you can find
information about the attributes of the album,
thumbnails, files, and compression schemes. The
description of the album is also displayed, as well
as any keyword lists and mark files.

Displaying program features

The Options command in the View menu provides
a submenu of commands to show and hide
various features of the Album program window.
These include the shelf, toolbox, mark palette and
search ribbon. Choosing one of these commands
hides the appropriate feature – choose it again to
show it. These commands can also be found in the
button menu on the left of the status bar.

Note: The toolbox and mark palette can also be
hidden by choosing the Close command in their
respective menus.
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Once files are represented in an album, you can
manage them just as you would from Windows
File Manager. This includes copying, deleting,
renaming and moving files on disk. You can even
convert the data types and file formats of files as
well as change their attributes and program
association.

All the commands to manage files are contained in
the File menu. These commands behave in much
the same way as those previously discussed in the
Album: Maintenance submenu. The major
difference being that File commands are applied
to a thumbnail’s file and not to the album itself.
The following describes each these commands in
greater detail:

Converting a file’s format

The Convert File Format command lets you
convert image and graphics files into a variety of
different file formats. This command can be
applied to individual or multiple files, sharing the
same or different formats. Changing file formats is
particularly useful when you want to open a file in
a program that doesn’t support a file’s current
format, e.g. changing *.TIF files to a *.BMP format
so they can be opened in Paintbrush.

When you choose this command, the Convert File
Format dialog box opens. In this dialog box you
can select to save the converted files in the same
directory, or have them saved in another
subdirectory. You can also delete the original files
after conversion or choose to insert thumbnails of
the converted files into an existing album.

Maintaining files
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Converting a file’s data type

The Convert Data Type command allows you to
convert image and graphics files from a variety of
data types into a common data type. This is
especially useful when you are preparing a large
number of images for publication, e.g. converting
your images from RGB True Color to Grayscale.

When you choose this command, the Convert
Data Type dialog box opens. In this dialog box you
can choose the target format and destination of
the files and whether to delete the original files
and/or insert the new files into an existing album.

Moving files

Choose the Move command if you want to transfer
the files of selected thumbnails to a new path and
directory . After moving, thumbnail information is
updated to reflect the files’ new location.

Copying files

Choosing the Copy command opens the Copy
Files dialog box. Here you can copy the files of
selected thumbnails to a new path and directory.
There is also an option to insert thumbnails of the
copied files into a new album. (If you want to copy
a file to the clipboard, use the Copy command in
the Edit menu.)

Deleting files

The Delete command deletes files from disk as
well as removing the selected thumbnails from
their album. This command cannot be undone. As
a precaution, make a back up of your files or keep
a copy of your important files in the TEMP
directory.
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Removing thumbnails from albums

Sometimes you will want to remove thumbnails
from albums. It could be that you no longer need
them or that they should not have been in the
album in the first place. Removing a thumbnail
from an album doesn’t affect the associated file on
disk. If you remove a thumbnail accidentally, use
the Undo command in the Edit menu or insert it
again from the original file.

To remove a thumbnail, select it and choose the
Clear command in the Edit menu, or press the Del
key. The selected thumbnail is removed from the
album.

Renaming files

Use the Rename command to change the
filenames of those files whose thumbnails you
select. A filename can be up to eight characters
long. (It is not necessary to type in a file
extension.) If you select multiple files, all
filenames will change to the same name, only the
file extensions remain different. (You cannot
rename files that share the same file extension.)

Note: You can use DOS wildcards when renaming
multiple files. For example, the string “NEW*.TIF” will
replace the first three characters of all the selected
files to NEW.
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Changing a file’s attributes

Choosing the Attributes command allows you to
change the attributes of the files whose
thumbnails are selected. These attributes can be:
Read Only, Archived, Hidden or System. A read
only file allows you to open the file but prevents
any changes being saved to it. This is useful when
sharing files over a network and you do not want
anyone changing the content of your files. The
archived option identifies those files, with an
asterisk, which have been updated since their last
backup. Selecting the Hidden attribute hides files
from view and System marks files as MS-DOS
system files, also hiding them from view.

Changing the association of a file

The Associate command allows you to change the
association between a file and the program it was
last saved in. You will want to change the
association of a file when, for example, you
double-click on a filename in Windows File
Manager and the file opens in a different program
than expected. (Such situations often happen
when you use different programs to work on the
same file.)

Choosing the Associate command opens the
Associate dialog box. In this dialog box you specify
the file extension whose program association you
want to change. If you do not select any
thumbnails, this command affects all thumbnail
files sharing the same extension.
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Relinking thumbnails to their associated
files

When the thumbnail of a file is inserted into an
album, it maintains a link to the location of this
file. This is why you can manage files by
manipulating their thumbnails. If files have been
moved using DOS or Windows File Manager, or, if
you remap your disk drives, Album may lose this
link. Thumbnails that have lost their link appear
with a cross mark over their index number. (The
File command in the View menu is also disabled
for such thumbnails.) If you want to reestablish
this link, you can reinsert the thumbnail for the
file or use the Relink command.

To relink thumbnails:

1. Select the thumbnails that need relinking.

2. Choose “Relink” from the Thumbnail menu.
The Relink dialog box opens.

3. Select the drive and directory that contains the
files you want to relink the thumbnails to.

4. Click OK. The dialog box closes and the
relinking process begins. The thumbnails are
compared against the files present at the new
location, their paths are updated and, if
necessary, so too are their thumbnails and
information.
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1·4 Labeling thumbnails

Albums are essentially databases that
provide an easy-to-use and efficient way of
cataloging and managing files. As with
any database, its real worth is how it
allows you to organize, label and search
for information related to these files. This
chapter, and the next, explain how Album
achieves this by using keywords, marks,
subjects and descriptions.
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Keywords are phrases that can be assigned to the
thumbnails of files to help you conveniently group
files which share common themes. For example,
the keyword “Sports” can be assigned to all those
files in an album that have a relationship to sports.

A keyword can consist of one word, such as “sun”,
or multiple words such as “sun in Hawaii”. (When
using multiple words, ensure that each word is
separated by a space.)

You can define keywords in the following ways:

• choosing the Keyword command in the Album
menu, (see procedure on the following page).
Using this method you can easily assign the
same keywords to multiple thumbnails as well
as perform keyword searches.

• clicking on the Keyword button in the New
Album dialog box, (opens the Keywords dialog
box).

• adding it to the Keywords list in the
Thumbnail Properties dialog box, (see p.96).
To use the same keyword repeatedly, it is best
to use the first method described above.

To create a keyword list:

1. Select the album you want to assign the
keyword list to.

2. Choose “Keywords” from the Album menu.
The Keywords dialog box opens.

3. In the New Keyword entry box type in a
keyword. Click on the Add button or press the
Enter key to add the keyword to the keywords
list box. (If there are existing keywords, the
Change button is also enabled. Clicking this
button changes the highlighted keyword in the
list to the keyword appearing in the New
Keyword entry box.) To add more keywords
repeat this procedure.

Defining keywords
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If you wish to adopt a keyword list from
another album open in the workspace, select
the album from the Adopt Keywords From
Album combo box. This places the album’s
keyword list (if it has one) into the keywords
list box.

4. Click OK. The dialog box closes and the
keywords are now associated to the album. To
assign the keywords to a thumbnail, use the
Thumbnail Properties dialog box, (see p.96).

Note: The total size of keywords in an album cannot
exceed 65,536 characters. You can assign as many as
32 keywords to a thumbnail. Each keyword cannot
exceed 31 characters.

Saving and loading keywords

When you create a keyword list you can save it for
future use or editing. To do this, click on the Save
button in the Keywords dialog box. This opens the
Save Keywords dialog box. Select the path you
want to save the keyword file to and type in a
filename, choosing either a DOS or Windows

*.TXT file extension. Use Windows if you are
working with Windows, DOS if you want to
transport your file to a DOS application program
for editing.

To add keywords from an existing keyword file,
click on the Load button in the Keywords dialog
box. The Load Keywords dialog box opens. Choose
the appropriate keyword file and click OK. You will
be asked if you want to retain the current
keywords. Selecting YES adds the keywords to
those currently in the keyword list box; NO
replaces the current keywords with those of the
file.

If preparing a large number of keywords, you may
find it easier to first compile the keywords in a
word processing program and then load them into
an album. Doing so, you can easily edit and, where
possible, spell check your work. (If using a word
processing program, each keyword must be
separated by a paragraph break.)
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Marks serve as visual tags for thumbnails in
albums. In a sense they are very similar to
keywords differing only in implementation.
Whereas keywords work “behind the scenes”,
marks are clearly displayed on the thumbnail
slide. You will find marks particularly useful when
you want to quickly navigate around an album and
pin-point certain thumbnails for future
operations.

Assigning marks

To assign marks you need to use the mark palette.
This is a floating palette that allows you to assign
up to 26 marks to a thumbnail. To move the
palette drag on its title bar, or, if you are using the
keyboard, choose the Move command in the mark
palette control menu. Each mark is represented by

a letter of the alphabet and once assigned the
letter is displayed next to the index number on the
thumbnail slide.

To assign a mark:

1. Open the album containing the thumbnails
you want to assign marks to.

2. If the mark palette is not open, choose “Show
Mark Palette” from the View: Options
submenu. The mark palette opens. (The same
command can also be accessed from the menu
button on the status bar.)

3. Double-click on any letter in the mark palette,
the Edit Marks dialog box opens. (This dialog
box can also be opened with the Edit
command in the mark palette control menu.)

Defining marks
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4. Select the letter you want to assign from the
Marks list box. In the Mark Name entry box
type a description (up to 31 characters).

Note: You can edit and assign descriptions to any
mark by simply clicking on it and then entering a
description in the Mark Name entry box. If you wish
to use marks already present in another album select
the album from the Adopt Marks From Album combo
box. The marks, if any, appear immediately in the
Mark list box.

5. Click OK. The dialog box closes, returning you
to the Album window. The description of the
mark now appears in the mark palette.

6. Click on the mark to assign in the mark
palette. The View and Assign buttons are
enabled. To assign multiple marks, hold down
the Ctrl key and click on each mark to select it.
(Clicking again deselects the mark.) To select a
range of marks, click on the first mark in the
range and, holding down the Shift key, click on
the last. All marks in the range are selected.
(Dragging your mouse over the marks
performs the same function.)

7. Click on the Assign button, the Assign button
changes to Stop and, when you move your
pointer onto an album, the pointer changes to
the mark pointer.

8. Place the mark pointer on the thumbnail you
wish to mark and click once. The letter of the
mark is immediately shown on the top left
corner of the thumbnail slide, next to the
index number. (Clicking again removes the
mark.) Repeat this procedure if you want to
assign the same mark to another thumbnail.

9. When you have finished assigning the current
mark, click on the Stop button in the mark
palette, the button changes to Assign. To
assign another mark repeat steps 6 to 8. (You
can assign more than one mark to the same
thumbnail.)

Note: To remove the mark palette, double-click on the
title bar or choose the Hide Mark Palette command in
the View: Options submenu.
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Examples of marked thumbnails

Viewing marks

The advantage of using marks is that they are
quick and easy to apply and you can see which
thumbnails have been marked accordingly. When
you want to view marked thumbnails the
procedure is just as convenient.

To view marked thumbnails:

1. Open the album which contains the marked
thumbnails you want to view.

2. If the mark palette is not open, choose “Show
Mark Palette” from the View: Options
submenu.

3. Select the letter or letters in the mark palette
you wish to view.

Note: To select individual marks, hold down the Ctrl
key and click on the mark to select it. (Clicking again
deselects the mark.) To select a range of marks, click
on the first mark in the range and, holding down the
Shift key, click on the last. All marks in the range are
selected. (Dragging your mouse over the marks
performs the same function.)

4. Click on the View button, the View menu
opens with the commands AND, OR and View
All. Choosing AND immediately displays those
thumbnails that contain all the selected
marks. For example, if you have selected the
marks A, B and C, only those thumbnails with
the marks A, B and C are displayed. Choosing
the OR command displays those thumbnails
with either one of the selected marks. To
display all the thumbnails in the album,
choose the View All command or click on the
view all button in the search ribbon.

Note: To view a diverse range of marks, use the Marks
command in the Thumbnail: Search by Item submenu,
(see p.105).
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Managing marks

When it comes to managing marks in an album
you can choose from a number of commands in
the mark palette control menu. These commands
are particularly helpful when you want to perform
batch operations over a large number of
thumbnails.

Performing a batch mark assignment

To assign the same mark to many thumbnails, you
can mark each one individually, as demonstrated
in the previous procedure, or first select them, and
then use the Assign Selected command in the
mark palette control menu. This automatically
affixes the currently selected mark or marks to
each thumbnail.

Removing marks

To remove specific marks from thumbnails, first
select the marks you want to remove and then
select the thumbnails you want to remove them
from. Click on the control menu of the mark
palette and choose the Clear Selected command.
The selected marks are removed from the
appropriate thumbnails. To remove all the

selected marks in the active album, choose the
Clear All command, (this command is disabled if
no marks are selected).

Loading and saving marks

Whenever you assign a mark, it is recorded as an
MRK file in the same directory of the album file. If
other people share the same album, such as a
Photo CD, you can send this file to them, and have
them load it into their machine using the Load
command in the mark palette control menu. This
provides you with a convenient method of
bringing to the attention of another user any
thumbnails you may want to highlight. To only
send the marks of a few thumbnails, select the
concerned thumbnails and then save these as a
new MRK file with the Save command.

Converting marks to keywords

There may be times when you would like to use
the same mark as a keyword. This allows you to
use the mark when performing more complex
searches as well as being another way to define
keywords, rather then using the Keywords dialog
box.
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To convert marks to keywords:

1. Select the mark or marks you want to convert.

2. Select any thumbnails you want to remove the
selected marks from, (optional).

3. Choose “Convert to Keywords” from the mark
palette control menu. The Convert to
Keywords dialog box opens.

4. Check the Clear Marks From Selected
Thumbnails option to remove the mark, or
marks, from any selected thumbnails after
they have been converted to keywords.
Checking the Clear Mark Name From Palette
option removes the mark, or marks, from the
mark palette after the conversion. (Optional.)

5. Click OK. The selected marks are converted to
keywords and will now appear in the
Keywords dialog box. Depending on your
options selected in the Convert to Keywords
dialog box, the marks will also be removed, or
remain unchanged, from any selected
thumbnails and the mark palette.

Thumbnails, by their very manner, allow you to
append a great deal of information about a file,
thus making it easier to locate and identify your
files. This information consists of keywords,
subjects and descriptions. All of which are user-
defined, fully searchable and can be applied to
individual or multiple thumbnails.

As mentioned in the previous section, keywords
can be used to group like files together. Subjects
help extend on keywords by providing brief titles,
such as “skiing in the Alps”, which add further
information about the file. Descriptions on the
other hand offer more detailed information about
any one file, such as observations about what the
file contains, date and time or any peculiarities
that should be remembered for later recall.

Assigning thumbnail
properties
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To assign a keyword, subject or description to a
thumbnail:

1. Select the thumbnail whose properties you
wish to assign.

2. Choose the Properties command in the
Thumbnail menu. The Thumbnail Properties
dialog box opens.

3. If assigning keywords, click on the Keywords
List combo box and select the keyword you
wish to assign. (If the album has no keywords,
or you wish to create a new one, enter its
name directly.) Press Enter to place the
keyword into the Keywords list box. If
assigning a subject or description, type your
comments in the appropriate Subject or
Description entry boxes.

Note: Keyword text cannot exceed 31 characters,
subject text 127 characters, and description text 4095
characters.

4. Click OK. The dialog box closes and the
thumbnail’s properties are updated.

If no thumbnails are selected, or you have selected
multiple thumbnails, the Next and Go To buttons
are enabled. Click on “Next” to step through the
thumbnails and stop on the one whose properties
you want to change. If you want to edit a specific
thumbnail, click on the Go To button. The Go To
dialog box opens listing available thumbnails.
Select the one you want and click OK. The
thumbnail now appears in the Information group
box and any properties it may already have are
displayed in the appropriate entry boxes.

Note: Double-clicking on the thumbnail in the
Information group box opens the file of the
thumbnail in its associated program, where possible.
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Saving and loading properties

Having assigned properties, you can save these to
a file and then export it to a text editing program.
In this way you can easily edit and, where possible,
spell check your work. Clicking on the Save button
in the Thumbnail Properties dialog box opens the
Save Properties dialog box. Select the path you
want to save the properties file to and type in a
filename, choosing either a DOS or Windows
*.TXT file extension. Use Windows if you are
working with Windows, DOS if you want to
transport your file to a DOS application program
for further editing.
At the bottom of this dialog box are the three
properties options, keywords, Subject and
Description. By default, all three are checked. If
you want to save a selected property, uncheck the
ones you do not require. This allows you to

 load only the selected property back into the
original thumbnails – without affecting other
property information.

Notes:

• When you save properties to file, additional file
information appears identifying the particular
properties as well as the file of the thumbnail.
Therefore, it is impossible to save the properties
from one thumbnail and then load it into another,
(without first altering the file location data
manually). When you open a properties file in an
editing program, it displays the following file
location and properties information:
[c:\pals2\manual\editor\woman.tif]
Keyword=woman, history, old English
Subject=Woman sitting on rocking chair.
Description=Image prepared for ImagePals GO! user
guides.

• When adding keywords to a properties file,
separate each keyword with a comma followed by a
space.
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1·5 Locating thumbnails

In the previous chapter you would have
learned how to assign marks, keywords,
subjects and descriptions to thumbnails.
This chapter explains how you can use
these properties to pin-point where in an
album, or albums, specific thumbnails are
located; using either the search ribbon for
quick one step searches, or one of the
search commands for more complex
multiple criteria-based searches.
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Album brings with it a variety of commands and
features to provide you with the most precise
means of locating thumbnails and their associated
files. In all, there are three methods you can use to
perform searches. The first is using the search
ribbon for quick, on-the-spot searches, the
second, choosing a user defined search command
from the Thumbnail: Search by Query submenu,
and the third, creating multiple criteria searches
with the Search, or Search by Item commands in
the Thumbnail menu.

Before you begin to perform searches, however,
you need to have a clear idea of some of the logic
behind search operations. The following section
explains this logic which will help you better
understand the possibilities available when using
the search facilities of Album.

Search criteria and queries

Whenever you perform a search, you must first
specify what it is you want to search on (the
criteria). This can be anything from keywords,
filenames or data types. Once you select a criteria,
you need to further define which aspect (the
query) of the criteria to look for. For example, if
you have chosen the criteria filenames, the query
would be the filename you are looking for.

Note: If the query consists of more than one word,
you must encase it with double quotes, e.g. “New
York”.

Search basics
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Boolean operators

One of the more powerful features of Album is its
use of logical (Boolean) operators: NOT, AND, OR
and ( ). These allow you to search a vast number of
files quickly, looking only for specific file features.
Below is a brief description of how each of the
operators work:

NOT, is used to define the opposite of the
indicated criteria. This allows you to isolate
thumbnails whose file’s format makes it a minority
in the album. For example, in an album consisting
largely of *.TIF files, performing a file format
search – NOT *.TIF, results in all thumbnails,
except those whose files are of the *.TIF format,
being displayed.

AND, allows you to specify more than one criteria
to search on. (Matching thumbnails must meet all
of these criteria.) For example, to find thumbnails
about your holiday in Spain, you could perform a
subject search on – “holidays AND Spain”. All

thumbnails with the words holiday and Spain in
their subjects would be displayed.

OR, allows you to match thumbnails that meet one
or more of a specified criteria. For example,
performing a filename search on – F*.* OR G*.*,
will display only thumbnails whose files begin with
an F or G.

( ), the parenthesis are used to group criteria
together. This is particularly important if you have
several queries, some of which must be paired
together. For example, if you are searching on the
values, A, B and C, then you could define the
search as, “A AND (B OR C)”, or “(A AND B) OR C”.
In the first example, the thumbnails must have A
or either B and C. In the second example, the
thumbnails must have both A and B and maybe C.

Note: To use an operator simply double click, (or
select), on the desired operator in any of the dialog
boxes that support this feature. The operator appears
in the Query entry box.
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Some examples of what you can achieve using Boolean operators.

•jhOperator Criteria Query

 File Name  new*.tif

 AND NOT  Image Data Type  Indexed 16-Color

This query searches for all TIF files which begin with the letters NEW and are not
Indexed 16-Color.

•jhOperator Criteria Query

 Keyword  holidays AND “image editor”

 OR  Description  “lying on the beach”

 AND  Date  from 4/18/93 to 2/05/94

This query searches for all thumbnails which have the keywords “holidays” and
“image editor” or have the phrase “lying on the beach” in their description. The
files of these thumbnails must be created between 4/18/93 and 2/05/94.

•jhOperator Criteria Query

 Media  Image

 AND  Keyword  “user guide” OR (user AND guide)

 AND  Subject  “Children” [Case]

 AND NOT  Description  “lying on the beach”

This query searches for all thumbnails which are of the image media type, have
“user guide” or the words “user” and “guide” as their keywords, have “Children”
in their subject (matching case) and do not include the phrase “lying on the beach”
in their description.
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Match case and match whole word

When performing a search on text, many of the
search dialog boxes allow you to “match case” or
the “whole word”. Matching case tells Album to
find those thumbnails matching the upper or
lower case of the query. For example, to match the
case of “New York”, only New York would be
selected, any variations, such as “new York” or
“NEW YORK” would be ignored.

Matching the whole word searches on occurrences
of a defined word. For example, to match the word
“man”, only man would be selected, not manage.
If this option is left unchecked, any occurrence of
the letters (not the word), m-a-n will be selected,
such as man, manage and human.

Note: Selecting Match Whole Word performs a search
much quicker than leaving this option unselected.

Performing a search can be as simple, or complex,
as you want to make it. In most cases you will be
performing simple, single criteria searches which
are best done from the search ribbon, (see p.106).
If you want more control over the search process
then choose one of the search commands in the
Thumbnail menu.

Some notes before you start:

• Although the search dialog boxes share similar
features, it is not possible to itemize all the
possible search variations here. The best
method is to read the previous section on
search basics, and then experiment with your
own variations.

• In some search dialog boxes, you will find that
the criteria and query can be very complex
and involved. Try working out your search on
paper first before entering it into a Query
entry or list box.

Performing a search
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• Whenever you perform a search, the search is
done only on the thumbnails in the current
view of the active album. If you want to
perform consecutive searches, ensure that the
Search Entire Album command in the
Thumbnail menu is checked. (The same
command can also be accessed from the menu
button on the status bar.) Alternately you
could click on the view all button or select the
View All command in the View menu. The next
time Album performs a search, all thumbnails
in the album will be included, irrespective of
the results of the previous search or current
view.

Defining a search query

To define complex searches, or to create a user
defined search, you need to access the Search
dialog box. This allows you to search on any
criteria and query and in any combination. If you
want to search on a single criteria only, use one of
the other search commands in the Thumbnail:
Search by Item submenu, or select a criteria from
the search ribbon.

To perform a search using the Search dialog box:

1. Open the album you want to perform the
search on.

2. Choose “Search” from the Thumbnail menu.
The Search dialog box opens.

3. Select the criteria you wish to search on in the
Search Criteria combo box. Depending on the
criteria chosen, define your query. (For
multiple queries click on the appropriate
operator.)

4. Click on the Add button. The query is now
placed in the list box underneath. To include
additional criteria, repeat steps 3 and 4. To
change a query, select the query in the list box
and redefine the criteria and query from the
Search Criteria group box. This time, when
you are ready to add the query, click on the
Change button. This replaces the query
selected in the list box with the new one. To
remove a query, highlight it and then click on
the Remove button.

5. To search all albums in the workspace, check
the Search all Albums in the Workspace
option.
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6. In the Action to Take combo box select View,
Go To or Select. View displays the thumbnails
matching the search criteria. Go To indicates
where in an album, with a yellow arrow, the
thumbnails are located and Select selects
those thumbnails matching the search criteria.

7. If you want to save the query for later use, type
in a name in the Query entry box and press
Enter. To remove an existing query, highlight
it and click on the Remove button. To edit a
query, select it from the Query entry box, the
contents of the query are displayed in the list
box.

8. Click OK. The search is performed and, if you
defined a query, the query is saved and added
as a menu command in the Search by Query
submenu.

Note: Depending on the media type and file format
of the thumbnail files, some options may be disabled.

Search by Item

If you have assigned keywords, subjects or marks
to thumbnails, you can search on these criteria by
choosing the Search by Item command. A
submenu appears listing the following commands.

Keywords

Choosing the Keywords command opens the
Search by Keywords dialog box. All the assigned
keywords in the active album are displayed in the
Keywords list box. Double-click on the keyword to
place it into the Query entry box . To search on
multiple keywords use the Boolean operators.
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Subjects

To search on only the subject of a thumbnail,
choose the Subjects command. This opens the
Search by Subjects dialog box. Here you can type
in a text string to search on the subjects of
thumbnails. (If you use multiple words, ensure to
place “double quotes” at the beginning and end of
the string.) To aid in your search, use the Boolean
operators as well as the Match Case and Match
Whole Word options.

Marks

Using the mark palette is one means of locating
thumbnails when working in an album. You can
also locate marked thumbnails with the Search by
Marks dialog box, opened by choosing the Marks
command. All the assigned marks in the active
album are displayed in the Marks list box. Double-
click on a mark to place it into the Query entry
box. To search on multiple marks use the Boolean
operators.

Search by Query

Any queries defined in the Search dialog box
appear in this submenu. To apply a query, simply
choose its name from the submenu list; the search
begins immediately. To edit or remove queries,
you have to select them from the Query entry box
in the Search dialog box.

Using the search ribbon

Many of the search criteria found in the search
dialog boxes can also be accessed directly from the
ribbon. You will find the search ribbon a much
more convenient and quicker way to perform
single criteria searches. To use the search ribbon,
select a criteria to search on from the criteria
combo box, the first on the left. The query box
changes to suit the chosen criteria. In the query
entry box, define your query. Click on the search
button, (on the left), the search is performed and
any thumbnails matching the search criteria are
displayed in the album. To show all the
thumbnails, click on the view all button.
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The above query searches for TIF files that begin with the characters NEW

The above query searches for thumbnails with the keyword “competition”

The above query searches for files last saved between April 18, 1993 and February 5, 1994

The above query searches for thumbnails whose description contains the words “public relations”   



108 IMAGEPALS GO!

06/13/95 TaurusCONFIDENTIAL

When you first create an album, thumbnails
appear in their order of insertion. This order can
be identified by the index number that appears on
the top left side of each thumbnail slide. Any new
thumbnails are placed after those already present.
Using your mouse, you can freely move
thumbnails by dragging and dropping them
anywhere within the album, changing their order
accordingly. Apart from this method, there are
also several sort mode commands in the
Thumbnail: Sort by submenu that allow you to
define the order of thumbnails in an album. They
are:

• Name – reorders thumbnails alphabetically
according to the filenames of their associated
files.

• File Type – reorders thumbnails according to
the file type of their associated files.

• Size – reorders thumbnails according to the
file size of their associated files.

• Date – reorders thumbnails according to the
date their associated files were last saved on.

• Media Type – reorders thumbnails according
to the media type of their associated files.

Sorting thumbnails
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• Subject – reorders thumbnails according to
their subject properties.

• Description – reorders thumbnails according
to their description properties.

• Others – opens the Sort dialog box which
allows you to choose more media specific
options such as image dimensions and
resolutions.

• User Defined – makes the current sort mode
the user defined mode. As such you can freely
move the thumbnails with your mouse. (You
cannot change the position of a thumbnail
while in one of the other sort modes.)

Notes:

• When you choose the Save Sequence command in
the Thumbnail menu, the thumbnails in the album
are reordered according to the current user defined
sequence.

• To move multiple thumbnails at the same time, use
the Move command in the Thumbnail menu.(This
command is disabled if you are in a sort mode or
there are no thumbnails selected.)

• You can determine the order of thumbnails, by
checking the “Sort Thumbnails in Ascending Order”
option in the Album dialog box (see p.54) for
ascending order, or leaving it unchecked for
descending order.
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When you have finished your Album session, exit
by closing the program window or by choosing the
Exit command in the Album menu. If you have
changed the order of images in an album and wish
to retain the new order, choose the “Save
Sequence” command in the Thumbnail menu
before you close Album. (For a large number of
albums, use the same command from the batch
manager.)

Exiting Album
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1·6 Viewer

Viewer is a unique program that allows
you to quickly “call up” image and
graphics files, displaying them in
individual Viewer windows. This allows
you to preview and compare files as well as
perform basic editing functions, such as
crop and copy, without having to first
invoke the program the file was originally
created in.
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Viewer can be invoked in a number of ways:

• double-clicking on the Viewer icon in the
ImagePals GO! program group. (The Open
dialog box appears, allowing you to select a file
to view.)

• choosing the Viewer command from the Pals
menu in any ImagePals GO! program. (The
Open dialog box appears, allowing you to
select a file to view.)

• double-clicking on the thumbnail (or
filename) of any image or graphics file in
Album.

• dragging a thumbnail and dropping it onto the
Viewer program icon in the Album toolbox.

• choosing the File command in the View menu
of Album. (The contents of the file are
displayed.)

The Viewer window

When you invoke Viewer you will see:

• An image within the workspace (the central
portion) of the Viewer window.

• The status bar, at the bottom, displaying
relevant file information. (Double-clicking on
the status bar opens the Viewer preferences
dialog box, see p.119.) Two buttons are also
included on the status bar: the first button
(from the left) is the switch button which
allows you to switch between multiple Viewer
windows. The second button is the drag-and-
drop button. To drop the Viewer file into
another program, first click on this button and
drag your mouse. Releasing the mouse drops
the image into the destination program.

Running Viewer
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The Viewer program window
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Although the Viewer is primarily geared towards
providing a quick view of an image or graphics file,
you can still perform basic editing functions such
as crop and copy. Cropping discards areas of an
image that are not necessary to your work. This is
particularly useful if you want to isolate parts of an
image or decrease file size. To perform more
extensive editing, choose the Run Image Editor
command in the File menu. This invokes Image
Editor program with the file open in the
workspace.

Note: If you have assigned another editing program
from the Viewer dialog box (see p.119), chose the Run
Other Editor command. This is useful if you want to
edit a graphics file in a drawing program. Alternately
you can click on the drag-and-drop button in the
status bar and then drag your mouse and drop the file
into the program you want it to open in.

To crop an image, drag you mouse over the area
you want to crop, (the area is immediately
deselected when you create another area, click the
right mouse button or choose the Select None
command in the Edit menu), and choose “Crop”
from the Edit menu. The areas outside the
selection area are discarded.

If you have made a mistake or wish to undo the
command, choose the Reopen command in the
File menu. This restores the image to its last saved
version. To save any changes, choose the Save As
command in the File menu.

Note: After cropping an image, the drag-and-drop
button is disabled.

Editing a file in Viewer
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Using the Copy commands

There are two copy commands in the Edit menu of
a Viewer window: Copy and Copy Filename. Copy
duplicates the entire image or selected part, and
places it onto the clipboard. Copy Filename places
the full pathname of the currently displayed image
onto the clipboard.

When it comes to controlling the view of an image,
all the necessary commands can be found in the
View menu of a Viewer window. If you are familiar
with the viewing commands in ImagePals GO!
Image Editor you should have no problem here as
these commands are identical in nature.

Actual view

Choose the Actual View command when you want
to display an image with each image pixel shown
by one screen pixel. This is the normal (1×) view of
an image. Graphics are displayed at the size
determined by your current display driver’s
resolution.

Changing the view in Viewer
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Zoom in and out

Each Viewer window allows you to zoom in and
out on an image. Zoom In enlarges the view of the
image, Zoom Out reduces the view of the image.
You can zoom in one step increments from ⅛× to
8× the original size.

The global viewer

When the whole of an image cannot be displayed
in its window, you would normally have to use the
scroll bars to locate hidden areas. The global
viewer of Viewer is a better method that allows
you to locate these areas quickly and easily by
providing a thumbnail view of the entire image.
This thumbnail image contains a floating frame
that can be moved independently around the
viewer. Moving the frame automatically repo-
sitions the current view of the active image. To
access the global viewer, click on the global viewer
box at the intersection of the scroll bars.

Full screen

The Full Screen command displays an image at
the current zoom level using the whole screen as a
backdrop. (The program window, menu bar and
status bar are all hidden.) Most of the functions
and shortcut keys remain available. Scroll bars
appear when the image is too large to be
completely displayed. To return to normal screen
mode press the Esc key.

Fit in window

When using any of the zoom commands the image
window does not change to fit the new image size.
As such there may be times when the whole of an
image cannot be displayed in its window and
scroll bars appear along the window border. If you
wish to display the image within its window
without scroll bars, choose a Fit in Window zoom
command.

Note: The maximum and minimum zoom level
possible is determined by the original size of the
image.
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Viewing Information

When you display the contents of a file in a Viewer
window, you can access information about that
file at any time by choosing the Information
command in the View menu. This opens the
Information dialog box which displays attribute
information such as data type, width and height,
resolution, and size of the image. There is also a
section on file information including the filename,
format, compression, whether the file can be
previewed, space occupied on disk and if the file is
readable.

Note: For some file formats the above information
may vary.

Viewer is a quick and efficient way to view image
and graphics files, as such you can be easily over-
run by Viewer windows. To control these
windows, use the batch commands in the File
menu: Close All, Minimize All and Restore All.
Choosing “Close All” closes all Viewer windows
from the screen. If you have been performing crop
operations, you will be asked to save the changes
made. Select No to discard changes; Yes to save
the changes. Choosing “Minimize All” minimizes
all Viewer windows and the “Restore All”
command restores minimized Viewer icons.

Managing Viewer Windows



118 IMAGEPALS GO!

06/13/95 TaurusCONFIDENTIAL

Positioning Viewer windows

One of the real advantages of Viewer is that you
can open multiple Viewer windows to compare
different files, this is particularly useful in the
Album program of ImagePals GO! where you may
find the current thumbnails too small to
adequately view or differentiate between images.

All the commands to control the positioning of
Viewer windows can be found in the View menu.
Each command is described below:

Place Viewers on Top

Choosing this command brings all Viewer
windows and minimized Viewer icons to the top,
obscuring any programs that may be currently
open. The last Viewer window to be brought to the
front is the active window. To make an individual
window active, you can click on its title bar or click
on the switch button on the left of the status bar.
This displays a list of all Viewer windows in the
workspace, choosing one makes it active.

Cascade and Tile Viewers

The Cascade and Tile Viewers commands arrange
Viewer windows within the confines of your
screen. Cascade places each window below and to
the right of the previous. Tile resizes all viewers to
fill the screen. Any minimized Viewers icons are
also brought to the front.

Always on Top

Choosing the Always on Top command ensures
that all open Viewer windows and minimized
Viewer icons appear at the front of other
programs. This is useful if you have other
programs running at the same time and do not
want to inadvertently change the active window. If
you want to use another program first uncheck
this command.
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Each Viewer window has similar Preferences
commands as those mentioned in Album, i.e.
Photo CD, Display, Memory and File Formats. The
only unique command is Viewer. Choosing this
command opens the Viewer dialog box allowing
you to determine the type of format images take
when placed onto the clipboard, i.e. DIB (Device
Independent Bitmap), DDB (Device Dependent
Bitmap), and WMF (Windows MetaFile).

You can also select another editing program which
can accessed from the Run Other Editor command
in the File menu of each Viewer window. If you
work with graphics, then assign your graphics
editing program here. The next time you view a
graphics file and wish to perform additional
editing, choose “Run Other Editor”. This opens the
file in the specified editing program.

Note: The Viewer preferences options only apply to
the image in each individual Viewer window. This
allows you to select different options for different
images and purposes.

Customizing Viewer
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When you have finished using a Viewer window,
exit by closing the program window or by
choosing the Exit command in the File menu.
When exiting a Viewer window, you will be asked
to save the changes to files you may have cropped.
Select YES to save the changes, NO to discard
them. If you have many open Viewer windows,
choose the Close All command in either of the
Viewer’s File menu. This closes all Viewer
windows in the workspace.

Exiting a Viewer window
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S E C T I O N  2

Image Editor
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2.1 Managing images, introduces the Image
Editor program window and describes basic
Image Editor functions such as creating,
opening, saving and viewing image files.

2.2 Image Editor basics, explains how to apply
commands and highlights drag-and-drop
operations. There are also sections on using
the clipboard and setting the Image Editor
Preferences.

2.3 Making selections, shows you how to select
areas of an image, save and load these areas
as masks, and use the object pool.

2.4 Manipulating images, explains how to
change an image’s dimensions, resolution
and data type and provides descriptions of
transformation commands such as rotate and
flip.

2.5 Painting, takes a look at working with colors
and how you can apply those colors to
images. There is also a section on editing the
color tables of Indexed-Color images.

2.6 Enhancing images, describes how you can
“touch–up” images by adjusting and
correcting the color values of pixels. There is
also a section on creating and using a variety
of special effects.

2.7 Image input & stitching, introduces the
different sources from which you can obtain
images and explains how to stitch images.

Section preview
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2·1 Managing images

This chapter and the next cover some of the
more common functions you will use
when working with images. They do not
tell you how to perform complicated image
editing or enhancing, but do provide basic
information that will help you establish a
good and efficient working method.

In this chapter you will find descriptions
about standard menu commands such as
Open and Close as well as ways you can
view images, information and elements of
the interface.
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Image Editor can be invoked in a number of ways:
• double-clicking on the Image Editor icon in

the ImagePals GO! program group.
• choosing the Image Editor command from the

Pals menu in any ImagePals program.
• double-clicking on the thumbnail (or

filename) of any image or graphics file in
Album.

• dragging a thumbnail and dropping it onto the
Image Editor program icon in the Album
toolbox.

• dragging a filename from Windows File
manager and dropping it onto the Image
Editor icon or workspace.

The Image Editor window

When you invoke Image Editor you may see:
• Images in individual windows within the

workspace of the Image Editor window (the
central portion).

• The toolbar, on the left, containing the tools
necessary to create selection areas, paint and
edit images.

• The color palette, on the right, displaying
available colors as well access to the size and
shape of paintbrushes and the object pool.

• The status bar, at the bottom, where
information about the current image as well as
menu command and tool messages appear.

Running Image Editor
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The Image Editor program window
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All Windows programs provide some standard
commands that have a lot in common – and, if you
are familiar with Windows, you will already know
how to use commands such as Open, Save and
Print. This section describes the Image Editor
Open, Duplicate, New, Save As, Print, Close and
Exit commands highlighting, where necessary, any
ways they differ from other programs.

Opening image files

After installation you will find a number of files in
the SAMPLES subdirectory under your installation
directory. To open these files, or other image and
graphics files, choose the Open command in the
File menu. The Open dialog box appears
displaying files of the current type shown in the
List Files of Type combo box. To open a file simply
click on its filename and press OK. (Double-

clicking on the filename also opens the file.) The
dialog box closes and the file is opened in the
Image Editor workspace.

When you select a file, its information and
contents (where possible) are displayed at the
bottom of the dialog box. Some files may not
display automatically, in such cases click on the
Preview button to display the contents of the file.

Notes:

• When you open a graphics file, which does not
contain bitmap data, it is converted into an image
and opens in an untitled window. (The data type of
this image is the same as your current display
mode). You can then edit it in the same way as
other images.

• You can also open the files you have most recently
been working on by choosing their names from the
list at the bottom of the File menu.

Standard commands
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Opening multiple files

One of the advantages of Image Editor is that it
allows you to open multiple images in one go. You
can also open images from the Album program of
ImagePals or Windows File Manager. To open
multiple images:

• in the Image Editor Open dialog box, use the
Shift key in conjunction with your mouse to
select a range of files or the Ctrl key to select,
or deselect, individual files. (You can also drag
your mouse over the filenames to select them.)
Once selected click OK. The images open in
individual windows in the program
workspace.

• from ImagePals Album, select multiple
thumbnails and drag them to Image Editor’s
icon in the Album toolbox, or to Image Editor’s
workspace or minimized program icon. This
invokes Image Editor and automatically opens
the files in the Image Editor workspace.

• from Windows File Manager, select and drag-
and-drop image files in the same way as from
ImagePals Album.

Duplicating images

When working with images you often need to
make a copy of the active image. This allows you to
continue editing without any danger of losing a
particular stage of your work. You can also retain
copies to compare images at different stages of
your editing, helping you see the effects of
particular commands. When you create a
duplicate image it opens in a new untitled window
that becomes the active window.

You can create a duplicate image in a number of
ways:

• choose the Duplicate command in the Image
menu.

• use the Ctrl + D shortcut key.

• choose the All command in the Edit: Select
submenu to select the entire image and drag
the selection into the open workspace.
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Creating a new image

In many cases your images will have been
obtained with some sort of image input device like
a scanner or frame grabber, or you will have
opened them from a CD or hard drive. At other
times you will want to start with a “clean” image
window for compiling elements of other images
together or for using the painting tools of Image
Editor.

To create a new image:

1. Choose “New” from the File menu. The New
dialog box appears.

2. In the Data Type combo box, choose the data
type of the new image.

3. Select an image size.
To choose a pre-defined size click on one of
the Standard options. To define your own
size, click on the User Defined option and
enter values for both the width and height.
Clicking the Active Image option creates an
image the same size as the active image in

the workspace. (This is unavailable when there
are no open images.) The Current Clipboard
option creates an image the same size as the
image on the clipboard. (This is unavailable
when there is no image on the clipboard.)

4. Enter a value for the image’s resolution.

Note: If the Unit of Measure option in the Image
Editor dialog box (see p.151) is in centimeters or
inches, the resolution determines how many pixels are
used to create the image: the higher the resolution,
the greater the number of pixels and thus amount of
memory required to store the image. When the Unit
of Measure is pixels, the resolution determines how
large your image will be when printed. The higher the
resolution, the smaller your image will print (the
memory required to store the image however,
remains the same).

5. Click OK. The dialog box closes and the new
image, filled with the background color,
appears in an untitled window.
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Managing image windows

Image Editor allows you to work with many
images open at the same time. This convenience
makes it easy to combine elements from different
images as well as being able to compare the
“before-and-after” of a performed effect.
While working with multiple files can be
advantageous, it also places a strain on your
system’s resources – not to mention making the
workspace cluttered. Image Editor provides the
solution to these problems with the Cascade, Tile
and Arrange Icons commands found in the
Window menu. Cascade “stacks” open windows
beneath and to the right of each other while Tile
resizes open windows to fill the workspace. If you
have a large number of minimized image
windows, the Arrange Icons command arranges
their icons along the bottom of the workspace.

Note: To save on system resources, minimize images
you are not currently working on. If you have a large
number of open images, use the batch manager’s
Minimize command (see p.144).

Saving files

When you want to save your work, Image Editor
provides three commands: Save, Save As and Save
to Album. Use Save when you wish to update the
file you are currently working on and Save As
when saving new files, or to save a file to a new
destination and/or filename. The Save to Album
command is provided in the batch manager (see
p.144) and allows you to save files to an album in
the ImagePals Album program.

Note: You can also save a file to a new album from
the Save As dialog box by clicking on the Album
button. This opens the Insert Thumbnails Into Album
dialog box. To save to an existing album, check the
Save to Album option and select an album from the
combo box. (This is disabled if there are no existing
album files.)

You should save whenever you make changes to a
file that you wish to retain. When you save, you
can choose the file format you save your image in
and, if a compression option is available, whether
or not to compress the file.
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To save an image for the first time:

1. Select the image you wish to save.

2. Choose “Save As” from the File menu. The
Save As dialog box opens.

3. In the Directories list box, select the drive and
directory you want to save the image to.

4. Select a format from the List Files of Type
combo box. For general purposes choose
“TIF”.

5. In the File Name entry box type the name of
your file (up to eight characters). You do not
need to enter the File extension.

Note: If you type in an extension, ensure that it is the
same as the extension shown in the List Files of Type
combo box.

6. Click OK. The dialog box closes, returning you
to the window containing your saved image.

Printing files

When it comes to printing your work, Image
Editor allows you to output files to any Windows-
compatible output device. Before you print
however, make sure that your output device is
turned on, connected and selected in the Printer
Setup dialog box. If you need to, you can access
this dialog box through the Printer Setup
command in the File menu.

Note: The Printer Setup command allows you to
change the current printer options including the
orientation of the page from landscape to portrait,
and the paper size.

When ready to Print, choose the Print command
in the File menu. The Print dialog box opens. In
this dialog box you have a number of options to
control the printed output.

The Scale to Fit the Page option scales images to
be as large as possible on the page while
maintaining their aspect ratio. With this option
unchecked, images print at the size determined by
their resolution.
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The Center Image Horizontally, Center Image
Vertically and Start From Top Left Corner options
allow you to choose where images print on the
page. If both the center options are selected,
images print centered on the page. (Choosing
these options disables the corresponding From
Top or From Left option.)

Image Editor also allows you to accurately control
the way your printer simulates multiple shades in
your images. The process used to do this is called
halftoning or sometimes dithering. For everyday
printing, select the Perform Halftone by Printer
option. This leaves the halftoning to the printer
and should produce the quickest and most
acceptable results.

The Tone Map button provides access to the Tone
Mapper dialog box (see p.212). This function is
intended to help you calibrate your printer to
reproduce images consistently.

Halftoning

Halftoning is the process of creating a pattern of
black and white dots to simulate shades of gray.
This enables you to print Grayscale (or color)
images on single color printers and maintain the
feeling of continuos tone.

The Image Editor program allows you to control
the halftoning process from the Halftone dialog
box, accessed by clicking on the Halftone button
in the Print dialog box. (Uncheck the Perform
Halftone by Printer option to enable the Halftone
button.)

If you uncheck the High Contrast option in the
Halftone dialog box, you can adjust the options for
shape, frequency and angle. If you do not uncheck
the High Contrast option, your printed image will
look as if no halftoning occurred; white will appear
to be very white and black to be very black.

Note: The Halftone settings do not affect the printing
of Black & White images if the images, which are
being printed pixel on pixel.
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To determine the best halftone screen settings,
you need to understand how variations in shape,
frequency and angle settings affect the final
output when printing images.

Shape

Shape determines the shape of the black dot used
to construct the halftone. The most commonly
used shape is Round, the default setting.

Other options such as Diffused convert the image
using a predefined diffusion process. This
converts the image to black or white by
transferring the difference between the pixel and
the midtone value (127) to the pixel on the right
and beneath it. This process continues from the
first row and moves to the second row and so on.
This process results in an image having less
concentrated areas of black, thus creating a grainy
texture appearance.

The Dispersed option divides the image into small
areas which contain different pixel patterns. Each
pixel pattern simulate a shade of gray. The final
image when outputted to your printer gives the
impression of a large transition area between the
shades of gray.

Frequency

The distance between the centers of the halftone
dots is referred to as frequency. This value is
independent of the dot size; a high frequency
number produces small dots, a low frequency, big
dots. As the dot size increases, a darker tone is
produced, until it begins to merge with its
neighbors, eventually becoming solid black.

Note: The higher the frequency, the smoother the
apparent change in tone. However, your output
device and other factors in the commercial
production process will impose an upper value limit
on the frequency settings.
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The default, 53 lpi (lines per inch) is calculated to
give you a near-optimum result on a 300 dpi
printer. For lower resolution printers, use a
frequency between 30 lpi and 50 lpi; for other
medium resolution printers, use the default or a
frequency between 50 lpi and 80 lpi; and for high
resolution printers choose a frequency between 90
lpi and 150 lpi. If you set the frequency too high,
the printer will not be able to reproduce the image
properly thereby losing image and causing the
output of the image to be darker than expected.

Output for commercial production

If your work requires outputting to a high-
resolution imagesetter to produce black-and-
white artwork for commercial reproduction, it is
best to first consult your commercial printer
manual to determine a range of acceptable screen
frequencies.
If you output onto bromide (light-sensitive paper),
reduce the frequency by between 20 and 40 lpi
because some information may get lost or

distorted because your commercial printer has to
produce film from your bromide. Reducing the
frequency increases the size of the halftone dots,
thus reducing distortion.
To print quality results whenever possible, you
should output to film. It is important that the film
is the right way round. One side of the film is
coated with photographic emulsion which is the
side that your image is produced.

After receiving the film, the commercial printer
places it in direct contact with a light-sensitive
printing plate and exposes the plate. If the
emulsion is on the wrong side, the thickness of the
film will diffuse the halftone dots enough to cause
visible distortion to your image. So, first ask your
commercial printer if they want the image “right
reading, emulsion down”, or “wrong reading,
emulsion down”; then your service bureau should
be able to change the way the film is exposed to
suit the commercial printer’s requirements.
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Angle

The Angle option determines the angle of the
halftone screen. The default angles are industry
standard, but they can be adjusted for different
images.

For Black & White output, if you select 90°, the
dots occur in vertical columns evenly spaced
across the image. If your image contains near-
vertical or vertical lines, a 90° screen may produce
a disturbing effect. The default (45°) is most
commonly used because it rarely conflicts with
elements within images.

Closing files

When you have finished working on an image or
wish to remove it from the workspace you can
close it. It is a good idea to close unnecessary
images as these occupy valuable system resources.
You can close an image in one of the following
ways:

• choosing the Close command in the File
menu.

• double-clicking on the image window’s
Control menu box.

• choosing the Close command in the image
window’s Control menu.

• using the batch manager’s Close or Close
Quickly commands.
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When you close an image, it disappears from the
workspace. If you have not saved it, or you have
made changes since you last saved it, a message
box appears asking if you want to save the
changes. Selecting No discards any changes; Yes
saves them.

Note: Close Quickly is only available in the batch
manager (see p.144) and allows you to close selected
images from the workspace quickly. When you use
this command no new images or changes made to
existing images are saved.

Exiting Image Editor

When you have finished working with Image
Editor, you can exit by closing the program
window or by selecting the Exit command in the
File menu. When exiting Image Editor, you will be
asked if you want to save any new images or any
changes made to previously saved images. If you
have many open images, use the batch manager to
save the images and then close them with the
Close Quickly command.
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When you display an image, the image pixels are
“mapped” onto your screen pixels. Controlling the
mapping of these pixels determines the way you
see images. This section takes a look at the ways
you can control the view of an image as well as
how to display file and system information and
choose which features of the interface to show or
hide.

Adding a view

When you edit specific portions of an image it is
often difficult to appreciate how your editing
affects the image as a whole. By choosing the Add
a View command in the View menu, you can
create a new window containing an additional
view (at 1×) of the image you are working on. This
image differs from a duplicated image in that any
editing done in either of the windows is reflected
in the other.

Note: You can have up to eight views of an image
displayed at any one time.

Viewing
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Editing an image (at 8x view) with a view added (at 1x view)

Viewing images

Image Editor provides commands to adjust both
the magnification at which an image is displayed
as well as to determine what area of an image is
displayed. This section deals with the ways you
can control the magnification and window size
while the next, the global viewer, describes how to
control what area of an image is displayed.

Zooming and the zoom tool
  

When you edit an image, you may want to see part
of it in greater detail or more of the image at a
smaller size. You can do this in two ways: with the
Zoom In and Zoom Out commands from the View
menu or using the zoom tool. Choosing the Zoom
In command enlarges the view of an image (up to
8× the actual view). To reduce the view, (up to ⅛×
the size of the actual view), choose the Zoom Out
command.
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The zoom tool provides an alternative to the Zoom
In and Zoom Out commands and allows you to
accurately zoom in on particular areas of an
image. You can use the zoom tool in a number of
ways:

• clicking the left mouse button zooms in on the
area under your mouse pointer.

• holding down the Shift key and clicking the
left mouse button zooms out.

• clicking the right mouse button or double-
clicking on the zoom tool icon in the toolbar
returns the image to actual view (1×).

• dragging the left mouse button creates a
rectangular viewing marquee. When you
release the mouse button the image
automatically zooms in on the area defined by
the marquee.
(If the viewing marquee is too large or the
image is already at
8× magnification the view will not be
adjusted.)

Note: You can also press the “+” and “-” keys to zoom
in and out on images – irrespective of the current tool
selected.
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Image at actual view 1x, enlarged to 3x view and reduced to a ¹/³x view

When you use the zoom commands, the image
window does not change to fit the new image size.
So after zooming in, the entire image will not
display in its window and scroll bars appear along
the window border. If you wish to display the

complete image within its window choose an
available zoom command from the View: Fit in
Window submenu. (The maximum zoom level
available is determined by the size of the image
and the resolution of your current display mode.)

Fit in window
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Actual view

When you open an image for the first time, it is
displayed at its actual size, with each image pixel
shown by one screen pixel. This is the normal (1×)
view of an image. If you change the view of an
image, for instance by zooming, you can return
the image to its actual size by choosing the Actual
View command in the View menu.

Note: If you have the zoom tool selected, clicking on
the image with the right mouse button performs the
same effect.

Full screen

The Full Screen command in the View menu
displays the active image at the current zoom level
occupying the entire screen; the program window,
toolbar, status bar and color palette are all hidden.
The current editing tool and the Undo command
(via the Ctrl + Z shortcut key) remain available and
scroll bars appear when the image is too large to
be completely displayed. To return to normal
screen mode press the Esc key.

The global viewer

When the whole of an image cannot be displayed
in its window, you would normally have to use the
scroll bars to locate hidden areas. The global
viewer of Image Editor is a better method that
allows you to locate these areas quickly and easily
by providing a thumbnail view of the entire active
image. This thumbnail image contains a floating
frame that can be moved independently around
the viewer. Moving the frame automatically
repositions the current view of the active image.
To access the global viewer, choose the Show
Global Viewer command in the View: Options
submenu or the same command from the menu
button in the status bar.
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The global viewer can be moved around the
program workspace by dragging on its title bar. If
you want to use the global viewer for a quick
adjustment, click on the box that appears at the
intersection of the scroll bars in an image window.
This displays the global viewer at the corner of the
image window and allows you to reposition the

current view by dragging the floating frame. When
you release the mouse the global viewer
disappears, or returns to its last position in the
workspace.

Note: Double-clicking on the title bar of the global
viewer closes it. Double-clicking anywhere else adjusts
the view of the image to fit within its window.

Using the global viewer to reposition the current view of an image



142 IMAGEPALS GO!

06/13/95 TaurusCONFIDENTIAL

Displaying information

Image Editor provides information about the
active image and your system status with two
commands in the View menu: Image Information
and System Information. The Image Information
command opens the Image Information dialog
box. Here you can find information about the
attributes of an image, such as its data type,
dimensions, resolution, and working file size as
well as various file details. These details include
the filename, file format and space occupied on
disk. There is also a section on the current state of
your memory, disk space and whether your file has
been modified since you opened it.

Note: For different file formats the information
provided may vary.

The System Information command opens the
System Information dialog box. Here you can find
information about Windows including the version
number, your current mode and available system
memory. There is also a section on disk
information displaying the current directory, size
of your disk and available disk space.

Displaying interface elements

The Options command in the View menu reveals a
submenu of show and hide commands. Choose
the appropriate commands to show or hide the
status bar, toolbar, color palette, global viewer,
object pool and rulers. This submenu can also be
accessed from the workspace by clicking on the
menu button on the left of the status bar.
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2·2 Image Editor basics

So far this guide has introduced the Image
Editor program and provided a look at
some of the more common menu
commands. This chapter takes you
towards your first step into the world of
image editing. Here you will learn how to
apply commands, use the clipboard,
perform “drag-and-drop” operations and
customize certain display and feature
options.
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To perform an operation, you first need to select
the image you want the operation to be performed
on, and then choose the appropriate command
from a menu. This is fine when you are working
with single files but proves inefficient when it
comes to working with a large number of files. To
overcome this “one-command, one-file”
limitation, Image Editor provides an extra feature,
the batch manager, that allows you to apply one
menu command to multiple files. This section first
describes the batch manager and then goes on to
explain the Restore and Undo commands which
can help you recover from any mistakes made.

Using the batch manager

The batch manager can be accessed in two ways:
double-clicking on an empty part of the
workspace or by choosing the Batch Manager
command in the File menu. Once invoked, the
batch manager opens and displays the filenames
of all image windows present in the workspace

as well as a combo box of operations that can be
applied to them: Close, Close Quickly, Minimize,
Print, Resolution, Restore Window, Save and Save
to Album.

Note: The batch manager can only apply operations
to files that are open in the workspace. When there
are no open files it is unavailable.

To perform a batch command, choose the
operation you want to perform, select the files you
want the operation to be performed to and click
OK – batch manager does the rest for you.

The batch manager, contains an additional two
commands not available in any of the Menus –
Close Quickly and Save to Album. Close Quickly
clears the workspace of all the selected images at
one go, without asking to save changes. (Only use
this command if you do not want to retain
changes made in an image or to save new files.)
Save to Album allows you to save selected images
to a new or existing album in the Album program
of ImagePals.

Applying commands
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Recovering from mistakes

One of the advantages of working with images in a
digital format is that you can experiment with a
variety of different effects and filters. As a
consequence you may perform a function and end
up with an unsatisfactory or unexpected result. If
you make such a mistake while working in Image
Editor, you normally correct it by selecting the
Undo or Restore commands.

Using the Undo command

If you change your mind about a command you
have applied, choose the Undo command in the
Edit menu. The effect of the command is reversed,
and the image is restored to its state prior to the
application of the command. Undo will only undo
the most recent change. If you need to undo
several changes, use the Restore command to
return the image to its last saved version.

Instead of “Undo” at the top of the Edit menu, you
may see:

• Redo... this appears after you have “undone”
something, effectively allowing you to undo
the undo; in other words, redo the change.

• Can’t Undo is displayed when it is not possible
to undo the last action, e.g. after you have
saved an image file.

• Undo Disabled means that the undo facility
has been disabled in the Image Editor dialog
box (see p.151).

Restoring an image

When experimenting with a variety of effects on
an image, you may not wish to undo each effect
after you perform it. In such cases you can restore
the image to its original state by choosing the
Restore command in the File menu. (This
essentially closes the file and reopens it.) Before
using this command, consider carefully because it
cannot be undone. If in doubt, create a duplicate
image before restoring so that you can compare
the current stage of your work with the original.

Note: Whenever you make a major change to an
image that you want to retain, you should save, or
create a duplicate.



146 IMAGEPALS GO!

06/13/95 TaurusCONFIDENTIAL

Many commands in Image Editor make use of the
clipboard. The clipboard is a temporary storage
area for any type of information. This may be an
image, text or even sound; but the clipboard can
only hold one piece of information at a time.
When you place something on the clipboard,
existing clipboard data is overwritten: irrespective
of whether you placed new data on the clipboard
from another program or from Image Editor.

Performing a cut and copy operation

The most common methods of placing data onto
the clipboard are the Cut and Copy commands.
Regardless of the active image’s data type, the Cut
and Copy commands are always available. Copy
places a duplicate of a selected area on the
clipboard whereas Cut deletes the selected area
and places it onto the clipboard. (The affected
area of the image is filled with the current
background color.) When there is no selection
area, both Cut and Copy are applied to the entire
image.

Using the clipboard
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Pasting data into an image

After cutting or copying some image data, you can
paste it from the clipboard into an image by
choosing the As Selection or Into Selection
commands in the Edit: Paste submenu.

The Paste commands are disabled when the
clipboard is empty or the contents of the clipboard
is from another, incompatible program and
cannot be pasted into images. The Paste: Into
selection is disabled when there is no current
selection.

Note: Image Editor allows you to paste image data
into any image, regardless of data type. When pasted
into an image of a different data type, the pasted
data is converted. At times this may cause an extreme
change in color, e.g. if the clipboard data is RGB True
Color and the destination image is Indexed 16-Color.

Pasting as selection

Using the As Selection command places the
clipboard image at the top left corner of the
current view. (You can freely move the image by
dragging on it with one of the selection tools.) If
you want to position the clipboard image at a
specific point in the image prior to pasting, use a
selection tool to draw a selection area starting at
the point you want the data to be pasted. (The size
of this selection area is not important.) This time
when you paste, the top left of the image from the
clipboard is pasted at the top left corner of the
selection area.

Note: When you drag a selection between images, it
is dropped pixel-on-pixel. So, if your source and
target images are at different zoom levels, the
selection may appear to be enlarged or reduced when
it is dropped.
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Pasting into a selection

Use the Into Selection command when you want
to paste the clipboard image inside the selection
area of an image. If the clipboard image is larger
than the selection area, only the portion contained
within the selection area is displayed. After
pasting, a selection marquee appears indicating

the size of the clipboard image. This marquee can
be moved to change the portion of the clipboard
image displayed in the selection area.

Note: If the pasted image is smaller than the selection
area, it is placed at the top left corner of the
selection. The remaining areas of the image are left
unaffected.

Pasting image data As Selection (left) and Into Selection (right)
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The Clipboard submenu

To help you work with the clipboard, Image Editor
provides a Clipboard submenu in the Edit menu.
This submenu contains commands to Load, Save
and Display clipboard images:

Load – brings image files and previously saved
clipboard images onto the clipboard. This
command is similar to the Open command, but
rather than opening a file and placing it in a new
image window, Load places the file onto the
clipboard.

Save – saves an image from the clipboard to disk.
After saving, you can open this image as you do
any other images, or bring it back onto the
clipboard with the Load command.

Display - shows the current clipboard image. The
clipboard window appears containing the image
fitted in a window (if possible). To close the
clipboard window, press a key or click the mouse.

Note: These commands can only be used when
the clipboard contains image data. The Windows
Clipboard Viewer utility, accessed by choosing
the Clipboard Viewer command in the Pals menu,
provides similar functions for other types of clipboard
data.
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An advantage of working in a Windows
environment is that you can use your mouse to
easily move images around the program
workspace as well as place them into other images
or programs. Performing such tasks is referred to
as “drag-and-drop”. Image Editor supports
standard drag-and-drop operations as well as
more advanced drag-and-drop operations such as
moving selection areas to other images, the open
workspace or the object pool. This section
describes some of these more advanced ways of
using drag-and-drop.

Drag-and-drop between image windows

Once you create a selection area, you can move
the selection within the original window, or to any
other image window, by dragging it with one of
the selection tools. If you drag-and-drop between
images of different data types, the dropped
selection is converted to the data type of the
destination image.
When you drag-and-drop a selection into another
image, you have the choice of moving the

selection into the image, filling the image (holding
down the F key as you drop), or moving the
selection marquee alone (holding down the M key
as you drop).

Note: When you drag a selection between images, it
is dropped pixel-on-pixel. So, if your source and
target images are at different zoom levels, the
selection may appear to be enlarged or reduced when
it is dropped.

Drag-and-drop to the workspace

During your imaging work you may want to retain
or duplicate a particular part of an image. Image
Editor makes this easy by allowing you to drag a
selected part of an image into the open
workspace; a new image window is created
containing the image. (The background, where
visible, is filled with the current background
color.) Hold down the M key as you drag-and-drop
to create a Grayscale image containing the
selection mask (for more about masks see p.170).

Using drag-and-drop
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Drag-and-drop to the object pool

Image Editor provides a useful feature that allows
you to instantly save selections and masks while
you work – the object pool (see p.170). To save a
selection area to the object pool, drag-and-drop it
onto the object pool icon at the bottom of the
color palette, or into the object pool window. By
dragging selections from the object pool, you can
place them into image windows or create new
images by dropping them into the workspace.

All the ImagePals programs come equipped with
extensive commands to customize the way each
program operates as well as interacts with
Windows. In Image Editor these commands can
be found in the File: Preferences submenu. The
following section discusses each of these
commands and details how you can use them to
improve the way Image Editor works for you.

Image Editor

Choosing the Image Editor command opens the
Image Editor dialog box. From this dialog box you
can set various features related to working with
images while in the Image Editor workspace:

Customizing the way you work
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The Unit of Measure combo box allows you to
define the measurement system used,
centimeters, inches or pixels. When you are
moving selection areas and wish to leave the
original image unaffected by the move check the
Preserve Image Under Selection option. With this
option unchecked moving selection areas results
in the original image under the selected area
being filled with the background color. (This
option can be conveniently “toggled” while you
work with the F5 key.)

Note: You cannot toggle this option when the
selection is floating.

The Enable Undo option, when checked, causes
Image Editor to retain in memory the status of an
image immediately prior to a change made to it.
After making a change you may recover to the
previous state by choosing the Undo command in
the Edit menu. Undo does, however, occupy
memory, as Image Editor has to “remember” what
the active image was like before the last change
was made. Unchecking Enable Undo frees this
memory allowing you to work with larger images
and to perform some operations more quickly.

The Number of Files Names Kept option allows
you to specify how many files are listed at the
bottom of the File menu. This list contains the
filenames of your most recently saved images,
which can be opened by clicking on them.

The final option, Background Color in
Thumbnail, allows you to change the color used to
fill the background of irregularly shaped selections
appearing in an effect dialog box. Change this
color when you find it hard to distinguish between
the edges of the image and the background color.
(The color selected here is also used to fill the
background of irregularly shaped images stored in
the object pool.)

Note: The Image Editor dialog box can also be opened
by pressing the F6 key or double-clicking on the status
bar.
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OLE & Clipboard

Running under Windows 3.1, Image Editor can
make use of the Windows OLE capabilities and act
as a server program. The OLE & Clipboard dialog
box allows you to choose what is placed on the
clipboard when you use the Copy or Cut
commands. This is important because it puts you
in control of the demand on your system
resources: you only want to copy the minimum
amount to the clipboard to complete your task.

If you want to use Image Editor as an OLE server,
you must check the Include OLE Related Formats
option. If this is unchecked you will find the OLE
paste commands disabled in your client program.

When moving large amounts of image data, check
the Delay Render option. This only places the data
onto the clipboard when you decide to perform a
paste operation. For general purposes leave this
unchecked.

Note: After placing images onto the clipboard, do not
change these options before pasting. Doing so may
produce unexpected results.

Photo CD

The Photo CD dialog box gives you the option of
determining the resolution and data type of any
image files imported from a Kodak Photo CD.

Display

The Display dialog box allows you to adjust the
way images are displayed by Image Editor.

If you are using a HiColor display mode, checking
the HiColor Dithering option improves display of
True Color images. When working in a 256-color
display mode, you can select the View Images
With a Common Palette option to display all
images with the system palette – this provides
reasonable representation of all images and makes
your work quicker because the palette stays the
same: as such there is no need to repaint any of
the images.
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A 256 Color display mode also enables the Don’t
Care About Background Quality option. If you
have selected the common palette option, this
makes no difference, otherwise select this option
to prevent the background images repainting –
giving you the best representation of the active
image and the fastest working environment. (You
cannot, however, compare images with this option
selected.)

The final option present in the Display
Preferences is the Monitor Gamma option. This
tunes your monitor to the current display. It is
very important that you calibrate your display
before you start working with images for the first
time. To learn more about how to calibrate your
display, see p.20

Memory

The Memory command gives you the opportunity
to specify directories which can provide additional
working space when working with images. The
first directory shown is the TEMP directory
defined by the SET TEMP statement in your
AUTOEXEC.BAT file. Image Editor provides a
further three choices that would normally be

different drives. If you are working on a network,
you may have different space allocations on the
same drive; in such cases you can specify more
than one temporary directory from the same
drive.

File Formats

The File Formats command allows you to specify
which file formats you want Image Editor to
support. When you use Image Editor for the first
time all available file formats are placed on the
active list. This allows you to open a wide range of
files but does use up valuable system resources
and extends the List Files of Type combo box (in
certain dialog boxes).

Notes:

• If you have an image currently open in the
workspace, the image’s file format appears with an
asterisk; indicating that the format is in use. If you
want to remove the format from the active list first
close the image.

• The object pool stores images in the TIF file format.
If you want to use the object pool, ensure that the
TIF format is on the active list.
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2·3 Making selections

An essential part of working with images is
being able to manipulate portions of an
image. Image Editor provides a
comprehensive range of selection tools and
commands that allow you to accurately
isolate those areas you want to perform an
operation on and protect areas you want
left alone.

This chapter begins by introducing
selection areas and explains the tools and
commands you use to select and
manipulate areas within an image.
Following this is a section on the object
pool – an indispensable tool that not only
increases your productivity, but adds a
whole new dimension to the way you work
with selections and images.
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After opening an image, you can choose to edit the
entire image or selected parts of it. To edit specific
areas within an image, you must first select them.
Unless a selection area has been created, any
editing you do may affect the entire image. Image
Editor allows you to select a single part of an
image or multiple, unconnected parts.

Note: When you move images an important
consideration is the Preserve Image Under Selection
option in the Image Editor dialog box. If this option is
checked, any selected areas leave the original,
underlying image unaffected. When it is unchecked,
the underlying image of the selection is replaced by
the background color – you can see this when you
move or transform the selection. (This option can be
toggled by pressing the F5 key.)

Moving a selection with Preserve Image Under Selection disabled (left) and enabled (right)

Understanding selection areas
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The selection marquee

When you create a selection, an animated dotted
line appears around the edge of the selected area.
This dotted line is called the selection marquee.
This marquee can be either floating, containing
some image data, or non-floating, selecting part of
the active image. A floating selection is created
when you:

• move a selected area,

• perform a transformation on a selected area,

• paste or drag a selection into an image,

• choose Make Floating from the Edit: Select
submenu.

Deselecting and discarding selections

After editing or moving a floating selection you
can make it part of the underlying image or
remove it. To make it part of the underlying
image, you deselect it by:

• choosing None from the Edit: Select submenu,

• double-clicking on the freehand or move
selection tools in the toolbar.

To remove a floating selection, choose the Discard
Floating command in the Edit: Select submenu. (If
the selection is not floating, this command is
disabled and you cannot “remove” the selection
area as such, but you can Undo your last applied
action or Restore the image see p.145).
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You can create and manipulate selection areas
with the selection tools at the top of the toolbar
and the select commands in the Edit: Select
submenu. This menu can also be accessed by
clicking the right mouse button on an image when
a selection tool is selected. (Choose a command by
dragging down the menu and releasing the mouse
button or by clicking on the appropriate
command with the left mouse button.)

This section describes how to use the selection
tools to select anything from similar colors to
irregular shapes.

Selecting an area of similar colors  

The magic wand tool selects an area in an image
that contains colors or grays falling within a
defined color range. To define this color range
double-click on the magic wand icon in the
toolbar. The Magic Wand dialog box appears. In
the Color Similarity entry box, type in the value
that you feel closest reflects the range of colors you
wish to select.

To select an area of the active image, click in the
center of the area you want to select (the color
value of the pixel under the magic wand is
displayed in the left-hand portion of the status
bar). All the surrounding pixels that fall within the
color range will be selected.

Making and manipulating
selections
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Below is a guideline on what to expect when
choosing particular color values.

• A value of 0 selects neighboring pixels of
exactly the same gray or color.

• A value of 255 selects pixels of all colors and
grays – thereby selecting the entire image.

• A value of 50 selects neighboring pixels that
have values which differ from the pixel you
clicked on by ±50, for example. If you click on
a pixel with values R25, G60, B190,
neighboring pixels with values between R0,
G10, B140, and R75, G110, B240 will be
selected.

 

Using the magic wand tool to select an area of similar colors
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Selecting irregularly shaped areas  

Using the freehand tool you can select an area of
any shape you desire. Do this by dragging the tool
to outline an area or by clicking on selected points
to define the ends of straight line segments. Once
completed, double-click and Image Editor

automatically completes the selection by drawing
a straight line between the last and first point of
the selection.

Note: If you make a mistake while drawing a selection
area with the freehand tool or wish to start again,
press the Esc key.

Using the freehand tool to select an irregularly shaped area
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Square and circular areas
  

Image Editor provides two tools which select areas
of preset shapes, the rectangular and elliptical
selection tools. Both tools operate in a similar
manner and provide two basic methods for
creating selection areas: freehand and fixed size.
To define this mode, double-click on the tool icon
in the toolbar. The appropriate tool dialog box
opens.

In Fixed mode you can define the width and
height (in pixels) of your selection area. When you
click on the image the selection area appears at
this size.

In Freehand mode, you drag the mouse over the
area you want to include in the selection. A further
option, Draw From Center allows you to
determine if the selection area is defined from the
center out or top left corner.

Using the rectangular tool to select a rectangular area
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Moving the selection marquee  

When you click on a selection area with a selection
tool and drag, the selection marquee and the
image data it contains both move. If you wish to
move the selection marquee alone without its
contents use the move tool. If the selection area
was floating, the contents of the area becomes
part of the underlying image.

Note: To drag a selection area from one image to
another you should use one of the selection tools and
hold down the M key as you drag. After you drop the
image the move tool becomes the current tool.

Inverting a selection

When you wish to protect a particular area while
working on the rest of an image, select it and then
choose the Invert command from the Edit: Select
submenu. This “flips” the selection area so that
those areas originally selected are now deselected
and the unselected area is selected. This allows
you to work on the rest of the image with no
danger of damaging the area you want to protect.
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Selecting the woman (image on the left) and then inverting the selection to
select the background
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Image Editor allows you to use any combination of
its selection tools to add to or subtract from
existing selection areas. To select additional areas
of an image, or to extend an existing area, make
your initial selection and then, with the “Shift” key
held down (the pointer changes to display an
addition sign) use a selection tool to select more of
the image. If you wish to exclude an area from an
already selected area, hold the Ctrl key down (the
pointer changes to display a subtraction sign) and
select the unwanted area – the marquee redraws
itself so that it no longer contains that area.

1. Create a selection area

Selecting more of an image
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2. Add to the selection 3. Subtract from the selection
(hold down the Shift key) (hold down the Ctrl key)
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As well as using the Shift key in conjunction with
the selection tools to select more of an image, you
can expand selection areas with the Similar
command in the Edit: Select submenu. When you
select this command the Similar dialog box opens.
This dialog box allows you to define a color range
and whether to expand the selection to include

neighboring areas of similar pixels or similar pixels
from the entire image. This is most useful when
you have a complex image on a simple
background and, after selecting part of the
background, you wish to expand it to include the
whole.

Expanding the selection on the left with the Expand From Current Selection
option enabled

Expanding a selection



MAKING SELECTIONS 167

06/13/95 TaurusCONFIDENTIAL

When you want to add a keyline to part of an
image or draw a box or circle use the Border
command in the Edit: Select submenu. This allows
you to select a line of pixels around the edge of the
current selection marquee – the width of the line
is determined by the width specified in the Border
dialog box that appears when you choose this
command. (You can define the border width from

1 to 64 pixels.) The border is created centered on
the selection marquee, i.e. half the specified width
is placed on the inside of the marquee and half on
the outside. After defining a border you can then
“fill” it with a color to create a keyline, box or
circle, or use a blurring or averaging effect to
“blend” the edges of the selection area into the
surrounding image.

1. Create a selection area  2. Apply the Border command

Selecting the border of an area
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When you deselect a floating selection, the
contents of the selection completely replace the
portion of the underlying image below it. In many
cases this may be desirable, but you will often
require greater control over the process.

The Merge Control dialog box gives you that
control. Specifically, it provides options to set the
transparency of the floating area, how colors
combine and the degree to which the edges of the
floating selection are blended with the underlying
image. Use these options as follows:

• HSB merges the floating selection as you see it.
• Hue and Saturation merges the colors in the

floating selection with the underlying image. If
your underlying image is a Grayscale image
that has been converted to RGB True Color
and your floating selection is a colored

square, this option will combine the color of
the floating selection with the underlying gray
image: thereby colorizing the gray image.

• Hue only merges only the hues from the
floating selection with the underlying image.
Use this option to change the color of areas in
a colored image.

Transparency defines the transparency of the
floating selection. Choosing 0% and the floating
selection completely replaces the underlying
image; the closer the value is to 100%, the greater
the transparency. At 50% the floating selection
and underlying image are merged equally.

Merging a selected area



MAKING SELECTIONS 169

06/13/95 TaurusCONFIDENTIAL

Edge Blending determines the number of pixels
(depth) at the edge of the floating selection that
are blended with the underlying image. This
function is centered around one pixel, hence the
available options are odd numbers (3, 5, 7, 9 and
11).

Notes:

• The merge control is a “modal” command, that is,
its effect is only permanent when the floating
selection is deselected. Before that time you can
reapply the merge settings and even move the
selection area.

• The Merge Control is only available when there is a
floating selection and you are working on a
Grayscale or RGB True Color image.

Merging a floating selection (25% transparency) with the underlying image
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When you create a selection area you may want to
save it and its contents for later use. Doing this
allows you to use the same selection for multiple
images or use it repeatedly with the
same image. To do this Image Editor provides a
unique and easy-to-use feature: the object pool.

To access the object pool, double-click on the
object pool icon at the bottom of the color palette.
The object pool window opens. In this window,
stored selections are displayed as thumbnails and
a ribbon, at the top of the window, displays the
name of the current group and various function
and selection buttons.

Note: The object pool is always on top of the Image
Editor program window and any image windows. To
close the object pool double-click on its title bar or
choose the Hide Object Pool command in the View:
Options submenu.

The Object Pool

Saving selections to the object pool

You save a selection in the object pool by dragging
it from an image to the object pool or its icon. The
selection is then automatically saved and a
thumbnail of the selection appears in the object
pool window. When you save a selection area, you
have the option of saving it as a mask or image
“object”. (You choose which in the Object menu,
accessed by clicking on the blue menu button). A
mask object is a selection marquee, while an
image object is a selection marquee and the image
data it contains.

The object pool
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For Grayscale images there is an additional option
to save a selection area as an “image as mask”.
This converts the image into a selection marquee
and saves the marquee.

Notes:

• Holding down the M key as you drag a selection
area into the object pool automatically saves the
selection as a mask object.

• Selections are saved in the TIF file format in the
directory specified at the time the group was
created. (The files are identified with an O prefix
followed by the letter I [image],
K [image as mask], or M[mask], with a creation
number at the end.) You can choose to compress
these files when they are created by checking the
Compress Objects option in the Information dialog
box, accessed by choosing the Information
command in the Disk menu.

• When saving a selection as an image or image as
mask object, Image Editor creates two files. One is
the image portion of the file, the other is the mask
portion which used to define the shape of the
image.

• As the object pool uses the TIF file format, the TIF
format must be one of the available file formats
(see p.154).

Saving selections to file

Although the object pool allows you to easily
export masks as Grayscale images, reimport
images as masks, and place masks into images,
you may want to export a mask to another
machine, or save it to a secondary storage device.
Image Editor provides a direct method of doing
this: the Save Mask command in the Edit: Select
submenu. This opens the Save Mask dialog box
and allows you to save the current selection
marquee as a Grayscale image in a file format of
your choice (the options in this dialog box are the
same as the Save As dialog box, see p.129).

Note: In general, do not save masks in a format that
involves “lossey” compression (like JPEG), these
formats will change the mask. For general purposes,
use the TIF file format (with or without compression).
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In the object pool

The object pool is a very handy and useful place to
store your work. It can however, become quickly
cluttered with large numbers of masks and
images. To better organize these masks and
images you can place them into user-defined
groups. Once created, a group can be selected by
choosing its name from the group combo box in
the object pool ribbon. To view the objects of a
group, click on the mask and image buttons in the
object pool ribbon. If neither button is pressed the
window will be empty. (These buttons are
disabled in the group does not contain their
respective objects.)

To create a group:

1. Double-click on the object pool icon. The
object pool window opens.

2. Click on the disk button in the ribbon and
choose “Create Group”. The Create Group
dialog box appears.

3. Type in a name for your group in the New
Group Name entry box. The name can be up
to 10 characters long (do not type in an
extension). If you want to change the path and
directory where the group is saved, type in a
new destination in the New Group Directory.
(Group files are saved with the OPG file
extension.)

4. Click OK. The dialog box closes and the newly
created group appears as the active group in
the group combo box.

You can import object groups from a network by
choosing the Import Group command from the
disk menu. (When you import a group, the group
file and objects remain in their original
directories.) If you wish to share your own object
groups but want to make them read only, click the
lock button. Other users can still access your
object groups but cannot make any changes to
your objects or groups. If a group from another
user is locked, the lock button in your object pool
will be depressed (you will not be able to unlock
it).
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Deleting groups and objects

Having created a group, you can easily delete it
and its associated files from disk by choosing the
Delete Group command in the Disk menu. To
delete an object from a group, click on the object
to select it and choose the Delete Object
command in the Disk menu.

Retrieving an object

Just as you create objects by dragging them into
the object pool, you can retrieve them by dragging
them from the object pool into an image window
or the workspace. Dragging an object to the
workspace creates a new image window
containing the object as a floating selection. You
can then edit the object just as you would any
other image.

If you drag an object back to the image it originally
came from, or another of equal size, the object is
placed as a floating selection in the same position
it was originally taken from. If the destination
image is a different size, the selection is placed at
the position of your mouse.

When dragging mask objects into an image, the
selection tool automatically changes to the move
tool. This enables you to accurately identify the
areas selected by the mask and to move it freely
without fear of affecting the underlying image.

Notes:

• When placing a mask object that has been created
from a Grayscale image into an Indexed-Color or
Black & White image the gray areas of the mask are
converted to pure black or white.

• To load a previously saved mask (or any Grayscale
image) into the active image as a selection
marquee, use the Load command from the Edit:
Select submenu.

Editing masks

When you create a selection area, areas are either
selected or not. This means that when you apply
commands to the selected area you will often get a
hard edge or too strong an effect. To avoid this you
can export the selection area as a mask and edit
the mask so that some areas are partially selected,
i.e. commands will only have a partial effect on
these areas.
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When you export a mask, by dragging a selection
area from an image into the workspace (with the
M key held down) or by dragging a mask from the
object pool into the workspace, a Grayscale image
is created. You can edit this Grayscale image as
you would any normal image, but always
remember:

• black areas are not selected,

• white areas are selected,

• gray areas are partially selected. When the
mask is placed into an image and editing
functions are applied to the image, the degree
of effect is determined by the gray shade – the
closer to white the greater the effect; the closer
to black the less the effect.

When you finish editing and wish to place the
mask back into an image as a selection marquee,
you do so via the object pool:

1. Select the whole image with “All” from the
Edit: Select menu.

2. With the “image as mask” option checked in
the object pool menu, drag the image back
into the object pool. The image is saved as a
mask.

3. Drag the newly created mask object into an
image.

Note: When a mask containing gray shades is dragged
into an image, the selection marquee may not appear
to accurately represent the mask. This is because the
selection marquee only shows the border of areas in
the mask that go from a value less than 128 to a value
greater than 128. If your mask is very dark, containing
only gray values below 128, no marquee will be
shown: if it is very light, containing only gray values
greater than 128, the whole image will appear to be
selected.
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2·4 Manipulating images

Editing images involves many different
stages and operations. Rather than
presenting all the facilities provided by
Image Editor in one place, we have
separated them out into three chapters:
Manipulating images, Painting and
Enhancing images.

This chapter deals with manipulating
images, and explains how you can change
images by converting their data type,
changing their resolution or size, or
applying transformations to them such as
crop, flip, distort and rotate.
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Whatever your reasons for editing images, it is
essential to be able to manipulate them to suit
your intended purpose. Whether you are
preparing images for a publication and need to
resize and crop them or preparing images for
display and need to convert them – Image Editor’s
manipulation commands will more than satisfy
your needs.

This section deals with the commands that you
use to crop, resize, rotate and distort images.

Notes:

• If the Preserve Image Under Selection option is
unchecked (in the Image Editor dialog box) sections
of an image may be filled with the background
color after applying transformation commands.
(You can toggle this option by pressing the F5 key).

• If, in transforming a selection, you click on or drag
anything other than a handle, the handles will
disappear. By choosing “Undo” you can undo your
last action, but this does not make the handles
reappear.

Cropping an image

Cropping is a way to trim the edges of an image
and control the position and size of the subject in
an image. This is particularly useful when you
have images that are too large to be displayed and
contain information around the edges that you
wish to discard. It is important to remember that
when you crop an image the cropped portions
cannot be retrieved again, unless you immediately
undo the Crop command or restore the image.

To crop an image:

1. Select the area of the image you wish to retain.

2. Choose “Crop” from the Edit menu. The areas
outside the selection marquee are discarded.
Only the area you selected is retained.

Note: If you select a non-rectangular area, the image
is cropped to the smallest rectangle that can contain
the selected area. Areas outside the selected area are
filled with the current background color.

Transforming Images
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Image with area selected before cropping and, on the right, after cropping

You can resize images in three ways: by changing
their resolution, resampling them or resizing a
selected portion of them. Changing the resolution
of images adjusts their size without changing the
actual image data and thereby retains original

 quality. Resampling an image discards data when
you reduce an image and creates new data when
you enlarge one. Resizing a selection area,
stretches or shrinks the selection within the
image.

Resizing images
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Changing an image’s resolution

Resolution determines the physical size of an
image by defining the size of its constituent pixels.
As you change the resolution, you change the
number of pixels that can be placed in a given
measure making the image bigger or smaller:
increasing the resolution reduces the size of the
image while decreasing it makes the image larger.

In this way you resize an image without actually
changing the number of pixels the image contains,
thus retaining the original quality of the image.
(The images in this guide have all been resized by
changing their resolution.)

To change the resolution of an image:

1. Select the image whose resolution you want to
change.

2. Choose “Resolution” from the Image menu.
The Resolution dialog box appears.

3. Decide on the resolution to use: Display,
Printer, or User Defined. If you select User
Defined, enter a new resolution in the entry
box.

4. Click OK. The dialog box closes and the
resolution of the active image is changed.
There is no change to the appearance of the
image. Changes are only apparent when you
print the image or place it into another
program that reads the resolution.
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Resampling an image

When you open images, their size on screen is
determined by your screen resolution and the
number of pixels they contain. The Resample
command allows you to adjust the number of
these pixels in an image. You will want to do this
when:

• you are preparing images for display on your
computer, e.g. in a slide show, and wish to
make them all display at the same size.

• you are preparing images for a publication
and you wish to make their file size smaller so
that they take less time to import into, and
print from, your DTP or word processing
program.

• you wish to stretch or squash an image.

To resample an image:

1. Select the image you want to resample.

2. Choose “Resample” from the Image menu.
The Resample dialog box appears containing
information about the current width and
height of the image.

3. Check the Keep Aspect Ratio option to retain
the proportions of the image. Uncheck this
option to independently change the width and
height of the image.

4. Enter the new width and height for the image.
(If Keep Aspect Ratio is checked, entering one
value automatically adjusts the other value.)

5. Click OK. A new image window is created with
the new width and height specified.

Notes:

• Resampling up generates new data, thereby
increasing the size of the image file. Conversely,
resampling down discards data and results in a
smaller file, but may reduce image quality.

• If you enter a new width and height of 100%, the
image is duplicated. Entering 200% doubles the size
of the image and 50% halves the size. This affects
the output (physical) size of the image as well
because the resolution remains unchanged.
Therefore, if you wish to reduce the size of an
image file and retain its physical size you must
reduce its resolution by a corresponding amount
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Resizing selected areas of an image

With the Free Resize command, in the Effect
menu, you can make the contents of a selection
area bigger or smaller. When you choose this
command, handles appear at each corner and side
of the selection marquee. Dragging a handle
resizes the selection area. Holding down the Shift
key as you drag maintains the original proportions
of the selection.

Flipping an image

The crop, resolution and resample commands all
relate to the manipulation of entire images. The
Flip command is an example of a command which
can be applied to either an entire image or to a
selected part of an image. After “flipping” the
image or selected area is horizontally or vertically
mirrored.

To flip an image or selection area:

1. Select the part of the image to flip. (To flip the
entire image,
do not make a selection.)

2. Choose “Horizontal” or “Vertical” from the
Effect: Flip submenu. The image or selected
area is then flipped in its position.
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Image before and after flipping

The Rotate command allows you to rotate an
entire image or selected area in any direction and
to any degree. Choosing the Rotate command in
the Effect menu displays a submenu of
commands, that when chosen, apply an
immediate effect, open a dialog box or place a line
on the image:

• Left 90° (counter-clockwise) – immediate
effect.

• Right 90° (clockwise) – immediate effect.

• 180° – immediate effect.

Rotating an image
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• Freely allows you to define the rotation of a
selected area by dragging the corners of the
area. (If there is no selection area this
command is disabled) – immediate effect

• Degree allows you to specify the angle and
direction of the rotation – opens a dialog box.

• by Horizontal line allows you to horizontally
rotate an image to a defined line. Use this if
the image has a strong horizontal feature –
places a horizontal line with handles on the
image.

• by Vertical line allows you to vertically rotate
an image to
a defined line. Use this if the image has a
strong vertical
feature – places a vertical line with handles on
the image.

Note: If you rotate an image by anything other than
90°, 180° or 270°, extra space is introduced around the
image. This space is filled with the background color.

To freely rotate a selection area:

1. Select the portion of the image to rotate.

2. Choose “Freely” from the Effect: Rotate
submenu.
Handles appear at each corner of the selection
marquee.

3. Place your mouse pointer over a handle and
drag it clockwise or counterclockwise. The
selection is rotated around its center.

4. When you are satisfied with the rotation,
choose “None” from the Edit: Select submenu
to merge the area with the image.
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1. Select area within image 2. Choose “Rotate: Freely” 3. Drag handle to rotate
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Rotating by horizontal/vertical line

The rotate by Horizontal and Vertical Line
commands are useful when you have an image
which is not quite straight. This is often the case
when you input an image with a hand-held
scanner.

To vertically align an image:

1. Select the image you want to straighten.
2. Choose “by Vertical Line” from the Effect:

Rotate submenu.
A line, with a handle at each end, appears on
the image.

3. Identify a strong vertical feature in the image
and drag the closest handle to one end of this
feature.

4. Drag the other handle to the other end of the
feature so that the joining line now aligns
along the feature.

5. Double-click on one of the handles. The image
is rotated until the joining line becomes
vertical.

Slanting a selection area

Apart from being able to rotate and flip images or
parts of images, Image Editor allows you to skew
or slant selected areas of an image using the Slant
command. When you perform a slant operation
you can choose to slant the selected area along the
horizontal or vertical plane.

To slant a selected area:

1. Select the portion of the image to slant.

2. Choose “Slant” from the Effect menu. Handles
appear at each corner of the selection
marquee.

3. Drag one of the handles in the direction you
want to slant. (Clicking outside a handle
removes the selection marquee. You can undo
the action but need to reapply the Slant
command.)

4. When the selection is at the desired slant,
choose “None” from the Edit: Select submenu
to merge the selection with the image.

Note: If you slant a selected area with the Shift key
held down, you can move a single handle of the area.
To create a perspective effect, slant two adjacent
corners of an area in opposite directions.
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1. Select area within image 2. Choose “Slant” 3. Drag handle to slant   

Distorting a selection area

Distort produces a similar effect to Slant except
that it allows you to move each marquee handle
independently and in any direction. Once you
drag and release the mouse, the contents of the
selected area are resized to fit the new shape.
Although Distort uses a rectangular selection area,
you can curve the selection area and create 3-D
effects by repeatedly applying the Distort
command to the same selection area.

To distort a selected area:

1. Select the portion of the image to distort.

2. Choose “Distort” from the Effect menu.
Handles appear at each corner of the selection
marquee.

3. Drag one of the handles in the direction you
want to distort. (Clicking outside a handle
removes the selection marquee. You can undo
the action but need to reapply the Distort
command.)
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4. When you are happy with the distortion,
choose “None” from the Edit: Select submenu
to merge the selection with the image.

Note: Holding down the Shift key as you drag each
handle prevents the selection area from resizing. When
the handles are in the correct position, release the
Shift key and click on any handle to resize the
contents.

1. Select area within image 2. Choose “Distort” 3. Drag handles to distort   
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When working with images, it is often necessary or
useful to change the data type of an image, for
example, from Grayscale to RGB True Color. Your
choice of data type directly relates to the image’s
file size and quality.

By converting to a data type that supports more
colors, you can take advantage of the extra colors,
but the image’s file size will increase. Conversely,
if you don’t require the number of colors
supported by the current data type, convert to one
that makes your image file smaller. For example,
for black-and-white publications use Grayscale
images, not RGB True Color.
You convert an image by choosing a target data
type from the Image: Convert menu. (Some data
types may not be available: these require an
intermediate conversion to Grayscale or RGB True
Color). After choosing the target data type,

 the conversion is immediate or an options dialog
box appears (see table below).

Note: Conversions do not change the original image
but open a new, untitled image window containing a
copy of the image in the new data type.

Source format Can convert to: Opt.

Black & White Grayscale

Grayscale Black & White
Indexed 16-Color
Indexed 256-Color
RGB True Color

Indexed 16-Color Grayscale
RGB True Color

Indexed 256-
Color

Grayscale
RGB True Color

RGB True Color Grayscale
Indexed 16-Color
Indexed 256-Color

Conversion paths between data types

Converting images
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Converting from Black & White to
Grayscale

You can only directly convert a Black & White
image to Grayscale. This conversion involves
options that enable you to choose if, and how, the
black and white pixels are converted to gray
shades. If you wish to convert a Black & White
image to other color data types, first convert to
Grayscale, and then to the target data type.

When you choose the Convert to Grayscale
command in the Image: Convert submenu, the
Convert to Grayscale dialog box opens containing
the following options:
Cell size defines the size of the cells used to
convert the black and white pixels of a Black &
White image to shades of gray. The higher the

number, the greater the number of gray shades
introduced. For line-art images that you wish to
keep as black and white, use a cell size of one. For
a photo scanned with a black-and-white hand-
held scanner choose a cell size from three to eight
(depending on the settings of the scanner). If the
resulting image shows visible grids, the cell size is
incorrect.

Scale down defines how much the image is scaled
down during conversion. A scale-down of one
results in no scaling. A scale-down of two reduces
the width and height (in pixels) and resolution of
the image by half. Scaling down prevents the new
gray image from displaying a mosaic like effect
that may be caused when you define a large cell
size.
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Converting from Grayscale to Black &
White

When you convert Grayscale images to Black &
White, the original gray shades cannot be
retained. To simulate them, Image Editor groups
black and white pixels using a “dithering” option.
Image Editor’s dithering options are adequate for
most situations but are particularly suited for
preparing images for display on monochrome
monitors.

Note: You can only convert Grayscale images directly
to Black & White. To convert images of other data
types to Black & White, first convert them to
Grayscale.

When you choose the Black & White command in
the Image: Convert submenu, the Convert to Black
& White dialog box opens. This dialog box
provides the following options:

Resolution allows you to choose the resolution of
the new image. You can choose the resolution to
match that of your Printer, Display or Active
Image or define your own. (If you select a high
resolution, a very large file will be produced and
the conversion may take a long time.)

Dither allows you to choose a dither method. None
simply maps lighter grays to white and darker
grays to black. Pattern arranges pixels in square
patterns to simulate gray shades. Diffusion uses a
more random method to dither gray shades. The
Diffusion option generally results in the best
conversion.
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Grayscale to Indexed 16-Color

Converting from Grayscale to Indexed 16-Color
involves the same dither options as those used to
convert Grayscale to Black & White. But these
options control how a possible 256 gray shades are
dithered with the 16 colors available in an Indexed
16-Color image. Whichever option you choose,
Image Editor selects a range of 16 grays that match
the grays in the original. These sixteen grays are
then used to dither the original shades in the same
way as when Grayscale is converted to Black &
White.

RGB True Color to Indexed 16-Color

When you convert from RGB True Color to
Indexed 16-Color, you are converting a possible
16.7 million colors to only 16. To get the most
effective result you need to decide how the 16
colors are chosen and how they are arranged
(dithered) to simulate the millions of colors in the
original. Image editor provides the following
options to control this choice:

Palette allows you to select the colors to be
included in the new image’s color table. Standard
uses the system’s default 16-color table,
containing the 16 colors available on a standard
VGA display. This option is most useful when you
transfer images to other Windows programs or
prepare them for use in a help file.

Choosing the Optimized option creates a color
table that is the closest adaptation of the colors
used in the image. In most cases this option gives
the best conversion.
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Reserve Entries allows you to reserve some entries
in an optimized palette. For example, if your
image is largely green and blue, you may not have
any black in the image, but you may need black to
add text at a later time. Select the Reserve Entries
Black & White option and the color table will
contain greens, blues, black and white. Checking
the 8 Prime Colors option retains red, green, blue,
cyan, magenta, yellow, black and white.

RGB True Color to Indexed 256-Color

Converting True Color to Indexed 256-Color,
Image Editor is faced with the same problem as
converting to Indexed 16-Color. That is, how to
represent several million colors with only a few.
The options dialog box for this conversion
contains the following palette and dithering
options:

Palette controls the selection of colors for the
palette.
3-3-2 (bits) uses the system’s default 256-color (8-
bit) table, based on a combination of eight (3-bit)
reds, eight (3-bit) greens, and four (2-bit) blues. 6-
7-6 (levels) uses a palette that offers six levels
(shades) of red, seven levels of green, and six levels
of blue. This is the standard palette used by ZSoft
Paintbrush IV Plus. 6-6-6 (levels) gives the most
balanced use of palette color. This palette offers
six levels (shades) of red, six levels of green, and six
levels of blue. This is the standard palette used by
the Apple Macintosh computer. Optimized creates
a palette that matches the range of colors used in
the image as closely as possible and as such
normally produces the best results.
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Dither provides you with the choice to either not
dither or dither by Pattern or Diffusion. If you
choose not to dither, Image Editor uses the color
in the table that is closest to the color in question.
(The other Dither options, Pattern and Diffusion,
work in a similar manner to those described
earlier for converting Grayscale images to Black &
White)

Notes:

• To preview an RGB True Color image on a 256-color
display, select the Optimized Palette and Diffusion
Dither options. This provides the best possible
results. (Make sure the View Images With a
Common Palette option in the Display dialog box is
not checked.)

• To transfer an Indexed 256-Color image to another
program, you should use the palette option
supported by that program.



193

06/13/95 TaurusCONFIDENTIAL

2·5 Painting

Image Editor’s painting tools enable you to
easily “touch-up” and enhance any kind of
image. The painting tools themselves
present a variety of functions from the
advanced magic lamp and clone tool to
more common tools like the paintbrush,
eraser and text tool. This chapter
introduces these painting tools, and begins
by describing how to select and work with
colors in Image Editor.
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The most important part of painting is choosing
the right color. Image Editor provides a number of
ways to help you get this right and gives you
maximum freedom in your choice of how to
display and select colors. The most obvious means
of doing this is with the color palette.

The color palette

The color palette contains colors you can apply to
any given image. The way colors are displayed
varies according to the type of image you are
working on. For Grayscale images, the color
palette displays shades of gray. Changing to an
Indexed-Color image switches the color palette to
display the 16 or 256 colors from the image’s color
table. For RGB True Color images, a complete
range of colors is displayed in discrete cells or as a
continuous spectrum.

Of the available colors in an image, two are active
at any given time. These two colors, referred to as
the foreground and background color, are
displayed in the color squares just below the color
area in the color palette. The foreground color is
in the front, slightly lower and to the right of the
background color.

Choosing colors
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Using the eyedropper tool  

The eyedropper tool is used to select foreground
or background colors. This can be done by clicking
on a color in an image or in the color palette.
(Whenever you move the mouse pointer over the
color palette, it changes to the eyedropper tool,
irrespective of your current tool selection.)

Clicking the left mouse button selects the color
under the pointer as foreground while clicking the
right mouse button selects the color as the
background color. When passing the eyedropper
tool over an image, or the color palette, the color
values of the pixel the tool is on are displayed in
the left corner of the status line.

Selecting colors with the color dialog
box

Another method of selecting color is to use the
Foreground or Background Color dialog boxes.
These can be accessed by:

• double-clicking on the eyedropper tool icon
(accesses the dialog box for the highlighted
color square).

• double-clicking on the foreground or
background color squares; the appropriate
Color dialog box opens.

When the dialog box appears, the current color is
displayed on the right side. To change it, first
specify the color model to use: RGB or HSB. Your
choice determines the function of the three slider
bars in the center of the dialog box. Drag the slider
bars to change the value of each individual color
component. Adjustments you make are reflected
in the new color area.



196 IMAGEPALS GO!

06/13/95 TaurusCONFIDENTIAL

Selecting colors with the color sliders

Below the color squares in the color palette are the
color sliders. These display the color values of the
highlighted square. Moving the slider arrows
changes these values, and thus the color, of the
color square currently highlighted. (You can
change which color square is highlighted by
clicking on the non-highlighted one.) The values
are RGB or HSB depending on the model you have
chosen in the Select Color dialog box (see p.195).

The colors in an Indexed-Color image are
recorded in a color table. To view the color table,
choose the Color table command in the View
menu (this command is disabled when the active
image is not Indexed-Color). From this dialog box
you can change the colors in the table, thereby
changing the color composition of the image.

To change the color contained in a cell, click on
the cell. The Select Color dialog box appears. Once
you have chosen the new color, click OK. The new
color is inserted into the color table. To return
back to the image, click OK in the Select Color
dialog box, the new color table is stored and the
image now reflects any changes made.

Note: Use this command to globally change a single
color in an image, e.g. from white to black.

Editing an image’s color
table
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Loading and saving color tables

Image Editor allows you to load and save color
tables, enabling you to optimize a color table for
one type of image, and then apply the same color
table to other images. When you load a new color
table, the old table is discarded and the pixels in
the image assume the values of the new table.

During the installation you had the opportunity to
install some pre-defined color tables. (Color tables
appear with a PAL extension.) These color tables
are intended to be loaded into Grayscale images
that you have converted to Indexed 256-Color.
Experiment with them or create your own to
achieve the best possible results.

Note: You can only load color tables containing 16
colors into Indexed 16-Color images. Likewise, color
tables containing 256 colors can only be loaded into
Indexed 256-Color images.

One of the ways to alter the contents of an image
or selected area is to “fill” it with a color or other
image data. When you fill an image you can
control exactly how the fill takes place and what is
used to fill the area. To perform a fill, choose the
Fill command in the Edit menu. The Fill dialog box
opens providing the following options:

Clipboard Data fills the area with image data from
the clipboard. If the area is larger than the
contents of the clipboard, the data is tiled to fill
the area. If the area is smaller, the clipboard image
is cropped. Checking the Start From Selection
option places the clipboard image’s top left corner
at the top left corner of the selected area. When
unchecked, or when there is no selection, the first
copy of the clipboard image is pasted in the top
left corner of the active image; subsequent copies
are tiled to the right and below it, until the image
or selected area is filled. (If you are filling several
areas in an image and you want the clipboard
images to align, do not check this option.)

Filling an area with color
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Selecting the Foreground to Background or
Background to Foreground options enables the
Gradient Fill Style options at the bottom of the
dialog box. The three options, Linear, Rectangular
and Elliptical, set the basic gradient pattern that
will be used in the operation. How this pattern is
created depends on how you define the area to fill.

To use a gradient fill:

1. Select the image, or area, you wish to fill.
(Gradient fills can only be used in Grayscale or
RGB True Color images.)

2. Choose “Fill” from the Edit menu.

3. Select the Foreground to Background Color
option. The Gradient Fill Style box is enabled.

4. Click on the Linear option.

5. Click OK. The dialog box closes and the mouse
pointer changes to the fill pointer.

6. Click on the point at which you want the fill to
start changing from the foreground color and
drag your mouse to the point where you want
it to reach the background color. Release the
mouse button to fill the selected area. Any area
before the start point and after the end point is
filled with the foreground and background
colors respectively.(If you have created a
selection area, only the area within the
selection is filled.)

Notes:

• The gradient fill option is modal, that is, you can
repeat the fill until you deselect the fill tool. This
allows you to experiment with different effects as
well as being able to change the foreground or
background colors. (If you are filling a selection
area the selection area is not floating.) To end the
fill, press the Esc key, change tools or choose a new
menu command.

• When using the rectangular or elliptical option,
holding down the Shift key as you draw produces a
square or circle fill.
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Sample gradient fills, from left: Linear, Rectangular, Elliptical

The quickest way to fill an image is to choose your
fill color as the background color and then use the
Clear command in the Edit menu or press the
Delete key. This fills the image, or selected area,
without the need to access the Fill dialog box.

If you wish to use an existing image as the fill, you
can copy it to the clipboard and then paste it into
another image. Alternatively, simply drag an
image selection from one image (with the F key
held down) and drop it onto another.

Using Clear and drag-and-drop to fill
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Image Editor comes equipped with a number of
tools that allow you to accurately paint and touch-
up areas of an image. How you use these tools
depends on the tool selected and the operation
you wish to perform.

Select a tool by clicking on the appropriate icon in
the tool bar. (When you place your mouse on an
image the mouse pointer changes to reflect the
tool you are currently using.) To apply the tool,
move the tool to the point on the image where you
want to start and press the left mouse button. The
effect of the tool continues for as long as you hold
the mouse button down.

Most of the tools provide options that you can
check or change by double-clicking on their icons
in the tool bar. Of the seven painting tools three,
the paintbrush, airbrush, and line tool, provide the
same options, while the magic lamp, clone, eraser
and text tool provide their own unique options.
This section describes the characteristics of each.

Note: If you have created a selection area, the tools
are only applied to the area within the selection. Use
selection areas in this way to restrict the parts of the
image to which enhancements are applied, protecting
the rest of the image from inadvertent changes.

Using the painting tools
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Selecting brush type and size

Irrespective of which painting tool you wish to
use, you should first decide on the type and size of
brush to use. Do this by double-clicking on the
brush button at the top of the color palette. This
opens the Select Shape dialog box in which you
can choose from six different brush shapes and
twenty-four sizes. Experiment with the various
options to find the one most suited to your
particular painting operation.

Note: You can also increase or decrease the brush size
by moving the slider (next to the brush button) up or
down.

Using the magic lamp  

The magic lamp is not strictly a painting tool in
the sense that it does not “paint” over the existing
image with a selected color. It is used to enhance
areas of an image by adjusting the existing pixel
values in the area. It provides five

functions: blur, sharpen, darken, lighten and
smudge. You choose the function and the strength
of its effect in the Magic Lamp dialog box that
appears when you double-click on the magic lamp
icon in the tool bar.

Notes:

• The magic lamp can only be applied to Grayscale
and RGB True Color images

• Depending on the function selected, you can
strengthen or weaken the effect by dragging the
Level slider to the left or right. A higher value
applies a stronger effect than a lower value.

• When you apply a selected function to an area, the
tool uses the shape and size of the current brush
each time you press the left mouse button. Drag
your mouse to perform the effect over a larger
area. Click repeatedly to reapply and increase the
effect on a specific area. (Smudging requires you to
drag the tool, as it smudges color from one area
into another.)
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Examples of magic lamp effects

Original image Blurring Sharpening

Darkening Lightening Smudging
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Applying color with the paintbrush  

The paintbrush applies color to parts of an image.
Click the left mouse button to apply the
foreground color or the right mouse button to
apply the background color. (The size and shape of
the applied color are determined by the current
brush settings.) If you drag the paintbrush around,
you draw a freehand line.

Double-clicking on the paintbrush icon in the tool
bar opens the Paintbrush dialog box containing
the following options:

The Factor combo box allows you to choose the
color components that are applied to the active
image.

• HSB replaces any parts of an image, to which
you apply the painting tool, with the applied
color.

• Hue and Saturation replaces the hue and
saturation of pixels with those of the applied
color but retains their brightness. For
example, if you convert a Grayscale image to
RGB True Color, you can use this option to
colorize areas of the image.

• Hue only changes the hue of pixels to the hue
of the foreground color. Use this to change the
color of areas in color images.

The Soft edge option blends the edges of painted
areas with the original image by feathering them.

Note: This dialog box can only be accessed if the
active image is Grayscale or RGB True Color.
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Painting with all a color’s components (left) and painting with just the
Hue and Saturation of a color (right)

Cloning allows you to copy part of an image to
another area in the same image or to another
image of the same data type.

To clone part of an image:

1. Click on the clone tool icon.

2. Hold down the Shift key and click with the left
mouse button over the area you wish to clone.
(This area is then marked with a cross-hair
and the mouse pointer changes to the clone
pointer.)

3. Drag your mouse across another part of the
image to begin painting. The cross-hair
changes to a square indicating the area you
are cloning and as you paint you replace the
area with whatever the clone square passes
over. (The size and shape of the area painted
are determined by the current brush settings.)

Cloning parts of an image  
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After painting, the cross-hair’s position is
determined by the Continue Drawing option
in the Clone dialog box (accessed by double-
clicking on the tool icon). With this option
unchecked, the cross-hair returns to its
original point; with it checked, the cross-hair
remains where you left it, allowing you to take
a rest while cloning a large area. The Clone
dialog box also allows you to control
transparency and select a soft edge to blend
the edges of your cloned areas with the image.

Note: Indexed-Color and Black & White images cannot
be cloned.

Cloning an image

Using the airbrush  

The airbrush tool produces a sprayed area over the
image. Clicking the left mouse button on the
image applies the foreground color while clicking
the right mouse button applies the background
color. (The size and shape of the airbrush are
determined by the current brush settings.) When
you use the airbrush, the color gradually builds up
as you drag back and forth over an area. Staying
on one point and keeping the mouse button
depressed increases the density of the color on
that point.

Double-clicking on the airbrush icon opens the
Airbrush dialog box. This dialog box provides the
same options as the Paintbrush dialog box. If you
use the Soft Edge option, color is sprayed like a
fine mist. If this option is not selected, color
appears more like grains of sand.

Note: This dialog box can only be accessed if the
active image is Grayscale or RGB True Color.
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Painting without a soft edge (image on the left) and with a soft edge
(image on the right)

Use the line tool to paint straight lines in an
image. Dragging with the left mouse button
applies the foreground color while dragging with
the right mouse button applies the background
color. (The width and ends of the line are
determined by the current brush settings.)
To draw a line, click on the point at which you
want the line to start and drag to the point where
you want it to end and release the button.

 Pressing the Shift key while drawing a line
constrains it to an angle of 0°, 45°, or 90°. Double-
clicking on the line icon opens the Line dialog box
which contains the same options as the
Paintbrush dialog box (see p.203).

Note: This dialog box can only be accessed if the
active image is Grayscale or RGB True Color.

Painting straight lines  



PAINTING 207

06/13/95 TaurusCONFIDENTIAL

Painting a straight line

Erasing colors  

The eraser tool replaces areas of an image with the
current background color. You can choose to
replace all the colors that the tool passes over with
the background color or just replace the
foreground color only. (Use the left mouse button
to erase, if you use the right button there is no
effect.)

To use the eraser tool:

1. Select the image or area you want to erase.

2. Choose the color you want to change as the
foreground color and the replacement color as
the background color.

3. Double-click on the eraser icon in the tool bar.
The Eraser dialog box appears.

4. Select the Erase Foreground to Background
Color option and click OK to close the dialog
box and return to your image.

5. Drag the eraser across an area in the image
containing the foreground color. The
foreground color in the area changes to the
background color without affecting any of the
other colors.
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Original image with Erasing foreground color Erasing all colors to
foreground color (gray) to background (black) background (black)

Adding text to an image  

The text tool allows you to add text to an image. In
addition to entering text in a variety of fonts and
styles, the text tool also provides options to create
text with a 3-D shadow as well as use anti-aliasing
(for Grayscale and RGB True Color images only) to
make text appear smoother.

To add text:

1. Click on the text tool icon in the tool bar.

2. Click on the area in the image where you want
your text to start. The Text dialog box appears.

3. Enter the text to insert in the Text entry box at
the top of the dialog box. The amount of text
entered is limited by the size of the entry box.

To start a new line press Ctrl + M (or Ctrl +
Enter).

4. Select the size, and style for the text. Set
shadow and color effects as desired.

5. Click OK. The dialog box closes and the text
appears on the image as a floating selection
filled with the selected color. The mouse
pointer also changes to the rectangular
selection tool to allow you to re-position the
text.

6. To combine the text with the image choose
“None” from the Edit: Select menu.
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2·6 Enhancing images

Image editing would not be complete
without tools to enhance images. This
chapter explains the use of the Image
Editor enhancement tools, beginning with
a look at the commands for adjusting and
correcting color. The final section of this
chapter describes the wide range of special
effects and filters that can be used in
conjunction with these tools to introduce
new elements into your imaging work.



210 IMAGEPALS GO!

06/13/95 TaurusCONFIDENTIAL

Some of the more common commands you will
use when working with images are concerned with
adjusting and correcting the color values of an
image. This is particularly important when the
colors recorded during a scanning process are
incorrect or you wish to highlight or darken
particular parts of an image. In Image Editor the
commands that control this type of operation,
Tone Mapper, Tone Adjustment, Brightness &
Contrast, Hue & Saturation, Invert, Level
Adjustment and Optimize can all be found in the
Image menu.

In most instances these commands can be applied
to selected areas or to entire images. However,
some of the commands are not applicable to some
data types, or they cannot be applied to selected
areas in certain data types.

Note: If you are not familiar with the terminology
used in this chapter refer to the Glossary.

Understanding mapping curves

When you select the Tone Mapper or Tone
Adjustment commands, a dialog box appears with
a graph representing the color values of the pixels
in the active image. The horizontal (x) axis
represents the “input” value, or original value
from black at the left (0) to white at the right (255).
The vertical (y) axis represents the “output”, or
remapped value.

Note: For RGB True Color images the right side of the
graph can also represent a primary value, red, green,
or blue, depending on the channel selected in the
channel combo box.

When you view the graph, a default mapping
curve (line) bisects the graph on the diagonal. This
indicates that for each “input” value the “output”
value is the same (i.e. y=x). By altering this curve
you can change the color values accordingly.

Adjusting and correcting color
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Adjusting image tones

The Tone Adjustment command in the Image
menu opens the Tone Adjustment dialog box in
which you can adjust the highlight, midtone and
shadow areas in an image. Highlight areas are
those areas that appear brighter or lighter than
others. Shadow areas are dark areas and the
midtone areas are somewhere in between.

Note: Adjusting these options affects the color values
of all pixels in an image or selected area.

In the Tone Adjustment dialog box you normally
adjust the overall tones in an image, but for RGB
True Color images, you can also adjust the three
color channels, Red, Green and Blue individually.
How best to adjust the color values of an image is
totally dependent on the type of image you have.
Try experimenting by moving the respective slider

controls and clicking on the Preview button to see
the effect on the image. The following should give
you a good idea of what to expect when you use
these controls:

Changing the Highlight enables you to increase or
decrease the brightness of the brighter pixels in an
image. Dragging to the right (a positive
percentage) increases this brightness, whereas
dragging to the left (a negative percentage)
decreases the brightness.

Changing the Midtone allows you to adjust
midtone pixels without affecting the highlights
and shadows too much. Drag to the right to
lighten the midtones; to the left to darken them.

Changing the Shadow lightens or darkens the
darker pixels in an image. Drag the slider to the
right to lighten the shadows or to the left to
deepen them.
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The graph in the Tone Adjustment dialog box
displays an added feature: the histogram. This
chart graphically represents the distribution of
color values within an image. The number of
pixels with a particular color is indicated by the
vertical “y” axis. As all colors in the image are
shown within this graph, the distribution of some
may be less apparent than others, e.g., light pixels
in a dark image or vice versa. In such cases
increase the Histogram Scale Factor to magnify
those color values with fewer pixels. (This only
affects the display of the histogram.)

Sometimes when you access the Tone Adjustment
dialog box, you will see the Auto button enabled.
This indicates the image has no black (x=0, y=0)
and/or white (x=255, y=255) pixels. In such cases
clicking the Auto button redraws the mapping
curve to map the original values onto the
complete range of colors from black to white. This
improves the contrast in an image and is
recommended (for most images) before you start
adjusting any color values.

Note: If you have selected an area of the image, only
the area within the selection is affected.

Sample histogram

Using the tone mapper curve

The previous section discussed how to change the
color values of pixels within an image by using the
Tone Adjustment dialog box. At times this may be
too general and not specific enough for your
needs. In such cases use the Tone Mapper to apply
finer adjustments to more specific ranges of color
values.
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Note: This command is primarily aimed at calibrating
your input and output devices. As such you will find it
is provided as an extension to both the input/scanning
process as a post processing option (see p.131) and
the printing process. To aid in this calibration you can
also load and save curves for subsequent use.

When you display the Tone Mapper dialog box you
only see a graph and mapping curve. You can
adjust this curve directly by dragging your mouse
over the graph or by selecting a predefined
enhancement using the Enhance Button.

Note: Each time you select an enhancement option
the enhancement is applied to the default curve (i.e
x=0 y=0).To apply different enhancements
sequentially check the Accumalatively option. This
applies each enhancement to the existing curve.

After adjusting the mapping curve you may feel
the curve is not “smooth” enough – simply click on
the Smooth button and it smoothes out
automatically. You can also use the Smooth button
to reduce the effect of a new tone curve as it
makes the curve tend towards the default.

You may have noticed that the color value graph
includes a 5×5 grid pattern. Each square block
within that grid represents a possible 51
consecutive color values (on a scale from 0 to 255).
If you want to edit only those values within a block
or you wish to have more restrictions on your
adjustments click on the Show Control Points
option. This places handles at each point where
the mapping curve intersects the grid. After
adjusting the control points you can apply other
enhancements or smooth the curve, but the
control points will disappear.

Note: Points to remember: the left area represents
darker pixels; the right lighter. Raising the curve
lightens color values; lowering the curve darkens
color values.
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Changing brightness and contrast

The Brightness & Contrast command in the Image
menu allows you to adjust the lightness and
darkness as well as the difference between areas of
light and dark colors in an image or selection area.
Use this when you want to perform a general
adjustment to the brightness and contrast of pixels
in an image.

Note: For RGB True Color images you can also edit the
individual color channels, Red, Green or Blue.

Changing hue and saturation

The commands mentioned so far deal primarily
with the lightness and darkness of pixels.
Sometimes you may only want to change the color
(hue) or purity (saturation) of colors. To change

the hue and saturation of an image choose the
Hue and Saturation command in the Image menu,
the Hue and Saturation dialog box opens. For best
results experiment by moving the sliders and
previewing your changes.

Inverting colors

The Invert command in the Image menu reverses
the colors in an image. If your image has shades of
black, they are inverted to reflect shades of white.
For color images each pixel changes to its
complementary color (e.g. blue changes to
yellow).
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Image before and after inverting

The Level Adjustment command allows you to
reduce the number of gray or color shades in an
image or selected area. This is useful when you
want to reduce the number of colors in an image
to enable a compression scheme to compress the
image more, or to create special effects.

Note: Unless you are using a well calibrated monitor
with a True Color display driver, you may not notice
any change in images when you select higher
numbers of levels (up to 64). But when you output
the image the changes may be more apparent.

Adjusting the number of displayable colors
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Image before and after reducing the number of displayable colors

The Optimize command attempts to generate the
best possible color for an image or selected area by
redistributing the pixels across the full range of
gray or color values. This effect will vary from one
image to another, depending on the original
distribution of the gray/color values. In general,
optimizing pixel values will make detail in the
darker shadow areas more apparent.

One good way to understand the process of
optimization is to view the histogram of an image
(choose the Tone Adjustment command) and then
apply the optimize command. This time when you
view the histogram of the image the color values
will be distributed throughout the image.

Optimizing an image’s color
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Image Editor provides different commands that
can be used to enhance images and create special
effects. You can apply these commands to entire
images or just to selected parts. However, it is only
possible to apply them to RGB True Color and
Grayscale images. If you wish to apply special
effects to other image data types, first convert
them to Grayscale or RGB True Color.

Blurring images

The Blur command in the Effect menu allows you
to reduce the contrast of pixel values in an image
to create a softer image. Images can be blurred in
three ways: Slightly, More, and Heavily. To blur an
image more selectively, use the magic lamp blur
option. This has the same effect as the Blur
commands except that you perform the operation
on a small area rather than the entire image or
selected area.

Applying special effects
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Image before and after blurring

The Sharpen command in the Effect menu
increases the contrast between light and dark
pixels in an image. This is essentially the opposite
of blurring an image. Images can be sharpened in
three ways: Slightly, More, and Strongly. To

sharpen an image more selectively, use the magic
lamp sharpen option. This has the same effect as
the Sharpen commands except that you perform
the operation on a small area rather than the
entire image or selected area.

Sharpening images
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Image before and after sharpening

”Noise” in an image refers to stray pixels that are
significantly different in color from surrounding
pixels. For example, a black pixel appearing in a
predominantly white area. (This often happens
when scanning poor quality images.) Choosing

the Despeckle command in the Effect menu clears
up these stray pixels and blends them into the
background color. Larger areas of color, different
from surrounding areas, have their edges softened
slightly.

Removing “noise” from an image
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Emphasizing the edges of an image

An edge in an image is defined as the parts of an
image where significant changes in color occurs.
The Emphasize Edges command in the Effect

menu outlines such changes in color, effectively
increasing the contrast along edges by making
them harder and more sharply defined.

Image before and after emphasizing edges
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Marking the edges of an image

The Find Edges command in the Effect menu
differs from the Emphasize Edges command in
that it inverts the edges of an image and obscures
the rest of the image with black. The color of the
lines varies depending on the image format you
are working on. Grayscale images produce lines of
white and varying shades of gray. RGB True Color
images produce either white or colored lines.

Note: Inverting an image you have applied “Find
Edges” to creates a “pencil-drawn” effect.

Image after find edges has
been performed

Adjusting an image for video

The Adjust for NTSC Preview command in the
Effect menu allows you to see an image as it would
appear when viewed on an NTSC device. This is
particularly useful when you want to know how an
image will look when it appears in a video
sequence of a video editing program.

Note: Depending on the image and your current
display mode, using this command may not produce
any visible effect
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Warping an image

Warping is a method of distorting a Grayscale or
RGB True Color image using a grid (or mesh)
based pattern. This grid is visible on a sample
image that appears in the Warping dialog box,
accessed by choosing the Warping command in
the Effect menu. In this dialog box you can define
the size of the grid squares, quality of the warp and
whether or not to show the control points that
appear at grid intersections.

To warp an area, click on a control point (or at a
grid intersection if the control points are hidden)

and drag it. (You can only drag within squares
bordering the control point selected.) When you
release the mouse, the grid redraws to
accommodate the new position. To see the effect
on the sample image, click the Testing button. (If
you want to see how the effect looks on the actual
image, click on the Preview button.)

Note: In most cases checking the Good option for
Quality Control will produce more than adequate
results. If you want even better results, check the
Better option. This does however require more time
to perform the effect.

Image before and after warping
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Custom Filter

Many of the effects provided by Image Editor work
by regenerating a pixel value based on its original
value and the value of its surrounding pixels. The
Custom Filter command allows you to create your
own effects in a similar way using a 5 by 5 pixel
matrix.

To create your own filter:

1. Select the image you want to apply the filter
to.

2. Choose “Custom Filter” from the Effect menu.
The Custom Filter dialog box opens.

3. In the Symmetry combo box, select one of the
following:

• No – this provides no symmetry.

• Horizontal – selecting this option duplicates
the value in the horizontally opposite cell.

• Vertical – selecting this option duplicates the
value in the vertically opposite cell.

• 4-Way – this option duplicates values in the
three cells that form the other corners of a
square around the center.

4. Enter values in the matrix cells. The cell in the
middle of the matrix represents the pixel
whose value is going to be regenerated. The
surrounding cells represent the surrounding
pixels. (The Divided by value changes to show
the total value of all the cells.)

5. Change the Divided by value to affect the
overall tone of the image. The higher the
value, the darker the image, the lower the
value, the lighter the value. This value
automatically adjusts as you change other
options to retain the overall tone (optional).

6. Check the Invert option to invert the
gray/color values of the image.

7. Click OK. The filter is applied to the image.

Note: You can only create custom filters for use with
RGB True Color and Grayscale images. Once created
you can then save them for future use or editing.
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Changing your wallpaper

Although not strictly an effect, the Set as
Wallpaper command in the Effect menu is a useful
feature that allows you to make any BMP file the
current Windows wallpaper. (This command is
disabled if the active image is not BMP.) When you
choose this command, you have the choice of
either tiling the image or centering it. Once
chosen, the wallpaper is changed immediately. If
you the image appears too big or too small, use the
Resample command in the Image menu (see p.177
to resize the image accordingly.

The Special Effects command

Apart from the above filters and effects, Image
Editor also provides a number of additional
options in the Special Effects dialog box (opened
by choosing the Special Effects command in the
Effect menu). The kind of effect that can be
applied depends on the data type of the active
image, e.g. for RGB True Color images you can
choose from a maximum of 15 effects. To perform
an effect, simply choose it from the Effect combo
box. The effect is immediately reflected in the
sample images at the bottom of the dialog box. (If
you want to see how the effect looks on the actual
image, click on the Preview button.) The following
section describes each of the effects available in
the Special Effects dialog box:
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Average

The Average effect recalculates the value of a pixel
in an image by averaging its value with the values
of the surrounding pixels. By moving the slider in
the Factor group box you can specify the number
of pixels with which each pixel is averaged. For
example, a square size of 4 pixels defines a 4×4 cell
containing 16 pixels to be used for calculating the
average pixel values. The averaged value then
replaces the original value of the pixel resulting in
a softer image with smoother transitions in color.

Blast

The Blast effect is only available for RGB True
Color images and simulates the effect of a strong
cold wind. This causes the image or selected area
to develop icicles. Use the direction options to
show the wind blowing to the left or right, and the
slider to increase or decrease the intensity of the
wind.

Cool/Warm

The Cool and Warm effects are only available for
RGB True Color images. They work by enhancing
the hue of pixels containing particular color
values. Increasing the Level leads to a
corresponding increase in the particular hue
values – making the images appear “cooler” or
“warmer”. The Cool effect enhances the hue of
pixels with a blue or cyan component while the
Warm effect enhances the hue pixels with a red or
yellow component.

Emboss

The Emboss filter makes an image appear to be
“raised” or “stamped” from paper of a particular
color. In the Factor group box you can select this
color as either the current foreground or
background color. You can also define how deeply
the image is stamped by moving the slider to the
right; to make the image appear raised, move the
slider to the left.
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Image before and after embossing

Facet

The Facet command breaks an image up into
squares which are then “shifted” in a random
order. To control the size of the squares, use the
Square Size slider. The Shift Value slider changes
how the squares are moved around the image.

Fat/Thin

Selecting the Fat option distorts an image out to
the sides, effectively making the center of an
image appear fatter. The higher the Level the
greater the distortion. The Thin option works in
the opposite way by squeezing the image in from
the sides to make the center of an image appear
thinner. Again, the higher the Level the greater the
distortion.
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Image made fatter (on the left) and thinner (on the right)

Fish Eye

The Fish Eye effect creates a convex circle in the
center of an image or selected area. This results in
a distorted 3D effect which is controlled by the
slider bar.

Note: For best results ensure that your subject is in
the center of your image or selected area.

Mosaic

This filter breaks an image into blocks containing
pixels of the same gray/color value. (Use the slider
to specify the size of the blocks.) The pixels within
each block are averaged together to produce the
color value for all the pixels in the block. This is
similar to the technique some television
companies use to obscure the faces of people who
wish to remain anonymous.
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Image before and after applying the fish eye effect

Motion Blur

Using this effect creates the appearance that the
image is moving. This effect is commonly
produced in photographs showing people and
objects moving at high speed. Changing the Angle
changes the direction of the movement while the
Moving Offset slider allows you to define how
much the image moves by.

Puzzle

The puzzle effect divides an image into a grid. The
sequences of the grid are then randomly
rearranged. The size of the squares in this grid is
determined by the slider. Each square is
surrounded by a border which takes its color from
the current background color.
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Image before and after applying the puzzle effect

Stagger

The Stagger effect is only available for RGB True
Color images. When you select this effect the
image is distorted horizontally, producing a severe
zigzag effect along the image or selected area.
Using the direction options you can change the
stagger to the left or right.

Tile

The Tile effect is similar to the puzzle effect except
that the image is broken up into square blocks
rather than a grid. To control the size of the
squares, use the Square Size slider. The Shift
Value slider determines how the squares are
moved around the image. (When the squares
overlap each other, the background is filled with
the current background color.)
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Image before and after applying the tile effect

Watercolor

The Watercolor effect is only available for RGB
True Color images. Applying this effect gives the
impression that the image has been created using
watercolors. By adjusting the Stroke Size you can
specify the size and length of each paint stroke.
Moving the slider to the right adds more water to
the paint, making the edges appear darker than
the center.

Windy

Windy is similar to the Blast effect and can only be
applied to RGB True Color images. Use this to
create “wisps” of wind over the image. To control
the direction of the wind use the direction
options, and the slider to determine how hard the
wind is blowing.
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2·7 Image input &
stitching

All types of photographs, illustrations, and
even video frames can be brought into
Image Editor via a range of input devices.
This chapter introduces the commands
that access image input devices and then
goes on to describe the different options
Image Editor provides for combining
images.
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Before you begin

The Acquire, Source, Import and Export
commands in the File menu provide ways to
access external software drivers. The commands
in the Import and Export submenus change
according to installed drivers. Because of this
flexibility, we cannot describe all the possibilities
here. For information about the use of an installed
driver, please refer to its documentation and on-
line help.

Note: All external image sources involve some sort of
hardware and an associated software driver. Different
sources require different installation procedures and
provide different facilities. To find out about these,
please refer to the manufacturer’s documentation.

The Import and Export submenus in the File menu
provide access to external software modules
expanding Image Editor’s ability to access and
output image files in special formats and for
special devices.

To install modules, run the Driver Setup program
and select the Import/Export module option. Click
OK and in the subsequent screen, choose the
module you wish to install or select “Others” to
install an unlisted driver. Unlisted modules
require a disk containing the module’s driver file
and an OEM.INF file.

Because the Import and Export submenu
commands access specific functions and devices,
you won’t be able to use any that appear unless
you have a suitable device. Devices supported by
modules available for Image Editor include Photo
CD drives and special printers like the Kodak XL
7700.

Importing and exporting
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The TWAIN commands

TWAIN is an industry standard that allows
applications to use input devices without a
complex installation procedure. It has been
described as “providing seamless connection
between applications and devices”.

If you have a TWAIN-compatible device you
should follow its installation procedure. Once
correctly installed, you will be able to use the
device from Image Editor or any other application
that supports TWAIN without worrying about
compatibility problems.

Acquire

Choosing the Acquire command in the File menu
accesses the software driver for the device selected
in the Select Source dialog box. When you choose
the Acquire command, a dialog box appears. This
dialog box varies according to the image input
device you have installed.

Note: If you select the Acquire command and you do
not have a TWAIN device installed, you will see an
error message. If you do have a TWAIN device, but it
is incorrectly installed, a dialog box appears
containing installation options.

The source options

The Source submenu in the File menu contains
commands that allow you to select your TWAIN
source and define post processing options. The
Select command opens the Select Source dialog
box that lists all your available input sources. To
select a source, click on the source and then press
OK. If you have only one source, it is automatically
selected. The other commands define what
happens to the image after scanning.

Performing post processing

When you input an image, Image Editor allows
you to perform a variety of post processing
commands: Auto Tone Adjustment, Brightness
and Contrast (see p.214) Tone Adjustment (see
p.210) Tone Mapper (see p.212) and Scan to
Printer.
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The Auto Tone Adjustment command is applied
during the input process whereas the others,
except for Scan to Printer, invoke their respective
dialog boxes once the image has been created. The
Scan to Printer command opens the Print dialog
box, allowing you to specify how the image is
printed before input.

Note: When you choose a command, a tick appears to
the left of the command. Choosing the command
again deselects it.

Auto Tone Adjustment automatically adjusts the
highlights and shadows and remaps newly input
images onto the full range of available colors,
improving contrast in the image. When you select
Auto Tone Adjustment you also have the option of
adjusting midtones. In the spin box at the bottom
of the dialog box, enter a value from – 100% to
100%. Negative values darken the midtones,
positive values lighten them. Select a value of 0 if
you only want to remap the image to use the full
range of colors available.

If your scanner cannot scan the whole of a picture
in one pass, you can input the entire picture by
scanning the picture in strips and then joining the
resulting images. In this situation, the ability to
join images accurately and efficiently is essential.
Image Editor provides two approaches to this
function through the Tile Two Images and Stitch
commands in the Edit menu.

With both “Tile Two Images” and “Stitch” you
choose an image and the position to place it
relative to the active image. The major difference
between the two commands is that “Tile Two
Images” joins images with a specific distance
between them while “Stitch” provides multiple
options and controls for both manual and
automatic joining.

Joining image strips
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Use “Tile Two Images” to create special effects or
to join two images when the joint is not critical.
Special effects can include placing the same image
against itself or by joining a flipped version of an
image to the original to create a mirrored effect.
“Stitch” is the command of choice where pixel-
level control and seamless joining is important.

Note: You can only join images that share the same
data type and are either Grayscale or RGB True Color.
To join images of other data types, first convert them
to Grayscale or RGB True Color.

To join two images using the Tile Two Images
command:

1. Make one of the images you wish to join active
by clicking on its title bar.

2. Choose “Tile Two Images” from the Edit
menu. The Tile Two Images dialog box
appears. In the preview window the active
image and floating image (with a gray shadow)
appear.

3. In the Floating Image combo box, select the
image you want to join to the active image.
The image selected here appears as the
floating image in the preview window.

4. Use the Direction arrows to place the floating
image relative to the active image.

5. In the Distance entry box, enter the distance
you want between the edges of the images. If
you enter a positive value, the gap between the
active and floating images is filled with the
current background color. If you enter a
negative value, the images overlap with the
combination in the overlap area being
controlled by the Transparency option.

6. Click OK. The dialog box closes and a new
window appears containing the joined images.
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The Stitch command in the Edit menu opens the
Stitch dialog box. This dialog box is similar to the
Tile Two Images dialog box except that it does not
have the Distance and Transparency entry boxes;
the OK button is also replaced by a Place button.

Clicking on the Place button puts Image Editor
into “Stitch” mode. In this mode, the Image Editor
workspace is cleared leaving only the two images
to be stitched. The normal Image Editor menus
are replaced by special Stitch menus. In Stitch
mode you can use the following options:

• set auto-stitching parameters and make Image
Editor automatically match and align the
floating image on the active image.

• drag the floating image until it matches with
the active image.

• define a reference point in each image, by
holding shift down and clicking first in one
and then in the other, Image Editor then aligns
the images on these points.

• select “Auto Fine Tune” in the Option menu to
aid in manual stitching.

• set the transparency of the floating image to
aid manual stitching and to define how images
are combined in the overlap area.

Operating in Stitch mode

Stitch mode allows you to find the best alignment
of two images by combining the use of manual,
automatic, and assisted joining functions. In this
mode there are three menus and one menu bar
command.

The Stitch command
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Action menu

Auto Stitch... choosing this command opens the
Auto Stitch dialog box. At the same time a
horizontal or vertical line appears on the active
image. This line represents the approximate
position to which the floating image should
overlap. This line is moved by dragging the
Overlap Range slider.

Note: If the overlap is too small (less than thirty
pixels), the chance of a successful match is greatly
reduced.

As well as adjusting this overlap range, a second
control, “Horizontal/Vertical Tolerance”, allows
you to provide for misalignment in the other
direction. The tolerance should be slightly greater
than the distance the floating image needs to
move (horizontally or vertically) to align with the
active image.

Clicking OK in this dialog box automatically
repositions the floating image to match the active
image according to the overlap and tolerance
parameters you have defined.

Done stitches the two images together. The Image
Editor window reappears as it was before stitching
with an additional window containing the newly
stitched image. (Double-clicking on the non-
active image has the same effect.)

Note: If you try to exit Stitch mode by selecting
“Close” from the control menu, a message, “Please
complete the Image Editor operation first”, appears.
Click OK and, if you don’t want to continue stitching,
select “Quit” from the Action menu.
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View menu

Actual view returns the view of the images to the
normal (1×) view where each image pixel is shown
by one screen pixel. If you are already at actual
view, this command has no effect.

Zoom In and Zoom Out change the view of the
images one step at a time. Use these commands if
you want to view a magnified or reduced portion
of the images to enable you to stitch more
accurately.

Transparency... opens the Transparency dialog
box. This dialog box allows you to specify the
transparency of the floating image. Wile you are
placing the floating image, use a transparency of
50% to enable you to see both images equally.
Before stitching, choose another transparency to
define how the area of overlap appears after
stitching. Selecting 0% causes the floating image
to obscure the active image in the area of overlap.
A 100% selection causes the active image to
obscure the floating image.

Option menu

Auto fine tune automatically fine-tunes the
position of the floating image immediately after
you have moved it by dragging or by defining
matching points. To be successful the floating
image must be placed fairly close to its final
destination (within thirty pixels either way). This
option usually achieves the best result with the
least amount of effort.

Note: When you choose the Auto Fine Tune
command, a tick appears to the left of the command,
thus enabling it. Choosing the command again
deselects it.

Help! menu bar command provides you with
direct access to help on the stitching process.
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To stitch two images manually:

1. Make one of the images you wish to join the
active image.

2. Choose “Stitch” from the Edit menu. The
Stitch dialog box appears.

3. In the Floating Image combo box, select the
image you want to join to the active image.
The image selected here appears as the
floating image (with a gray shadow) in the
preview window.

4. Use the Direction arrows to place the floating
image relative to the active image.

5. Click on the Place button. Image Editor enters
Stitch mode.

6. Drag the floating image until you are satisfied
with its position.

7. Double-click on the image or select “Done”
from the Action menu. You exit Stitch mode
and a window appears containing the stitched
image.

Note: An alternative to dragging is to define a
matching point in each image: hold Shift down and
click on a point in one image and then on a point in
the other. Image Editor then moves the images to
match on these corresponding points. To improve
either method, choose “Auto fine tune” from the
Options menu before setting reference points or
dragging.
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Stitching images by defining reference points

1. Original matching point, defined by holding down Shift and clicking on the floating image

2. Corresponding matching point, defined by holding down Shift and clicking on the active image
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Aspect ratio

The ratio of width to height in an image or
graphic. Keeping the aspect ratio means any
change to one value is immediately reflected in
the other.

Averaging

A filtering process which takes the gray/color
value of each pixel and averages it with the values
of surrounding pixels. The value of each pixel is
then replaced with the averaged value.

Bit

The smallest element of a computer’s memory.
Among other things, bits are used to record the
color values of pixels in an image. The more bits
used for each pixel the greater the number of
available colors. For example:

1-bit: each pixel is either black or white.

8-bits: each pixel can be any one of 256 colors or
gray shades.

16-bits: each pixel can be any one of 65,536 colors.

24-bits: each pixel can be any one of 16.7 million
colors.

Bitmap

An image made up of a collection of dots or
“pixels” arranged in rows.

Glossary
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Black & White image

An image that only contains black and white
pixels.

Brightness

The brightness of an image is a description of how
much light appears to be emitted from it. An
absence of light, (black), has zero brightness; pure
white light has maximum brightness.

Channel

Refers to one of the components of a color model.
Different color models use different components
to represent image colors. The RGB color model
uses red, green and blue color component
channels. The HSB color model uses hue,
saturation and brightness color component
channels. (Grayscale images can be thought of as
single-channel images.)

Client programs

A program which accepts embedded or linked
object files.

Clipboard

A temporary storage area shared by all Windows
programs used to hold data during cut, copy and
paste operations. Whenever you place new data
onto the clipboard, it immediately replaces the
existing data.

Cloning

Replicating one part of an image within or
between different images.

CMYK

A color model in which each color consists of
varying degrees of the colors cyan, magenta,
yellow and black.
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Color model

A color model is a way to mathematically describe
and define colors and the way they relate to each
other. Different color models exist, each of which
has a specific purpose; the two most common
color models are the RGB and HSB. (See HSB,
RGB.)

Complementary color

Complementary colors are opposite in value to
primary colors. For example, cyan, magenta and
yellow are complementary colors of red, green and
blue.

Compression (file)

A method for making files smaller in size on disk.
There are two types of compression: lossless and
lossey. Files compressed with a lossless scheme
can be restored to their original state. Lossey
schemes discard data and so images, when
decompressed, may show quality degradation.
The ImagePals GO! programs support schemes of
both types depending on the format of the file.

Contrast

The contrast of an image describes the difference
between light and dark. In an image with high
contrast the transition from dark to light is very
clear; in an image with low contrast, the difference
between light and dark is not so obvious.
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Conversion (file)

The process of changing from one file format into
another.

Data type

The way an image is internally described and
represented by a computer. The data type of an
image controls the amount of information that the
image can retain and therefore its displayed
appearance. The ImagePals GO! programs read
and write to the following types: Black & White,
Grayscale, Indexed 16 and 256-Color, RGB True
Color and CMYK True Color. RGB 8-Color images
can also be read but they are automatically
converted to Indexed 16-Color.

Dithering

Methods of making images with limited colors
available appear to contain more. Most notably for
making Black & White images appear to contain
near-continuous changes in tone (gray shades). By
arranging pixels of different colors close together,
dithering can simulate colors not directly
supported by an image data type.

Dots per inch (DPI)

A unit of measure for screen and printer
resolution that represents the number of dots a
line can print or display per inch.

Embedding

To create a copy of an object from one program, a
server program, in the document of another
program, a client program. The embedded object
retains a copy of the object’s native data and a link
to its server program which may be
edited directly from the client. (see Link, OLE.)
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Export

The process of transferring information from one
program to another.

File format

The ways in which a computer stores images or
information on a disk.

Filters

Algorithms that manipulate the values of pixels to
produce special effects.

Graphics file

A file whose data is composed largely of vector
graphics. Vector graphics do not have a basic
component, like a pixel, but are defined as lines
between points, and fills between lines.

Grayscale

Something that contains solely shades of gray. For
an image this normally means 254 different grays
plus black and white: 256 “grays” in all.

Halftoning

A method of using a pattern of black and white
dots to produce what appears to be shades of gray.
This is a common form of dithering.

HiColor

For images, this normally means a 16-bit (5-6-5)
data type that can contain up to 65,536 colors. TGA
file formats support images of this type. Other file
formats require prior conversion of a HiColor
image into True Color. For displays, HiColor
normally refers to 15-bit (5-5-5) display adapters
that can display up to 32,768 colors.
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HSB color model

A color model that specifies colors in a way that is
easier for us to visualize than the RGB model. H in
HSB represents the hue, or basic color; S
represents the saturation, or purity of the color;
and B represents the brightness, or amount of
light the color appears to emit. (See Saturation,
Brightness)

Hue

The hue of a color describes whether a color is
basically red, orange, yellow, green, turquoise, etc.
In ImagePals GO!, the Hue is specified in degrees
(from -0° to 359°.)

Image

In computing terms, an image is picture that is
represented on screen as a collection of “dots”.
(See Pixel.)

Import

The process of incorporating information from
one program into another.

Indexed-Color

An Indexed-Color image is represented by each
pixel having four bits (16-Color) or eight bits (256-
Color).

Linking

To create a reference in the document of a client
program to an object in a server program. The
linked object can be edited directly from within
the client program. When the object changes in
the server program, the changes are automatically
reflected in the client program.

Mask

A mask is a selection marquee. This marquee can
be defined by a selection tool or generated from
the contours of a Grayscale image.
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Object (OLE)

An object is data that is created or edited in one
program and then placed into a document of
another.

Object Pool

A storage area used in Image Editor that allows
you to store, browse or retrieve image and mask
objects.

OLE (Object Linking and Embedding)

A function developed by Microsoft as a means of
transferring and sharing information (objects)
between programs. OLE differs from cut, copy and
paste operations in that the object in the client
program retains a link to the server program it
originated from.

Pixel

The smallest unit in an image. Computer images
are made up of rows of pixels, each of which can
be a different color. Pixels are normally so small
that you see the image created by a collection of
them.

Prime colors

The prime colors are the basis of the RGB color
model: red, green, and blue. With different
amounts of each of these colors, on screen, it is
possible to create any other color.

Raster (see Bitmap)

Resolution

The resolution of an image determines the size of
the individual pixels in an image and thus the size
of the whole image. Resolution is shown in pixels
per inch (ppi) or dots per inch (dpi).
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RGB color model

A color model used to define colors by specifying
the red, green, and blue components of colors.
This is one of the standard color models used to
specify and record colors on a computer. (See
Color model.)

Saturation

Saturation defines the purity of a color. A color
with a high saturation appears very intense and
strong; a color with a low saturation appears
washed-out.

Server program (OLE)

A server program allows you to take objects from it
and place them into a document in another OLE
client program. Album and Image Editor can both
act as server programs. (see Client, OLE.)

Thumbnail

A small, low-resolution representation of an
image.

True Color

Something that can display enough colors to
appear “True” to life. For an image this normally
means 24-bit color, providing up to 16.7 million
colors. (See Bit.)

Vector graphics (see Graphics file.)

Last page
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A

Acquire command, Album  72

Actual Size command, Image Editor  140

Add a View command, Image Editor  136

Adjust for NTSC Preview, Image Editor  221

Airbrush  tool, Image Editor  205

Album
backing up  67
changing properties  64
closing  65
copy  67
create  62

delete  67
exit  110
information  83
preferences  51
restore  69
shelf  70

Animation files  36

Application-linked files  34

Associate command, Album  34  87

Attributes command, Album  87

Auto Fine Tune command, Image Editor   236

Auto Tone Adjustment, Image Editor  234

Backup command, Album  68

B

Batch Manager
Album  46
Image Editor  144

Blur command, Image Editor  217

Boolean operators  101

Border command, Image Editor  167

Brightness & Contrast, Image Editor  214

Index
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C

Calibrating your display  20

Check command, Album  66

Clone tool  204

Color Table command, Image Editor  196

Configure command, Album  50

Converting data types
Album  85
Image Editor  187

Converting file formats, Album  84
Copy command

Album  77
Image Editor  146

Crop command, Image Editor  176

Custom Filter command, Image Editor  223

Cut command
Album  77
Image Editor  146

D

Data types
Black & White  29
Grayscale  29
Indexed 16-Color  29
Indexed 256-Color  29
RGB 8-Color  31
RGB HiColor  30
RGB True Color  31

Delete command, Album  65
Despeckle command, Image Editor  219

Diffusion  192

Discard Floating command, Image Editor  157

Display command
Album  58
Image Editor  153

Distort command, Image Editor 185

Dithering  30

Drag-and-drop
Album  51
Image Editor  150

Duplicate command, Image Editor  127
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E

Elliptical tool, Image Editor  161

Embedding  24

Emphasize Edges command, Image Editor  220

Eraser tool, Image Editor 207

Exit
Album  110
Image Editor  135
Exiting Viewer  120

Eyedropper tool, Image Editor  195

F

File formats
BMP   37
CGM  36
EPS   37
GIF  38
JPEG  38
PCD  38
PCX  39
TGA  39
TIF   40
WMF  36  40

File Formats command
Album  60
Image Editor  154

Fill command, Image Editor  197

Find Edges command, Image Editor  221

Freehand tool, Image Editor  157

Freely command, Image Editor  182

From Clipboard command, Album  75

From File command, Album  74

Full Screen command, Image Editor  140

G

Global Viewer, Image Editor  140

Graphics files  36

Grayscale  29

H

Halftoning  131

HiColor  39

Histogram, Image Editor  212

Horizontal command, Image Editor  180

Hue & Saturation command, Image Editor  214
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I

Image input & stitching, Image Editor  231

Import Group command, Image Editor  172

Indexed 16-Color  29

Indexed 256-Color  29

Insert command, Album  72

Invert command, Image Editor  162

J

JPEG compression  63

K

Keywords  90

L

Level Adjustment command, Image Editor  215

Line tool, Image Editor  206

Linking  22

Lossey compression  38

M

Magic Lamp, Image Editor  201

Magic Wand, Image Editor  158

Make floating command, Image Editor  157

Mark Palette
assigning  92
converting to keywords  95
loading and saving  95
removing  95
Viewing  94

Masks  170

Memory command
Album  59
Image Editor  154

Merging, Image Editor  168

Midi files  35

N

New command
Album  62
Image Editor  128
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O

Object Pool, Image Editor  170

Objects, Image Editor  170
OLE & Clipboard command

Album  56
Image Editor  153

Open command
Album  64
Image Editor  126

Optimize command, Image Editor  216

Options command, Album  83

P

Paste command, Image Editor  147

PCD  38

PCX  39

Photo CD command

Album  58
Image Editor  153

Pixel  25

Preferences, Album
Album  54
Display  58
File Formats  60
Memory 59
OLE & Clipboard  56
Photo CD  58

Preferences, Image Editor
Display  153
File Formats  154
Image Editor  151
Memory  154
OLE & Clipboard  153
Photo CD  153

Print
Albums  77
File  77
Image Editor  130
Keywords  77
Thumbnails  77

Put on Shelf command, Album  70
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R

Rectangular tool, Image Editor  161

Relink command, Album  88

Remove command, Album  64

Rename command, Album  67  86

Resample command, Image Editor  179

Resolution command, Image Editor  178

Restore command
Album  69
Image Editor  145

Rotate command, Image Editor  181

S

Save
command, Image Editor  129
command, Viewer  114
to Clipboard  149
to the Object Pool  170

Save Sequence command, Album  109

Scrolling albums  80

Scrolling program icons, Album  50

Search
by item  105
criteria and queries  100
keywords  105
marks  106
query  106
ribbon  106
subjects  103

Search Entire Album command  104

Select command, Image Editor  233

Set as Wallpaper command, Image Editor  224

Sharpen command, Image Editor  218

Shelf command, Album  70

Similar command, Image Editor  166

Slant command, Image Editor  184

Slide Show command  81

Special effects, Image Editor  224

System Information command, Image Editor  142
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T

TIFF  37

TARGA  39

Text tool, Image Editor  208

Thumbnail properties  96

Tile Two Images command, Image Editor  235

Tone Adjustment command, Image Editor  211

Tone Mapper command, Image Editor  210

Toolbox, Album
add programs  48
customize  50

True Color  39  40

TrueVision  39

U

Undo command
Album  47
Image Editor  145

V

Vertical command, Image Editor  180

Video files  36

Viewer commands
Actual View command  115
Always on Top command  118
Cascade and Tile commands  118
Place Viewers on Top command  118
Reopen command  114
Run Other Editor command  114
Select None command  114

W

Warp command, Image Editor  222

WMF  36  40

Z

Zoom, Image Editor  137

Zoom tool, Image Editor  138


